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法律声明
阿里云提醒您在阅读或使用本文档之前仔细阅读、充分理解本法律声明各条款的内容。
如果您阅读或使用本文档，您的阅读或使用行为将被视为对本声明全部内容的认可。

1. 您应当通过阿里云网站或阿里云提供的其他授权通道下载、获取本文档，且仅能用
于自身的合法合规的业务活动。本文档的内容视为阿里云的保密信息，您应当严格
遵守保密义务；未经阿里云事先书面同意，您不得向任何第三方披露本手册内容或
提供给任何第三方使用。

2. 未经阿里云事先书面许可，任何单位、公司或个人不得擅自摘抄、翻译、复制本文
档内容的部分或全部，不得以任何方式或途径进行传播和宣传。

3. 由于产品版本升级、调整或其他原因，本文档内容有可能变更。阿里云保留在没有
任何通知或者提示下对本文档的内容进行修改的权利，并在阿里云授权通道中不时
发布更新后的用户文档。您应当实时关注用户文档的版本变更并通过阿里云授权渠
道下载、获取最新版的用户文档。

4. 本文档仅作为用户使用阿里云产品及服务的参考性指引，阿里云以产品及服务
的“现状”、“有缺陷”和“当前功能”的状态提供本文档。阿里云在现有技术的
基础上尽最大努力提供相应的介绍及操作指引，但阿里云在此明确声明对本文档内
容的准确性、完整性、适用性、可靠性等不作任何明示或暗示的保证。任何单位、
公司或个人因为下载、使用或信赖本文档而发生任何差错或经济损失的，阿里云不
承担任何法律责任。在任何情况下，阿里云均不对任何间接性、后果性、惩戒性、
偶然性、特殊性或刑罚性的损害，包括用户使用或信赖本文档而遭受的利润损失，
承担责任（即使阿里云已被告知该等损失的可能性）。

5. 阿里云网站上所有内容，包括但不限于著作、产品、图片、档案、资讯、资料、网
站架构、网站画面的安排、网页设计，均由阿里云和/或其关联公司依法拥有其知识
产权，包括但不限于商标权、专利权、著作权、商业秘密等。非经阿里云和/或其关
联公司书面同意，任何人不得擅自使用、修改、复制、公开传播、改变、散布、发
行或公开发表阿里云网站、产品程序或内容。此外，未经阿里云事先书面同意，任
何人不得为了任何营销、广告、促销或其他目的使用、公布或复制阿里云的名称
（包括但不限于单独为或以组合形式包含“阿里云”、“Aliyun”、“万网”等阿
里云和/或其关联公司品牌，上述品牌的附属标志及图案或任何类似公司名称、商
号、商标、产品或服务名称、域名、图案标示、标志、标识或通过特定描述使第三
方能够识别阿里云和/或其关联公司）。

6. 如若发现本文档存在任何错误，请与阿里云取得直接联系。
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通用约定
格式 说明 样例

 危险 该类警示信息将导致系统重大变更甚至故
障，或者导致人身伤害等结果。

 危险

重置操作将丢失用户配置数据。

 警告 该类警示信息可能会导致系统重大变更甚
至故障，或者导致人身伤害等结果。

 警告

重启操作将导致业务中断，恢复业务
时间约十分钟。

 注意 用于警示信息、补充说明等，是用户必须
了解的内容。

 注意

权重设置为0，该服务器不会再接受新
请求。

 说明 用于补充说明、最佳实践、窍门等，不是
用户必须了解的内容。

 说明

您也可以通过按Ct rl+A选中全部文
件。

> 多级菜单递进。 单击设置> 网络> 设置网络类型。

粗体 表示按键、菜单、页面名称等UI元素。 在结果确认页面，单击确定。

Courier字体 命令或代码。
执行 cd /d C:/window 命令，进入
Windows系统文件夹。

斜体 表示参数、变量。
bae log list  --inst anceid

Inst ance_ID

[] 或者 [a|b] 表示可选项，至多选择一个。 ipconfig [-all|-t ]

{} 或者 {a|b} 表示必选项，至多选择一个。 swit ch {act ive|st and}
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欢迎您选择运维编排OOS（Operation Orchestrat ion Service），我们提供了丰富的API供您使用。如果您熟
悉网络服务协议和一种以上编程语言，我们推荐您使用云服务器OOS API管理您的云上资源和开发自己的应
用程序。更多详情，请参见API概览。

使用限制
您能创建的运维编排OOS模板、执行等资源均有数量等限制。更多详情，请参见使用限制。当接口描述、参
数可选值与使用限制发生矛盾时，优先以《使用限制》为准。

使用说明
我们支持HTTP或者HTTPS请求，允许GET和POST方法。您可以通过以下方式调用运维编排OOS API：

（推荐）不同编程语言的云服务器OOS SDK，请参见SDK

请求结构

SDK免去了您手动身份验证环节，进而能快速调用接口。我们推荐您使用SDK，方便调用接口以及管理资
源。

API URL请求需要您自行验证身份和编码URL。您可以通过该方法了解阿里云访问验证流程。更多详情，请参
见签名机制和创建AccessKey。

资源术语

中文 英文 说明

地域 Region
阿里云建设的数据中心。资源创建成
功后无法更换地域。

1.简介

运维编排 API参考·简介
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运维编排提供以下相关API接口。

模板

API 描述

CreateTemplate 调用CreateTemplate创建一个模版。

DeleteTemplate 调用DeleteTemplate删除一个模版。

GetTemplate 调用GetTemplate获取一个模版，包括内容。

ListExecutionRiskyTasks 调用ListExecutionRiskyTasks获取模版中的高风险任务。

ListTemplates 调用ListTemplates查询模板，支持多种过滤方式。

UpdateTemplate 调用UpdateTemplate更新一个已经存在的模板。

ValidateTemplateContent 调用ValidateTemplateContent校验一个模版是否合法。

动作

API 描述

ListActions 调用ListActions查询可用动作，包括原子动作和云产品动作。

执行

API 描述

CancelExecution 调用CancelExecution取消执行。

DeleteExecutions 调用DeleteExecutions删除执行。

GenerateExecutionPolicy 调用GenerateExecutionPolicy获取模板执行所需要的Ram Policy。

GetExecutionTemplate 调用GetExecutionTemplate获取一个执行所使用的模板，包括内容。

NotifyExecution 调用NotifyExecution通知一个状态为等待中的执行接下来如何运行。

ListExecutions 调用ListExecutions查询执行，支持多种过滤方式。

ListExecutionLogs 调用ListExecutionLogs获取执行的详细日志。

StartExecution 调用StartExecution启动一个执行。

ListTaskExecutions 调用ListTaskExecutions查询任务执行，支持多种过滤方式。

标签

2.API概览

API参考·API概览 运维编排
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API 描述

TagResources 调用TagResources可创建标签资源关系，即可为资源创建用户标签。

UntagResources 调用UntagResources可删除用户标签资源关系，即可为资源删除用户标签。

ListTagResources 调用ListTagResources查询可见的资源标签关系。

运维编排 API参考·API概览
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本文提供了在OOS通过访问控制实现团队或者部门成员鉴权、RAM账号资源授权以及跨云服务授权的RAM鉴
权规则。

背景信息
当RAM账号通过OOS API访问OOS资源时，阿里云OOS首先向RAM发起权限检查，以确保资源拥有者已经将
相关权限授予调用者。不同的OOS API会根据涉及的资源以及API语义确定需要检查哪些资源的权限。您可以
阅读访问控制产品文档和访问控制API文档了解更多详情，实现精细化授权策略和权限控制。

说明  如果您无需授权就能访问目标资源，可以跳过此章节。

鉴权列表
部分API的鉴权规则如下表所示。资源说明请参见基本概念。

OpenAPI Action 资源ARN

CreateTemplate oos:CreateTemplate
acs:oos:$regionid:$accountid:te
mplate/*

ListTemplates oos:ListTemplates
acs:oos:$regionid:$accountid:te
mplate/${templateName}

UpdateTemplate oos:UpdateTemplate
acs:oos:$regionid:$accountid:te
mplate/${templateName}

GetTemplate oos:GetTemplate
acs:oos:$regionid:$accountid:te
mplate/${templateName}

DeleteTemplate oos:DeleteTemplate
acs:oos:$regionid:$accountid:te
mplate/${templateName}

GenerateTemplatePolicy oos:GenerateTemplatePolicy
acs:oos:$regionid:$accountid:te
mplate/${templateName}

StartExecution oos:StartExecution

acs:oos:$regionid:$accountid:te
mplate/${templateName}

acs:oos:$regionid:$accountid:ex
ecution/*

ListExecutions oos:ListExecutions
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

ListExecutionTasks oos:ListExecutionTasks
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

CancelExecution oos:CancelExecution
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

3.鉴权规则

API参考·鉴权规则 运维编排
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NotifyExecution oos:NotifyExecution
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

DeleteExecutions oos:DeleteExecutions
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

ListExecutionLogs oos:ListExecutionLogs
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

GetExecutionTemplate oos:GetExecutionTemplate
acs:oos:$regionid:$accountid:ex
ecution/${executionId}

OpenAPI Action 资源ARN
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本文适用基于API URL发起HTTP/HTTPS GET请求的用户，如果您使用的是SDK可以跳过此环节。

发起API请求的URL由不同参数拼凑而成，有固定的请求结构。URL中包含公共参数、您的签名机制和某个API的
具体参数。每篇API文档均给出了URL请求示例供您参考，但是为了方便显示，我们并没有编码这些URL示
例，您需要在发起请求前自行编码。我们根据您的签名验证了请求后，会返回结果。接口调用成功会显示返
回参数，调用失败则显示相应报错，您可以根据公共错误码和具体API错误码分析排查。

说明  推荐您使用SDK，以免除您手动签名验证环节，方便调用接口以及管理资源。

公共参数分为公共请求参数和公共返回参数。

公共请求参数

名称 类型 是否必需 描述

Action String 是
API的名称。取值参见API
概览。

AccessKeyId String 是
访问密钥ID。AccessKey
用于调用API，而用户密码
用于登录OOS 管理控制台

Signature String 是
您的签名。取值参见签名
机制。

SignatureMethod String 是
签名方式。取值范围：
HMAC-SHA1。

SignatureVersion String 是
签名算法版本。取值范
围：1.0。

SignatureNonce String 是

签名唯一随机数。用于防
止网络重放攻击，建议您
每一次请求都使用不同的
随机数。

Timestamp String 是

请求的时间戳。按照时间
格式标准表示，并需要使
用UTC时间，格式为yyyy-
MM-ddTHH:mm:ssZ。示
例：  2019-06-
01T12:00:00Z 表示北
京时间2019年06月01日
12点00分00秒。

4.HTTP调用方式
4.1. 概述

4.2. 公共参数

API参考·HTTP调用方式 运维编排
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Version String 是
API 的版本号，格式为
YYYY-MM-DD。取值范
围：2019-06-01。

Format String 是
返回参数的语言类型。取
值范围：json。

名称 类型 是否必需 描述

请求示例

https://oos.cn-hangzhou.aliyuncs.com/?Action=XXXXXX
&Format=json
&Version=2019-06-01
&Signature=cWgxtKc9dQWgSMB7OEhtOkq%2B9AM%3D
&SignatureMethod=HMAC-SHA1
&SignatureNonce=479a2bf5-8045-11e9-8d42-6c96cfdd1fa1
&SignatureVersion=1.0
&AccessKeyId=key-test
&Timestamp=2019-05-27T06%3A04%3A25Z
…

公共返回参数

名称 类型 描述

RequestId String
请求ID。无论调用接口成功与否，我
们都会返回请求ID。

阿里云OOS API支持基于URL发起HTTP/HTTPS GET请求。请求参数需要包含在URL中。本文列举了GET请求
中的结构解释，并提供了OOS的服务接入地址（Endpoint）。

结构示例
以下为CreateTemplate一条未编码的URL请求示例：

https://oos.cn-hangzhou.aliyuncs.com/?Action=CreateTemplate
&TemplateName=YourTemplateName
&<公共请求参数>

 https 指定了请求通信协议。

 oos.cn-hangzhou.aliyuncs.com 指定了OOS的服务接入地址（Endpoint）。

 Action=CreateTemplate 指定了要调用的
API，  TemplateName=YourTemplateName 是CreateTemplate规定的参数。

 <公共请求参数> 是系统规定的公共参数。

通信协议

4.3. 请求结构

运维编排 API参考·HTTP调用方式
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支持HTTP或HTTPS协议请求通信。为了获得更高的安全性，推荐您使用HTTPS协议发送请求。

涉及敏感数据时，如用户密码和SSH密钥对，推荐使用HTTPS协议。例如，在StartExecution中指定敏感参数
时。

接入地址
OOS API的服务接入地址，参见以下表格。为较少网络延时，建议您根据业务调用来源配置接入地址。

华东1（杭州） oos.cn-hangzhou.aliyuncs.com

华北2（北京） oos.cn-beijing.aliyuncs.com

华北5（呼和浩特） oos.cn-huhehaote.aliyuncs.com

华北3（张家口) oos.cn-zhangjiakou.aliyuncs.com

中国香港 oos.cn-hongkong.aliyuncs.com

华东2（上海） oos.cn-shanghai.aliyuncs.com

华南1（深圳） oos.cn-shenzhen.aliyuncs.com

印度（孟买） oos.ap-south-1.aliyuncs.com

美国（弗吉尼亚） oos.us-east-1.aliyuncs.com

德国（法兰克福） oos.eu-central-1.aliyuncs.com

西南1（成都) oos.cn-chengdu.aliyuncs.com

英国（伦敦） oos.eu-west-1.aliyuncs.com

印度尼西亚（雅加达） oos.ap-southeast-5.aliyuncs.com

马来西亚（吉隆坡） oos.ap-southeast-3.aliyuncs.com

澳大利亚（悉尼） oos.ap-southeast-2.aliyuncs.com

新加坡 oos.ap-southeast-1.aliyuncs.com

日本（东京） oos.ap-northeast-1.com

请求参数
您需要通过  Action 参数指定目标操作，例如Action=CreateTemplate。还需要指定接口的其他参数以
及公共请求参数。

字符编码
请求及返回结果都使用  UTF-8 字符集编码。

4.4. 签名机制
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对于每一次HTTP或者HTTPS协议请求，我们会根据访问中的签名信息验证访问请求者身份。具体由使用
AccessKeyID和AccessKeySecret对称加密验证实现。

AccessKey相当于用户密码，AccessKey用于调用API，而用户密码用于登录OOS控制台。其中AccessKeyID
是访问者身份，AccessKeySecret是加密签名字符串和服务器端验证签名字符串的密钥，必须严格保密谨防
泄露。

说明

我们提供了多种编程语言的SDK及第三方SDK，可以免去您签名的烦恼。更多详情，请下载SDK。

构造规范化请求字符串
1. 排序参数。排序规则以首字母顺序排序，排序参数包括公共请求参数和接口自定义参数，不包括公共请求

参数中的  Signature 参数。

说明

当使用GET方法提交请求时，这些参数就是请求URL中的参数部分，即URL中  ? 之后由  & 连接的

部分。

2. 编码参数。使用UTF-8字符集按照RFC3986规则编码请求参数和参数取值，编码规则如下：

字符A~Z、a~z、0~9以及字符  - 、  _ 、  . 、  ~ 不编码。

其它字符编码成  %XY 的格式，其中  XY 是字符对应ASCII码的16进制。示例：半角双引号（  " ）

对应  %22 。

扩展的UTF-8字符，编码成  %XY%ZA… 的格式。

空格（ ）编码成  %20 ，而不是加号（  + ）。该编码方式与

 application/x-www-form-urlencoded  MIME格式编码算法相似，但又有所不同。如果您使用的是

Java标准库中的  java.net.URLEncoder ，可以先用标准库中  percentEncode 编码，随后将编码后

的字符中加号（  + ）替换为  %20 、星号（  * ）替换为  %2A 、  %7E 替换为波浪号（  ~ 

），即可得到上述规则描述的编码字符串。

private static final String ENCODING = "UTF-8";
private static String percentEncode(String value) throws UnsupportedEncodingException
{
return value != null ? URLEncoder.encode(value, ENCODING).replace("+", "%20").replace
("*", "%2A").replace("%7E", "~") : null;
}

3. 使用等号（  = ）连接编码后的请求参数和参数取值。

4. 使用与号（  & ）连接编码后的请求参数，注意参数排序与步骤一：构造规范化请求字符串一致。

运维编排 API参考·HTTP调用方式
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现在，您得到了规范化请求字符串（CanonicalizedQueryString），其结构遵循请求结构。

构造签名字符串

1. 构造待签名字符串  StringToSign 。您可以同样使用  percentEncode 处理上一步构造的规范化请求

字符串，规则如下：

StringToSign=
HTTPMethod + "&" + //HTTPMethod：发送请求的 HTTP ⽅法，例如 GET。
percentEncode("/") + "&" + //percentEncode("/")：字符（/）UTF-8 编码得到的值，即 %2F。
percentEncode(CanonicalizedQueryString) //您的规范化请求字符串。

2. 按照RFC2104的定义，计算待签名字符串  StringToSign 的HMAC-SHA1值。示例使用的是Java Base64

编码方法。

Signature = Base64( HMAC-SHA1( AccessSecret, UTF-8-Encoding-Of(StringToSign) ) )

3. 添加根据RFC3986规则编码后的参数  Signature 到规范化请求字符串URL中。

说明

计算签名时，RFC2104规定的Key值是您的  AccessKeySecret 并加上与号（  & )，其ASCII值为38。

示例 1. 参数拼接法

以调用ListTemplates查询模板为例。假设您获得了  AccessKeyID=testid 以及

 AccessKeySecret=testsecret ，签名流程如下所示：

1. 构造规范化请求字符串。

AccessKeyId=testid&Action=ListTemplates&Format=json&SignatureMethod=HMAC-SHA1&Signature
Nonce=9a3fdf30-8049-11e9-8875-6c96cfdd1fa1&SignatureVersion=1.0&Timestamp=2019-05-27T06
%3A35%3A22Z&Version=2019-06-01

2. 构造待签名字符串  StringToSign ，详情请参见步骤二：构造签名字符串。

GET&%2F&AccessKeyId%3Dtestid&Action%3DListTemplates&Format%3Djson&SignatureMethod%3DHMA
C-SHA1&SignatureNonce%3D9a3fdf30-8049-11e9-8875-6c96cfdd1fa1&SignatureVersion%3D1.0&Tim
estamp%3D2019-05-27T06%253A35%253A22Z&Version%3D2019-06-01

3. 计算签名值。因为  AccessKeySecret=testsecret ，用于计算的Key为  testsecret& ，计算得到的

签名值为  1FcsD6/AvH2KugeowoCJSi8lBd8= 。示例使用的是Java Base64编码方法。

Signature = Base64( HMAC-SHA1( AccessSecret, UTF-8-Encoding-Of(StringToSign) ) )

4. 添加RFC3986规则编码后的  Signature=1FcsD6%2FAvH2KugeowoCJSi8lBd8%3D 到步骤一：构造规范化请求

字符串的URL中。
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http://oos.cn-hangzhou.aliyuncs.com/?SignatureVersion=1.0&Format=json&Timestamp=2019-05
-27T06%3A35%3A22Z&AccessKeyId=testid&SignatureMethod=HMAC-SHA1&Version=2019-06-01&Signa
ture=1FcsD6%2FAvH2KugeowoCJSi8lBd8%3D&Action=ListTemplates&SignatureNonce=9a3fdf30-8049
-11e9-8875-6c96cfdd1fa1

通过以上URL，您可以使用浏览器、curl或者wget等工具发起HTTP请求调用  ListTemplates ，查询您的模

板。

示例 2. 编程语言法
依然以调用ListTemplates查询模板为例。假设您获得了AccessKeyID=test id以及
AccessKeySecret=testsecret，并且假定所有请求参数放在一个Java  Map<String, String> 对象里。

1. 预定义编码方法。

private static final String ENCODING = "UTF-8";
private static String percentEncode(String value) throws UnsupportedEncodingException {
return value != null ? URLEncoder.encode(value, ENCODING).replace("+", "%20").replace("
*", "%2A").replace("%7E", "~") : null;
}

2. 预定义编码时间格式  Timestamp 。参数  Timestamp 必须符合时间格式规范，并需要使用UTC时间，

时区为+0。

private static final String ISO8601_DATE_FORMAT = "yyyy-MM-dd'T'HH:mm:ss'Z'";
private static String formatIso8601Date(Date date) {
SimpleDateFormat df = new SimpleDateFormat(ISO8601_DATE_FORMAT);
df.setTimeZone(new SimpleTimeZone(0, "GMT"));
return df.format(date);
}

3. 构造请求字符串。
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final String HTTP_METHOD = "GET";
Map parameters = new HashMap();
// 输⼊请求参数
parameters.put("Action", "ListTemplates");
parameters.put("Version", "2019-06-01");
parameters.put("AccessKeyId", "testid");
parameters.put("Timestamp", formatIso8601Date(new Date()));
parameters.put("SignatureMethod", "HMAC-SHA1");
parameters.put("SignatureVersion", "1.0");
parameters.put("SignatureNonce", UUID.randomUUID().toString());
parameters.put("Format", "JSON");
// 排序请求参数
String[] sortedKeys = parameters.keySet().toArray(new String[]{});
Arrays.sort(sortedKeys);
final String SEPARATOR = "&";
// 构造 stringToSign 字符串
StringBuilder stringToSign = new StringBuilder();
stringToSign.append(HTTP_METHOD).append(SEPARATOR);
stringToSign.append(percentEncode("/")).append(SEPARATOR);
StringBuilder canonicalizedQueryString = new StringBuilder();
for(String key : sortedKeys) {
// 这⾥注意编码 key 和 value
canonicalizedQueryString.append("&")
.append(percentEncode(key)).append("=")
.append(percentEncode(parameters.get(key)));
}
// 这⾥注意编码 canonicalizedQueryString
stringToSign.append(percentEncode(
canonicalizedQueryString.toString().substring(1)));

4. 签名。因为  AccessKeySecret=testsecret ，所以用于计算HMAC的Key为  testsecret& ，计算得到

的签名值为  1FcsD6/AvH2KugeowoCJSi8lBd8= 。

// 以下是⼀段计算签名的⽰例代码
final String ALGORITHM = "HmacSHA1";
final String ENCODING = "UTF-8";
key = "testsecret&";
Mac mac = Mac.getInstance(ALGORITHM);
mac.init(new SecretKeySpec(key.getBytes(ENCODING), ALGORITHM));
byte[] signData = mac.doFinal(stringToSign.getBytes(ENCODING));
String signature = new String(Base64.encodeBase64(signData));

5. 增加签名参数后，按照RFC3986规则编码后的URL如下所示：

http://oos.cn-hangzhou.aliyuncs.com/?SignatureVersion=1.0&Format=json&Timestamp=2019-05
-27T06%3A35%3A22Z&AccessKeyId=testid&SignatureMethod=HMAC-SHA1&Version=2019-06-01&Signa
ture=1FcsD6%2FAvH2KugeowoCJSi8lBd8%3D&Action=ListTemplates&SignatureNonce=9a3fdf30-8049
-11e9-8875-6c96cfdd1fa1
                                        

6. 使用浏览器、curl或者wget等工具发送HTTP请求。
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{
"Templates": [
 {
   "Hash": "9ea05673ea6c7d03fe8707ddd3d347d74f9e47963538097d120583c0b5385edf",
   "Description": "",
   "TemplateName": "demo",
   "ShareType": "Private",
   "Tags": [],
   "TemplateFormat": "JSON",
   "CreatedBy": "1000008528360000",
   "CreatedDate": "2019-06-01T12:00:00Z",
   "TemplateVersion": "v1",
   "TotalExecutionCount": 1
 },...],
 "NextToken": "gAAAAABc5pnvl_meBuZkGEbZNmzTOA1RotEjFs4q8q2fICes_oGk4qenxGB5UeyXYWa5eF4T
eZLQMpnVc6rmhr2BC0Kahyx1P5brt_fQvLFTLBEcXQzzqsWwxDS-Y1xL7pkhOOgU_K3Z0-dMQHOkIQwWhodp4qu
tzKNO7gQ-EPWQvM1ugrGkonFDe_bV3TckHyHqgJDTLwk8Swfm1NvnZTXg9AH8YLvhu0fTK8sgXI6nBkvqTkozed
WFhq8jmH1SFbs1yVZoKoKpFaYV6-vuTFcUO9G9-5W0YVdfliTuEOf42QHtkWLZ8jj1Xhmk9rTBYjb7P4KmRm7b7
UhQ6FamvpVv9vXlCQvWAafnPgT98ViFlr6z7ByNHrI=",
 "RequestId": "8B813042-7F00-45CE-AF8C-85CCEEFC6BA2",
 "MaxResults": 50
}

返回结果列举了模板信息。

返回结果为JSON格式。为了便于查看和美观，API文档返回示例均有换行和缩进等处理，实际返回结果无换
行和缩进处理。

正常返回示例
接口调用成功后会返回接口返回参数和请求ID，我们称这样的返回为正常返回。HTTP状态码为2xx。

JSON示例

{
  "RequestId": "AC467B38-3910-447D-87BC-AC049166F216" /* 返回结果数据 */
}

异常返回示例
接口调用出错后，会返回错误码、错误信息和请求ID，我们称这样的返回为异常返回。HTTP状态码为4xx或
者5xx。

您可以根据接口错误码，参考公共错误码以及API错误中心排查错误。当您无法排查错误时，可以提交工单联
系我们，并在工单中注明服务节点  HostId 和  RequestId 。

JSON示例

4.5. 返回结果
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{
  "RequestId": "A40CFF28-407A-40B5-B6A5-AC049166F216", /* 请求 ID */
  "HostId": "oos.cn-hangzhou.aliyuncs.com", /* 服务节点 */
  "Code": "InvalidNextToken", /* 错误码 */
  "Message": "NextToken is invalid" /* 错误信息 */
}

公共错误码

错误代码 HT T P状态码   错误信息 描述

InvalidVersion 400
Specified parameter
Version is not valid.

给定的Version非法。请检
查URL中指定的Version的
正确性。

InvalidAction.NotFound 400
Specified api is not
found, please check
your url and method.

给定的API不存在。请检查
URL中指定的Action的正
确性。

Throttling.User 400

Request was denied
due to user flow
control. 访问频率太高导致流控。

InvalidParameter 400
内容随校验场景不同而不
同，如 TemplateName
can not contain “*”

参数非法。请根据错误信
息来检查指定参数的正确
性。

User.NoPermission 400
User has no permission
to do the action:
({api_name})

用户没有调用某个API的权
限。请检查是否在RAM中
给当前用户赋予了OOS的
API的权限。

InvalidStsToken 400
Invalid STS token to do
the action: ({api_name})

给定的STS Token非法。

ExpiredStsToken 400
Expired STS token to do
the action: ({api_name})

给定的STS Token过期。

MissingParameter 400
The Parameter ({name})
was not provided.

缺少必填参数。

API参考·HTTP调用方式 运维编排

20 > 文档版本：20220705



QuotaExceed 400
The Quota ({key})
exceeded ({value}).

特定属性（如模板数量、
正在运行的执行数等）超
过上限。

InvalidAccountType 400
The account type
({account_type}) was
not supported.

不支持给定的账号类型。

TemplateValidationErro
r

400 {reason}
模板约束，如参数类型、
数值等，校验不通过。

InvalidFunctionParamete
rs

400
The specified function
{fn_name}’s parameters
are incorrect.

模板中使用函数时给定的
参数校验错误。请检查参
数的数量和值。

InvalidTemplateReferen
ce

400
The specified reference
{resource} (in {key}) is
incorrect.

模板内参数引用不正确。

UnknownUserParameter 400
The parameter ({key})
was not defined in
engine.

模板中给定的参数未定义
或不被支持。

InvalidT imerTriggerPara
meter

400
The parameter ({key}) is
invalid

T imerTrigger动作的给定
参数非法。

InvalidTemplateParame
ter

400
The parameter ({key})
has no attributes.

模板中的Parameters类型
非法，必须为字典。

错误代码 HT T P状态码   错误信息 描述
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调用CreateTemplate创建一个模版。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 CreateTemplate
系统规定参数。取
值：Creat eT emplat e   。

RegionId String 否 cn-hangzhou 地域ID

TemplateName String 是 MyTemplate

模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符，且不能以
ALIYUN、ACS、ALIBABA、ALICLOUD开
头。

Content String 是

{"FormatVersion"
: "OOS-2019-06-
01",
"Description":
"Describe
instances of
given status",
"Parameters":
{"Status":
{"Type": "String",
"Description": "
(Required) The
status of the Ecs
instance."}},
"Tasks":
[{"Properties":
{"Parameters":
{"Status": "{{
Status }}"}, "API":
"DescribeInstance
s", "Service":
"Ecs"}, "Name":
"foo", "Action":
"ACS::ExecuteApi
"}]}

模板内容。JSON或YAML格式，长度限制
为 64 KB。

5.模板
5.1. CreateTemplate
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Tags Map 否
{"k1":"v1","k2":"v
2"}

标签键和值列表， 标签键值对数量范围是
1至20。

VersionName String 否 v2 版本名称。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

TemplateType String Private 模版类型。

RequestId String
20758A-585D-4A41-
A9B2-28DA8F4F534F

请求ID

Template Object 模板元信息

Hash String

4bc7d7a21b3e0034
34b9c223f6e6d2578
b5ebfeb5be28c1fcf
8a8a1b11907bb4

模板内容的SHA256

UpdatedDate String
2019-05-
16T10:26:14Z

模板更新时间

UpdatedBy String root(130900000) 模板更新者

Tags Map 该资源的标签

TemplateName String MyTemplate 模板名称

TemplateVersi
on

String v1
模板版本。以“v”+数字的形式，数字从1开
始。

TemplateForm
at

String JSON 模板格式。系统字段判断，为JSON或YAML。

Description String
Describe instances
of given status

模板说明
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ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(13090000) 模板创建者

CreatedDate String
2019-05-
16T10:26:14Z

模板创建时间

TemplateId String t-94753d38 模板ID

HasTrigger Boolean true 是否成功触发

ShareType String Private
模板共享类型。目前用户创建的模板的共享类型
均为 Private。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=CreateTemplate
&RegionId=cn-hangzhou
&TemplateName=MyTemplate
&Content={"FormatVersion": "OOS-2019-06-01", "Description": "Describe instances of given st
atus", "Parameters": {"Status": {"Type": "String", "Description": "(Required) The status of
the Ecs instance."}}, "Tasks": [{"Properties": {"Parameters": {"Status": "{{ Status }}"}, "
API": "DescribeInstances", "Service": "Ecs"}, "Name": "foo", "Action": "ACS::ExecuteApi"}]}
&VersionName=v2
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<CreateTemplateResponse>
    <RequestId>20758A-585D-4A41-A9B2-28DA8F4F534F</RequestId>
    <Template>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2019-05-27T08:46:33Z</CreatedDate>
        <UpdatedBy>root(1309000000)</UpdatedBy>
        <UpdatedDate>2019-05-27T08:46:33Z</UpdatedDate>
        <Description>Describe instances of given status</Description>
        <Hash>4bc7d7a21b3e003434b9c223f6e6d2578b5ebfeb5be28c1fcf8a8a1b11907bb4</Hash>
        <ShareType>Private</ShareType>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <TemplateFormat>JSON</TemplateFormat>
        <TemplateName>MyTemplate</TemplateName>
        <TemplateId>t-94753eeaef8</TemplateId>
        <TemplateVersion>v1</TemplateVersion>
    </Template>
</CreateTemplateResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "20758A-585D-4A41-A9B2-28DA8F4F534F",
  "Template" : {
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2019-05-27T08:46:33Z",
    "UpdatedBy" : "root(1309000000)",
    "UpdatedDate" : "2019-05-27T08:46:33Z",
    "Description" : "Describe instances of given status",
    "Hash" : "4bc7d7a21b3e003434b9c223f6e6d2578b5ebfeb5be28c1fcf8a8a1b11907bb4",
    "ShareType" : "Private",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "TemplateFormat" : "JSON",
    "TemplateName" : "MyTemplate",
    "TemplateId" : "t-94753eeaef8",
    "TemplateVersion" : "v1"
  }
}

错误码
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访问错误中心查看更多错误码。

调用DeleteTemplate删除一个模版。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 DeleteTemplate
系统规定参数。取
值：Delet eT emplat e   。

TemplateName String 是 MyTemplate

模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符，且不能以
ALIYUN、ACS、ALIBABA、ALICLOUD开
头。

RegionId String 否 cn-hangzhou 地域ID

AutoDeleteExecut
ions

Boolean 否 false 删除模版时，顺带删除其相关的执行。

返回数据

名称 类型 示例值 描述

RequestId String
2075899A-585D-
4A41-A9B2-
28DA8534F

请求ID

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=DeleteTemplate
&TemplateName=MyTemplate
&<公共请求参数>

正常返回示例

 XML  格式

5.2. DeleteTemplate
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<DeleteTemplateResponse>
      <RequestId>2075899A-585D-4A41-A9B2-28DA8534F</RequestId>
</DeleteTemplateResponse>

 JSON  格式

{
  "RequestId": "2075899A-585D-4A41-A9B2-28DA8534F"
}

错误码
访问错误中心查看更多错误码。

调用该API删除多个模版

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 DeleteTemplates
系统规定参数。取值：
DeleteTemplates。

TemplateNames String 是 ["t1","t2"] 将要删除模版名称列表

RegionId String 否 cn-hangzhou 地域ID

AutoDeleteExecut
ions

Boolean 否 false
删除模版时，是否顺带删除其相关的执
行。

返回数据

名称 类型 示例值 描述

RequestId String
2075899A-585D-
4A41-A9B2-
28DA8534

请求ID

示例
请求示例

5.3. DeleteTemplates
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http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=DeleteTemplates
&TemplateNames=["t1","t2"]
&<公共请求参数>

正常返回示例

 XML  格式

<DeleteTemplateResponse>
      <RequestId>2075899A-585D-4A41-A9B2-28DA8534F</RequestId>
</DeleteTemplateResponse>

 JSON  格式

{
  "RequestId": "2075899A-585D-4A41-A9B2-28DA8534F"
}

错误码
访问错误中心查看更多错误码。

调用GetTemplate获取一个模版，包括内容。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 GetTemplate 系统规定参数。取值：Get T emplat e   。

RegionId String 否 cn-hangzhou 地域ID

TemplateName String 是 MyTemplate
模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符。

TemplateVersion String 否 v1

模板版本。格式：“v”+ 数字  。取值范
围：v1-v200。

返回数据

5.4. GetTemplate
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名称 类型 示例值 描述

"FormatVersion:
OOS-2019-06-
01\nDescription:\n
en: Creates an ECS
image\n zh-cn: 创建
一个ECS镜像\n
name-en: Create
Image\n name-zh-
cn: 创建镜像\n
categories:\n -
image_manage\n -
application_manage
\nParameters:\n
regionId:\n Type:
String\n Label:\n
en: RegionId\n zh-
cn: 地域ID\n
AssociationProperty
: RegionId\n
Default: '{{
ACS::RegionId }}'\n
instanceId:\n
Label:\n en:
InstanceId\n zh-cn:
ECS实例ID\n Type:
String\n
AssociationProperty
:
ALIYUN::ECS::Instan
ce::InstanceId\n
AssociationProperty
Metadata:\n
RegionId: regionId\n
imageName:\n
Label:\n en:
ImageName\n zh-
cn: 新镜像的名称\n
Type: String\n
Description:\n en:
<p
class=\"p\">Note:
</p> <ul
class=\"ul\"> <li
class=\"li\">Length
is 2~128 English or
Chinese
characters</li> <li
class=\"li\"><font
color='red'>must
start with big or
small letters or
Chinese, not http://
and https://.
</font></li> <li
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Content String

class=\"li\">Can
contain numbers,
colons (:),
underscores (_), or
dashes (-). </li>
</ul>\n zh-cn: <p
class=\"p\">注意：
</p> <ul
class=\"ul\"> <li
class=\"li\">长度为
2~128个英文或中文
字符</li> <li
class=\"li\"><font
color='red'>必须以
大小字母或中文开
头，不能以http://和
https://开头。
</font></li> <li
class=\"li\">可以包
含数字、半角冒号
（:）、下划线（_）
或者短划线（-）。
</li> </ul>\n
tags:\n Label:\n
en: Tags\n zh-cn:
镜像标签\n Type:
Json\n
AssociationProperty
: Tags\n
AssociationProperty
Metadata:\n
ShowSystem:
false\n Default: []\n
OOSAssumeRole:\n
Label:\n en:
OOSAssumeRole\n
zh-cn: OOS扮演的
RAM角色\n Type:
String\n Default:
OOSServiceRole\nRa
mRole: '{{
OOSAssumeRole
}}'\nTasks:\n-
Name:
createImage\n
Action:
ACS::ECS::CreateIm
age\n
Description:\n en:
Create new image
with the specified
image name and
instance ID\n zh-cn:
通过指定实例ID和镜
像名称创建新的镜像
\n Properties:\n

模板内容

名称 类型 示例值 描述

API参考·模板 运维编排

30 > 文档版本：20220705



regionId: '{{ regionId
}}'\n imageName: '{{
imageName
}}__on_{{
ACS::ExecutionId
}}_at_{{
Acs::CurrentDate
}}'\n instanceId: '{{
instanceId }}'\n
tags: '{{tags}}'\n
Outputs:\n
imageId:\n
ValueSelector:
imageId\n Type:
String\nOutputs:\n
imageId:\n Type:
String\n Value: '{{
createImage.imageI
d }}'\nMetadata:\n
ALIYUN::OOS::Interf
ace:\n
ParameterGroups:\n
- Parameters:\n -
regionId\n -
instanceId\n
Label:\n default:\n
zh-cn: 选择实例\n
en: Select Ecs
Instances\n -
Parameters:\n -
imageName\n -
tags\n Label:\n
default:\n zh-cn: 镜
像设置\n en: Image
Configure\n -
Parameters:\n -
OOSAssumeRole\n
Label:\n default:\n
zh-cn: 高级选项\n
en: Control Options"

RequestId String
5BBE2663-A18E-
5261-9BBB-
F4832F5294D9

请求ID

Template Object 模板元信息

Hash String

40fb5e3e08ef6c8a4
99ff7cd8441194f51
8028ad08338a84cb7
0c023a64576f1

模板内容的SHA256

UpdatedDate String
2022-04-
26T08:37:07Z

模板更新时间

名称 类型 示例值 描述
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UpdatedBy String ACS 模板更新者

TemplateType String Automation 模板类型

Tags Map 标签键及值，键值对数量限制为1至20。

TemplateName String
ACS-ECS-
CreateImage

模板名称

TemplateVersi
on

String v15
模板版本。以“v”+数字的形式，数字从1开
始。

TemplateForm
at

String YAML 模板格式。系统字段判断，为JSON或YAML。

Description String

"{\"en\": \"Creates
an ECS image\",
\"zh-cn\": \"创建一
个ECS镜像\",
\"name-en\":
\"Create Image\",
\"name-zh-cn\":
\"创建镜像\",
\"categories\":
[\"image_manage\",
\"application_mana
ge\"]}"

模板描述

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String ACS 模板创建者

CreatedDate String
2019-05-
16T10:26:14Z

模板创建时间

VersionName String version15 版本名称

TemplateId String
t-
4bdb1745c1714018
83a2

模板ID

HasTrigger Boolean false 是否含有触发器

名称 类型 示例值 描述
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ShareType String Public
模板共享类型。目前用户创建的模板的共享类型
均为 Private。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetTemplate
&RegionId=cn-hangzhou
&TemplateName=MyTemplate
&TemplateVersion=v1
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<GetTemplateResponse>
    <Content>"FormatVersion: OOS-2019-06-01\nDescription:\n  en:  Creates an ECS image\n  z
h-cn: 创建⼀个ECS镜像\n  name-en: Create Image\n  name-zh-cn: 创建镜像\n  categories:\n    - i
mage_manage\n    - application_manage\nParameters:\n  regionId:\n    Type: String\n    Labe
l:\n      en: RegionId\n      zh-cn: 地域ID\n    AssociationProperty: RegionId\n    Default:
'{{ ACS::RegionId }}'\n  instanceId:\n    Label:\n      en: InstanceId\n      zh-cn: ECS实例
ID\n    Type: String\n    AssociationProperty: ALIYUN::ECS::Instance::InstanceId\n    Assoc
iationPropertyMetadata:\n      RegionId: regionId\n  imageName:\n    Label:\n      en: Imag
eName\n      zh-cn: 新镜像的名称\n    Type: String\n    Description:\n      en: &lt;p class=\
"p\"&gt;Note:&lt;/p&gt; &lt;ul class=\"ul\"&gt; &lt;li class=\"li\"&gt;Length is 2~128 Engl
ish or Chinese characters&lt;/li&gt; &lt;li class=\"li\"&gt;&lt;font color='red'&gt;must st
art with big or small letters or Chinese, not http:// and https://. &lt;/font&gt;&lt;/li&gt
; &lt;li class=\"li\"&gt;Can contain numbers, colons (:), underscores (_), or dashes (-). &
lt;/li&gt; &lt;/ul&gt;\n      zh-cn: &lt;p class=\"p\"&gt;注意：&lt;/p&gt; &lt;ul class=\"ul
\"&gt; &lt;li class=\"li\"&gt;⻓度为2~128个英⽂或中⽂字符&lt;/li&gt; &lt;li class=\"li\"&gt;&l
t;font color='red'&gt;必须以⼤⼩字⺟或中⽂开头，不能以http://和https://开头。&lt;/font&gt;&lt;/l
i&gt; &lt;li class=\"li\"&gt;可以包含数字、半⻆冒号（:）、下划线（_）或者短划线（-）。&lt;/li&gt; 
&lt;/ul&gt;\n  tags:\n    Label:\n      en: Tags\n      zh-cn: 镜像标签\n    Type: Json\n   
AssociationProperty: Tags\n    AssociationPropertyMetadata:\n      ShowSystem: false\n    D
efault: []\n  OOSAssumeRole:\n    Label:\n      en: OOSAssumeRole\n      zh-cn: OOS扮演的RAM
⻆⾊\n    Type: String\n    Default: OOSServiceRole\nRamRole: '{{ OOSAssumeRole }}'\nTasks:\
n- Name: createImage\n  Action: ACS::ECS::CreateImage\n  Description:\n    en: Create new i
mage with the specified image name and instance ID\n    zh-cn: 通过指定实例ID和镜像名称创建新的
镜像\n  Properties:\n    regionId: '{{ regionId }}'\n    imageName: '{{ imageName }}__on_{{ 
ACS::ExecutionId }}_at_{{ Acs::CurrentDate }}'\n    instanceId: '{{ instanceId }}'\n    tag
s: '{{tags}}'\n  Outputs:\n    imageId:\n      ValueSelector: imageId\n      Type: String\n
Outputs:\n  imageId:\n    Type: String\n    Value: '{{ createImage.imageId }}'\nMetadata:\n
ALIYUN::OOS::Interface:\n    ParameterGroups:\n      - Parameters:\n          - regionId\n 
- instanceId\n        Label:\n          default:\n            zh-cn: 选择实例\n            e
n: Select Ecs Instances\n      - Parameters:\n          - imageName\n          - tags\n    
Label:\n          default:\n            zh-cn: 镜像设置\n            en: Image Configure\n  
- Parameters:\n          - OOSAssumeRole\n        Label:\n          default:\n            z

运维编排 API参考·模板

> 文档版本：20220705 33



- Parameters:\n          - OOSAssumeRole\n        Label:\n          default:\n            z
h-cn: ⾼级选项\n            en: Control Options"</Content>
    <RequestId>5BBE2663-A18E-5261-9BBB-F4832F5294D9</RequestId>
    <Template>
        <Hash>40fb5e3e08ef6c8a499ff7cd8441194f518028ad08338a84cb70c023a64576f1</Hash>
        <UpdatedDate>2022-04-26T08:37:07Z</UpdatedDate>
        <UpdatedBy>ACS</UpdatedBy>
        <TemplateType>Automation</TemplateType>
        <TemplateName>ACS-ECS-CreateImage</TemplateName>
        <TemplateVersion>v15</TemplateVersion>
        <TemplateFormat>YAML</TemplateFormat>
        <Description>"{\"en\": \"Creates an ECS image\", \"zh-cn\": \"创建⼀个ECS镜像\", \"na
me-en\": \"Create Image\", \"name-zh-cn\": \"创建镜像\", \"categories\": [\"image_manage\", 
\"application_manage\"]}"</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>ACS</CreatedBy>
        <CreatedDate>2019-05-16T10:26:14Z</CreatedDate>
        <VersionName>version15</VersionName>
        <TemplateId>t-4bdb1745c171401883a2</TemplateId>
        <HasTrigger>false</HasTrigger>
        <ShareType>Public</ShareType>
    </Template>
</GetTemplateResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "Content" : "\"FormatVersion: OOS-2019-06-01\\nDescription:\\n  en:  Creates an ECS image
\\n  zh-cn: 创建⼀个ECS镜像\\n  name-en: Create Image\\n  name-zh-cn: 创建镜像\\n  categories:
\\n    - image_manage\\n    - application_manage\\nParameters:\\n  regionId:\\n    Type: St
ring\\n    Label:\\n      en: RegionId\\n      zh-cn: 地域ID\\n    AssociationProperty: Regi
onId\\n    Default: '{{ ACS::RegionId }}'\\n  instanceId:\\n    Label:\\n      en: Instance
Id\\n      zh-cn: ECS实例ID\\n    Type: String\\n    AssociationProperty: ALIYUN::ECS::Insta
nce::InstanceId\\n    AssociationPropertyMetadata:\\n      RegionId: regionId\\n  imageName
:\\n    Label:\\n      en: ImageName\\n      zh-cn: 新镜像的名称\\n    Type: String\\n    Des
cription:\\n      en: &lt;p class=\\\"p\\\"&gt;Note:&lt;/p&gt; &lt;ul class=\\\"ul\\\"&gt; 
&lt;li class=\\\"li\\\"&gt;Length is 2~128 English or Chinese characters&lt;/li&gt; &lt;li 
class=\\\"li\\\"&gt;&lt;font color='red'&gt;must start with big or small letters or Chinese
, not http:// and https://. &lt;/font&gt;&lt;/li&gt; &lt;li class=\\\"li\\\"&gt;Can contain
numbers, colons (:), underscores (_), or dashes (-). &lt;/li&gt; &lt;/ul&gt;\\n      zh-cn:
&lt;p class=\\\"p\\\"&gt;注意：&lt;/p&gt; &lt;ul class=\\\"ul\\\"&gt; &lt;li class=\\\"li\\\
"&gt;⻓度为2~128个英⽂或中⽂字符&lt;/li&gt; &lt;li class=\\\"li\\\"&gt;&lt;font color='red'&gt
;必须以⼤⼩字⺟或中⽂开头，不能以http://和https://开头。&lt;/font&gt;&lt;/li&gt; &lt;li class=\\
\"li\\\"&gt;可以包含数字、半⻆冒号（:）、下划线（_）或者短划线（-）。&lt;/li&gt; &lt;/ul&gt;\\n  t
ags:\\n    Label:\\n      en: Tags\\n      zh-cn: 镜像标签\\n    Type: Json\\n    Associatio
nProperty: Tags\\n    AssociationPropertyMetadata:\\n      ShowSystem: false\\n    Default:
[]\\n  OOSAssumeRole:\\n    Label:\\n      en: OOSAssumeRole\\n      zh-cn: OOS扮演的RAM⻆⾊
\\n    Type: String\\n    Default: OOSServiceRole\\nRamRole: '{{ OOSAssumeRole }}'\\nTasks:
\\n- Name: createImage\\n  Action: ACS::ECS::CreateImage\\n  Description:\\n    en: Create 
new image with the specified image name and instance ID\\n    zh-cn: 通过指定实例ID和镜像名称
创建新的镜像\\n  Properties:\\n    regionId: '{{ regionId }}'\\n    imageName: '{{ imageName 
}}__on_{{ ACS::ExecutionId }}_at_{{ Acs::CurrentDate }}'\\n    instanceId: '{{ instanceId }
}'\\n    tags: '{{tags}}'\\n  Outputs:\\n    imageId:\\n      ValueSelector: imageId\\n    
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}'\\n    tags: '{{tags}}'\\n  Outputs:\\n    imageId:\\n      ValueSelector: imageId\\n    
Type: String\\nOutputs:\\n  imageId:\\n    Type: String\\n    Value: '{{ createImage.imageI
d }}'\\nMetadata:\\n  ALIYUN::OOS::Interface:\\n    ParameterGroups:\\n      - Parameters:\
\n          - regionId\\n          - instanceId\\n        Label:\\n          default:\\n   
zh-cn: 选择实例\\n            en: Select Ecs Instances\\n      - Parameters:\\n          - i
mageName\\n          - tags\\n        Label:\\n          default:\\n            zh-cn: 镜像
设置\\n            en: Image Configure\\n      - Parameters:\\n          - OOSAssumeRole\\n 
Label:\\n          default:\\n            zh-cn: ⾼级选项\\n            en: Control Options\
"",
  "RequestId" : "5BBE2663-A18E-5261-9BBB-F4832F5294D9",
  "Template" : {
    "Hash" : "40fb5e3e08ef6c8a499ff7cd8441194f518028ad08338a84cb70c023a64576f1",
    "UpdatedDate" : "2022-04-26T08:37:07Z",
    "UpdatedBy" : "ACS",
    "TemplateType" : "Automation",
    "TemplateName" : "ACS-ECS-CreateImage",
    "TemplateVersion" : "v15",
    "TemplateFormat" : "YAML",
    "Description" : "\"{\\\"en\\\": \\\"Creates an ECS image\\\", \\\"zh-cn\\\": \\\"创建⼀
个ECS镜像\\\", \\\"name-en\\\": \\\"Create Image\\\", \\\"name-zh-cn\\\": \\\"创建镜像\\\", \
\\"categories\\\": [\\\"image_manage\\\", \\\"application_manage\\\"]}\"",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "ACS",
    "CreatedDate" : "2019-05-16T10:26:14Z",
    "VersionName" : "version15",
    "TemplateId" : "t-4bdb1745c171401883a2",
    "HasTrigger" : false,
    "ShareType" : "Public"
  }
}

错误码
访问错误中心查看更多错误码。

调用ListExecutionRiskyTasks获取模版中的高风险任务。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListExecutionRisky
Tasks

系统规定参数。取
值：List Execut ionRiskyT asks    。

5.5. ListExecutionRiskyTasks
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TemplateName String 是 myTemplate 模板名称

RegionId String 否 cn-hangzhou 地域ID

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
C04B668D-D2DD-
4B40-B6E9-
0E3C4F53D5B5

请求ID

RiskyTasks Array 风险任务

API String DeleteInstance 风险API名称

Service String ECS 风险API所属云产品

Task List [“parenttask1”] 风险API所在任务

Template List
[“deleteInstanceTa
sk1”] 风险任务所在模版

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=ListExecutionRiskyTasks
&TemplateName=myTemplate
&<公共请求参数>

正常返回示例

 XML  格式
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<ListExecutionRiskyTasksResponse>
      <RequestId>C04B668D-D2DD-4B40-B6E9-0E3C4F53D5B5</RequestId>
      <RiskyTasks>
            <Task>parenttask1</Task>
            <Task>childtask2</Task>
            <Template>root template name</Template>
            <Service>ECS</Service>
            <API>DeleteInstance</API>
      </RiskyTasks>
      <RiskyTasks>
            <Task>task3</Task>
            <Template>root template name</Template>
            <Service>SLB</Service>
            <API>RemoveBackendServers</API>
      </RiskyTasks>
</ListExecutionRiskyTasksResponse>

 JSON  格式

{
    "RequestId":"C04B668D-D2DD-4B40-B6E9-0E3C4F53D5B5",
    "RiskyTasks":[
            {
                "Task": ["parenttask1","childtask2"],
                "Template": ["root template name"],
                "Service": "ECS", 
                "API": "DeleteInstance"             
            },
            {
                "Task": ["task3"],
                "Template": ["root template name"],
                "Service": "SLB", 
                "API": "RemoveBackendServers"             
            }
  ]
}

错误码
访问错误中心查看更多错误码。

调用ListTemplates查询模板，支持多种过滤方式。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

5.6. ListTemplates
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名称 类型 是否必选 示例值 描述

Action String 是 ListTemplates 系统规定参数。取值：List T emplat es    。

RegionId String 否 cn-hangzhou 地域ID

TemplateName String 否 MyTemplate
模板名称。列出含所填模板名称的所有模
板。

TemplateFormat String 否 YAML

模板格式。取值范围：

JSON

YAML

ShareType String 否 Private

分享类型。取值范围：

Public

Privat e

CreatedBy String 否 ACS

模板创建者。

对于阿里云官方提供的模板，为ACS

对于用户个人创建的模板，可填写 UID
进行筛选，或填写 用户名称  进行筛选

CreatedDateBefor
e

String 否
2019-05-
16T10:26:14Z

创建时间小于等于指定时间的模板。

格式为：YYYY-MM-DDThh:mm::ssZ

CreatedDateAfter String 否
2019-05-
16T10:26:14Z

创建时间大于等于指定时间的模板。

格式为：YYYY-MM-DDThh:mm:ssZ

Tags Map 否
{"k1":"k2","k2":"v
2"}

标签键及值，键值对数量限制为1至20。

Category String 否 TimerTrigger
模版类型如
TimerTrigger，EventTrigger，AlarmTrig
ger，Other。

MaxResults Integer 否 50
分页大小。取值范围：20-100。默认为
50。

NextToken String 否 xxx
对查询结果进行翻页时需要传入的Token
值，如有则获取自当前页的返回值。

API参考·模板 运维编排
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SortField String 否 Popularity

排序字段。取值范围：

T ot alExecut ionCount    （默认值）：
总执行次数

Popularit y ：受欢迎程度

T emplat eName  ：模板名称

Creat edDat e  ：创建时间

SortOrder String 否 Descending

排序方向。取值范围：

Ascending：升序

Descending（默认值）：降序

HasTrigger Boolean 否 true 是否触发

TemplateType String 否 private 模版类型

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

NextToken String xxx
对查询结果进行翻页时需要传入的Token值，如
有则获取自当前页的返回值。

RequestId String
BEF54BA-17B6-449F-
A219-49ACB157E3

请求ID

MaxResults Integer 50 分页大小。

Templates
Array of
Template

模板元信息

Hash String

4bc7d7a21b3e0034
34b9c223f6e6d2578
b5ebfeb5be28c1fcf
8a8a1b11907bb4

模板内容的SHA256

UpdatedDate String
2019-05-
16T10:26:14Z

模板更新时间

UpdatedBy String root(13092000) 模板更新者

运维编排 API参考·模板
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TemplateType String private 模版类型

Tags Map 标签键及值，键值对数量限制为1至20。

TemplateName String MyTemplate 模板名称

TemplateVersi
on

String v1
模板版本。以“v”+数字的形式，数字从1开
始。

TemplateForm
at

String JSON 模板格式。系统字段判断，为JSON或YAML。

Popularity Integer 8

公共模板受欢迎程度。范围是1-10，数字越高表
示越受欢迎。若ShareT ype 为Privat e ，该字段
值为  -1 。

说明  该字段
在ShareT ype 为Public时有意义。

TotalExecution
Count

Integer 5

私有模板总执行次数。
若ShareT ype 为Public，该字段值为  -1 。

说明  该字段
在ShareT ype 为Privat e 时有意义。

Description String
Describe instances
of given status

模板说明

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(1309200) 模板创建者

CreatedDate String
2019-05-
16T10:26:14Z

模板创建时间

Category String TimerTrigger 模版类型

HasTrigger Boolean true 是否成功触发

名称 类型 示例值 描述

API参考·模板 运维编排
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TemplateId String t-94753deed38 模板ID

ShareType String Public

模板共享类型。目前用户创建的模板的共享类型
均为 Privat e 。取值范围：

Public

Privat e

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=ListTemplates
&RegionId=cn-hangzhou
&TemplateName=MyTemplate
&TemplateFormat=YAML
&ShareType=Private
&CreatedBy=ACS
&CreatedDateBefore=2019-05-16T10:26:14Z
&CreatedDateAfter=2019-05-16T10:26:14Z
&Category=TimerTrigger
&MaxResults=50
&NextToken=xxx
&SortField=Popularity
&SortOrder=Descending
&HasTrigger=true
&TemplateType=private
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<ListTemplatesResponse>
    <NextToken>xxx</NextToken>
    <RequestId>BEF54BA-17B6-449F-A219-49ACB157E3</RequestId>
    <MaxResults>50</MaxResults>
    <Templates>
        <Hash>4bc7d7a21b3e003434b9c223f6e6d2578b5ebfeb5be28c1fcf8a8a1b11907bb4</Hash>
        <UpdatedDate>2019-05-16T10:26:14Z</UpdatedDate>
        <UpdatedBy>root(13092000)</UpdatedBy>
        <TemplateType>private</TemplateType>
        <TemplateName>MyTemplate</TemplateName>
        <TemplateVersion>v1</TemplateVersion>
        <TemplateFormat>JSON</TemplateFormat>
        <Popularity>8</Popularity>
        <TotalExecutionCount>5</TotalExecutionCount>
        <Description>Describe instances of given status</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(1309200)</CreatedBy>
        <CreatedDate>2019-05-16T10:26:14Z</CreatedDate>
        <Category>TimerTrigger</Category>
        <HasTrigger>true</HasTrigger>
        <TemplateId>t-94753deed38</TemplateId>
        <ShareType>Public</ShareType>
    </Templates>
</ListTemplatesResponse>

 JSON 格式

API参考·模板 运维编排

42 > 文档版本：20220705



HTTP/1.1 200 OK
Content-Type:application/json
{
  "NextToken" : "xxx",
  "RequestId" : "BEF54BA-17B6-449F-A219-49ACB157E3",
  "MaxResults" : 50,
  "Templates" : [ {
    "Hash" : "4bc7d7a21b3e003434b9c223f6e6d2578b5ebfeb5be28c1fcf8a8a1b11907bb4",
    "UpdatedDate" : "2019-05-16T10:26:14Z",
    "UpdatedBy" : "root(13092000)",
    "TemplateType" : "private",
    "TemplateName" : "MyTemplate",
    "TemplateVersion" : "v1",
    "TemplateFormat" : "JSON",
    "Popularity" : 8,
    "TotalExecutionCount" : 5,
    "Description" : "Describe instances of given status",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(1309200)",
    "CreatedDate" : "2019-05-16T10:26:14Z",
    "Category" : "TimerTrigger",
    "HasTrigger" : true,
    "TemplateId" : "t-94753deed38",
    "ShareType" : "Public"
  } ]
}

错误码
访问错误中心查看更多错误码。

调用UpdateTemplate更新一个已经存在的模板。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 UpdateTemplate
系统规定参数。取
值：Updat eT emplat e   。

RegionId String 否 cn-hangzhou 地域ID

5.7. UpdateTemplate
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TemplateName String 是 MyTemplate

模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符，且不能以
ALIYUN、ACS、ALIBABA、ALICLOUD开
头。

Content String 是

{"FormatVersion"
: "OOS-2019-06-
01",
"Description":
"Describe
instances of
given status",
"Parameters":
{"Status":
{"Type": "String",
"Description": "
(Required) The
status of the Ecs
instance."}},
"Tasks":
[{"Properties":
{"Parameters":
{"Status": "{{
Status }}"}, "API":
"DescribeInstance
s", "Service":
"Ecs"}, "Name":
"foo", "Action":
"ACS::ExecuteApi
"}]

模板内容。JSON或YAML格式，长度限制
为 64 KB。

Tags Map 否
{"k1":"k2","k2":"v
2"}

标签键及值，键值对数量限制为1至20。

VersionName String 否 v2 模版版本名称。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
2075899A-585D-
4A41-A9B2-
28DF4F534F

请求ID

Template Object 模板元信息

API参考·模板 运维编排
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Hash String

4bc7d7a21b3e0034
34b9c223f6e6d2578
b5ebfeb5be28c1fcf
8a8a1b11907bb4

模板内容的SHA256

UpdatedDate String
2019-05-
16T10:26:14Z

模板更新时间

UpdatedBy String root(1309000) 模板更新者

Tags Map 标签键及值，键值对数量限制为1至20。

TemplateName String MyTemplate 模板名称

TemplateVersi
on

String v2
模板版本。以“v”+数字的形式，数字从1开
始。

TemplateForm
at

String JSON 模板格式。系统字段判断，为JSON或YAML。

Description String
Describe instances
of given status

模板说明

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID。

CreatedBy String root(130920000) 模板创建者

CreatedDate String
2019-05-
16T10:26:14Z

模板创建时间

TemplateId String t-94753deed38 模板ID

HasTrigger Boolean true 是否成功触发

ShareType String Private
模板共享类型。目前用户创建的模板的共享类型
均为 Privat e 。

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=UpdateTemplate
&RegionId=cn-hangzhou
&TemplateName=MyTemplate
&Content={"FormatVersion": "OOS-2019-06-01", "Description": "Describe instances of given st
atus", "Parameters": {"Status": {"Type": "String", "Description": "(Required) The status of
the Ecs instance."}}, "Tasks": [{"Properties": {"Parameters": {"Status": "{{ Status }}"}, "
API": "DescribeInstances", "Service": "Ecs"}, "Name": "foo", "Action": "ACS::ExecuteApi"}]
&VersionName=v2
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<UpdateTemplateResponse>
    <RequestId>2075899A-585D-4A41-A9B2-28DF4F534F</RequestId>
    <Template>
        <Hash>4bc7d7a21b3e003434b9c223f6e6d2578b5ebfeb5be28c1fcf8a8a1b11907bb4</Hash>
        <UpdatedDate>2019-05-16T10:26:14Z</UpdatedDate>
        <UpdatedBy>root(1309000)</UpdatedBy>
        <TemplateName>MyTemplate</TemplateName>
        <TemplateVersion>v2</TemplateVersion>
        <TemplateFormat>JSON</TemplateFormat>
        <Description>Describe instances of given status</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130920000)</CreatedBy>
        <CreatedDate>2019-05-16T10:26:14Z</CreatedDate>
        <TemplateId>t-94753deed38</TemplateId>
        <HasTrigger>true</HasTrigger>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Template>
</UpdateTemplateResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "2075899A-585D-4A41-A9B2-28DF4F534F",
  "Template" : {
    "Hash" : "4bc7d7a21b3e003434b9c223f6e6d2578b5ebfeb5be28c1fcf8a8a1b11907bb4",
    "UpdatedDate" : "2019-05-16T10:26:14Z",
    "UpdatedBy" : "root(1309000)",
    "TemplateName" : "MyTemplate",
    "TemplateVersion" : "v2",
    "TemplateFormat" : "JSON",
    "Description" : "Describe instances of given status",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130920000)",
    "CreatedDate" : "2019-05-16T10:26:14Z",
    "TemplateId" : "t-94753deed38",
    "HasTrigger" : true,
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

调用ValidateTemplateContent校验一个模版是否合法。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ValidateTemplat
eContent

系统规定参数。取
值：Validat eT emplat eCont ent     。

5.8. ValidateTemplateContent
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Content String 是

{"FormatVersion"
: "OOS-2019-06-
01",
"Description":
"Describe
instances of
given status",
"Parameters":
{"Status":
{"Type": "String",
"Description": "
(Required) The
status of the Ecs
instance."}},
"Tasks":
[{"Properties":
{"Parameters":
{"Status": "{{
Status }}"}, "API":
"DescribeInstance
s", "Service":
"Ecs"}, "Name":
"foo", "Action":
"ACS::ExecuteApi
"}]}

模板内容。JSON或YAML格式，长度限制
为 64 KB。

RegionId String 否 cn-hangzhou 地域ID

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

Outputs String {} 模板输出

Parameters String

{ "Status": {
"Description": "
(Required) The
status of the Ecs
instance.", "Type":
"String" } }

模板参数

RamRole String OOSServiceRole RAM角色

RequestId String
ADF2066B-4017-
4EF0-861C-
C0FF3A9F1ED4

请求ID

Tasks Array 模板中定义的任务
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Description String
(Required) The
status of the Ecs
instance.

任务描述

Name String foo 任务名称

Outputs String .instanceId 任务输出

Properties String

{"API":
"DescribeInstances",
"Parameters":
{"Status": "{{ Status
}}"},"Service": "Ecs"}

任务属性

Type String ACS::ExecuteAPI 动作类型

名称 类型 示例值 描述

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=ValidateTemplateContent
&Content={"FormatVersion": "OOS-2019-06-01", "Description": "Describe instances of given st
atus", "Parameters": {"Status": {"Type": "String", "Description": "(Required) The status of
the Ecs instance."}}, "Tasks": [{"Properties": {"Parameters": {"Status": "{{ Status }}"}, "
API": "DescribeInstances", "Service": "Ecs"}, "Name": "foo", "Action": "ACS::ExecuteApi"}]}
&<公共请求参数>

正常返回示例

 XML  格式
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<ValidateTemplateContentResponse>
      <RequestId>ADF2066B-4017-4EF0-861C-C0FF3A9F1ED4</RequestId>
      <Outputs></Outputs>
      <Parameters>
            <Status>
                  <Description>(Required) The status of the Ecs instance.</Description>
                  <Type>String</Type>
            </Status>
      </Parameters>
      <RamRole>OOSServiceRole</RamRole>
      <Tasks>
            <Name>foo</Name>
            <Properties>
                  <API>DescribeInstances</API>
                  <Parameters>
                        <Status>{{ Status }}</Status>
                  </Parameters>
                  <Service>Ecs</Service>
            </Properties>
      </Tasks>
</ValidateTemplateContentResponse>

 JSON  格式

{
  "RequestId": "ADF2066B-4017-4EF0-861C-C0FF3A9F1ED4",
  "Outputs": {},
  "Parameters": {
    "Status": {
      "Description": "(Required) The status of the Ecs instance.",
      "Type": "String"
    }
  },
  "RamRole": "OOSServiceRole",
  "Tasks": [
    {
      "Name": "foo",
      "Properties": {
        "API": "DescribeInstances",
        "Parameters": {
          "Status": "{{ Status }}"
        },
        "Service": "Ecs"
      }
    }
  ]
}

错误码
访问错误中心查看更多错误码。

5.9. ListTemplateVersions
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调用ListTemplateVersions查询一个模版的多个版本对象。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListTemplateVers
ions

系统规定参数。取值：
ListTemplateVersions。

TemplateName String 是 describeinstances 模版名称。

RegionId String 否 cn-hangzhou 地域ID。

MaxResults Integer 否 50 最大结果数。取值范围10-100。

NextToken String 否
H8xj9c-398djs9-
39ajd9asdjjJ

用来翻页的Token字符串。

ShareType String 否 Private 模版类型。取值范围Private或Public。

返回数据

名称 类型 示例值 描述

MaxResults Integer 50 最大结果数。

NextToken String
NJSNDKLJS-
SJKJDO090k30-
JSDK232

翻向下一页的Token字符串。

RequestId String
E6CD612B-5889-
4F1A-823F-
8A4029E46

请求ID。

TemplateVersi
ons

Array 模版的多个版本对象。

Description String
Detach the eip from
the special instance.

该版本描述。

5.9. ListTemplateVersions
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TemplateForm
at

String YAML 模版内容格式。YAML或JSON。

TemplateVersi
on

String v2 该版本号。

UpdatedBy String foo 该版本模版最近更新人。

UpdatedDate String
2020-05-
19T06:05:41Z

该版本模版最近更新时间。

VersionName String baz 版本名称

名称 类型 示例值 描述

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com?Action=ListTemplateVersions
&TemplateName=describeinstances
&<公共请求参数>

正常返回示例

 XML  格式
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<ListTemplateVersionsResponse>
  <RequestId>E6CD612B-5889-4F1A-823F-8A4029E4667F</RequestId>
  <MaxResults>20</MaxResults>
  <TemplateVersions>
        <UpdatedBy>sub:239325550833674852:wb-kxy520087</UpdatedBy>
        <Description>Detach the eip from the special instance.</Description>
        <TemplateFormat>YAML</TemplateFormat>
        <UpdatedDate>2020-05-19T06:05:41Z</UpdatedDate>
        <TemplateVersion>v3</TemplateVersion>
  </TemplateVersions>
  <TemplateVersions>
        <UpdatedBy>sub:239325550833674852:wb-kxy520087</UpdatedBy>
        <Description>Detach the eip from the special instance.</Description>
        <TemplateFormat>YAML</TemplateFormat>
        <UpdatedDate>2020-05-19T02:48:16Z</UpdatedDate>
        <TemplateVersion>v2</TemplateVersion>
  </TemplateVersions>
  <TemplateVersions>
        <UpdatedBy>sub:239325550833674852:wb-kxy520087</UpdatedBy>
        <Description>Detach the eip from the special instance.</Description>
        <TemplateFormat>YAML</TemplateFormat>
        <UpdatedDate>2020-05-19T02:41:09Z</UpdatedDate>
        <TemplateVersion>v1</TemplateVersion>
  </TemplateVersions>
</ListTemplateVersionsResponse>

 JSON  格式
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{
 "RequestId": "E6CD612B-5889-4F1A-823F-8A4029E4667F",
 "MaxResults": 20,
 "TemplateVersions": [
  {
   "UpdatedBy": "sub:239325550833674852:wb-kxy520087",
   "Description": "Detach the eip from the special instance.",
   "TemplateFormat": "YAML",
   "UpdatedDate": "2020-05-19T06:05:41Z",
   "TemplateVersion": "v3"
  },
  {
   "UpdatedBy": "sub:239325550833674852:wb-kxy520087",
   "Description": "Detach the eip from the special instance.",
   "TemplateFormat": "YAML",
   "UpdatedDate": "2020-05-19T02:48:16Z",
   "TemplateVersion": "v2"
  },
  {
   "UpdatedBy": "sub:239325550833674852:wb-kxy520087",
   "Description": "Detach the eip from the special instance.",
   "TemplateFormat": "YAML",
   "UpdatedDate": "2020-05-19T02:41:09Z",
   "TemplateVersion": "v1"
  }
 ]
}

错误码
访问错误中心查看更多错误码。
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调用CancelExecution取消执行。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 CancelExecution
系统规定参数。取
值：CancelExecut ion 。

ExecutionId String 是 exec-xxx 执行ID

RegionId String 否 cn-hangzhou 地域ID

返回数据

名称 类型 示例值 描述

RequestId String
14A07460-EBE7-
47CA-9757-
12CC4761D47A

请求ID

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=CancelExecution
&ExecutionId=exec-xxx
&<公共请求参数>

正常返回示例

 XML  格式

<CancelExecutionResponse>
      <RequestId>491DF8C2-34C9-4679-9DB3-4C0F49B129AC</RequestId>
</CancelExecutionResponse>

 JSON  格式

6.执行
6.1. CancelExecution
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{
  "RequestId": "491DF8C2-34C9-4679-9DB3-4C0F49B129AC"
}

错误码
访问错误中心查看更多错误码。

调用DeleteExecutions删除执行。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 DeleteExecutions
系统规定参数。取
值：Delet eExecut ions   。

ExecutionIds String 是 ["exec-xxx"]

执行ID（列表）。

可以由多个ID组成一个JSON数组，格式
为  ["xxxxxxxxx", "yyyyyyyyy", …
"zzzzzzzzz"] ，最多支持100个ID，ID
之间用半角逗号（,）隔开。

RegionId String 否 cn-hangzhou 地域ID

返回数据

名称 类型 示例值 描述

RequestId String
491DF8C2-34C9-
4679-9DB3-
4C0F49B129AC

请求ID

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=DeleteExecutions
&ExecutionIds=["exec-xxx"]
&<公共请求参数>

6.2. DeleteExecutions

API参考·执行 运维编排

56 > 文档版本：20220705

https://error-center.aliyun.com/status/product/oos
https://api.aliyun.com/#product=oos&api=DeleteExecutions&type=RPC&version=2019-06-01


正常返回示例

 XML  格式

<DeleteExecutionsResponse>
      <RequestId>491DF8C2-34C9-4679-9DB3-4C0F49B129AC</RequestId>
</DeleteExecutionsResponse>

 JSON  格式

{
  "RequestId": "491DF8C2-34C9-4679-9DB3-4C0F49B129AC"
}

错误码
访问错误中心查看更多错误码。

调用GenerateExecutionPolicy获取模板执行所需要的Ram Policy。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GenerateExecutio
nPolicy

系统规定参数。取
值：Generat eExecut ionPolicy  。

TemplateName String 是 vmeixme 模板名称

RegionId String 否 cn-hangzhou 地域ID

TemplateVersion String 否 v2 模版版本，默认为最新版。

返回数据

名称 类型 示例值 描述

Policy String {} Ram Policy

6.3. GenerateExecutionPolicy
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RequestId String
14A07460-EBE7-
47CA-9757-
12CC4761D47A

请求ID

名称 类型 示例值 描述

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=GenerateExecutionPolicy
&TemplateName=vmeixme
&<公共请求参数>

正常返回示例

 XML  格式

<GenerateExecutionPolicyResponse>
      <Policy>
            <Statement>
                  <Action>ecs:InvokeCommand</Action>
                  <Action>ecs:DeleteCommand</Action>
                  <Action>ecs:DescribeInvocations</Action>
                  <Action>ecs:DescribeInvocationResults</Action>
                  <Action>ecs:CreateCommand</Action>
                  <Action>ecs:DescribeInstances</Action>
                  <Effect>Allow</Effect>
                  <Resource>*</Resource>
            </Statement>
            <Version>1</Version>
      </Policy>
      <RequestId>C04B668D-D2DD-4B40-B6E9-0E3C4F53D5B5</RequestId>
</GenerateExecutionPolicyResponse>

 JSON  格式
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{
  "Policy": {
    "Statement": [
      {
        "Action": [
          "ecs:InvokeCommand", 
          "ecs:DeleteCommand", 
          "ecs:DescribeInvocations", 
          "ecs:DescribeInvocationResults", 
          "ecs:CreateCommand", 
          "ecs:DescribeInstances"
        ], 
        "Effect": "Allow", 
        "Resource": "*"
      }
    ], 
    "Version": "1"
  }, 
  "RequestId": "C04B668D-D2DD-4B40-B6E9-0E3C4F53D5B5"
}

错误码
访问错误中心查看更多错误码。

调用GetExecutionTemplate获取一个执行所使用的模板，包括内容。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GetExecutionTem
plate

系统规定参数。取
值：Get Execut ionT emplat e    。

ExecutionId String 是
exec-
046490ff88f242

执行ID

RegionId String 否 cn-hangzhou 地域ID

返回数据

6.4. GetExecutionTemplate
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名称 类型 示例值 描述

Content String

"{\n
\"FormatVersion\":
\"OOS-2019-06-
01\",\n
\"Parameters\": {\n
\"Status\": {\n
\"Type\":
\"String\",\n
\"Description\": \"
(Required) The ID of
the ECS
instance.\"\n }\n },\n
\"Tasks\": [\n {\n
\"Name\":
\"bar\",\n
\"Properties\": {\n
\"Parameters\": {\n
\"Status\": \"{{
Status }}\"\n },\n
\"API\":
\"DescribeInstances
\",\n \"Service\":
\"Ecs\"\n },\n
\"Action\":
\"acs::ExecuteAPI\",
\n \"Outputs\": {\n
\"InstanceIds\", {\n
\"ValueSelector\":
\".Instances.Instanc
e[].InstanceId\",\n
\"Type\": \"List\"\n
}\n }\n }\n ],\n
\"Outputs\": {\n
\"InstanceIds\": {\n
\"Value\": \" {{
bar.InstanceIds }}
\",\n \"Type\":
\"List\"\n }\n }\n}\n"

模板内容

RequestId String
14A60-EBE7-47CA-
9757-12C1D47A

请求ID

Template Struct 模板元信息

CreatedBy String root(13090000) 模板创建者

CreatedDate String
2019-05-
16T10:26:14Z

模板创建时间

Description String
Descirbe instances
of given status

模板说明

API参考·执行 运维编排

60 > 文档版本：20220705



Hash String

4bc7d7a21b3e0034
34b9c223f6e6d2578
b5ebfeb5be28c1fcf
8a8a1b11907bb4

模板内容的SHA256

ShareType String Private
模板共享类型。目前用户创建的模板的共享类型
均为 Privat e 。

Tags Map {"k1":"k2","k2":"v2"} 标签键及值，键值对数量限制为1至20。

TemplateForm
at

String JSON 模板格式。系统字段判断，为JSON或YAML。

TemplateId String t-94753d4d828d38 模板ID

TemplateName String MyTemplate 模板名称

TemplateVersi
on

String v1
模板版本。以“v”+数字的形式，数字从1开
始。

UpdatedBy String root(13090000) 模板更新者

UpdatedDate String
2019-05-
16T10:26:14Z

模板更新时间

名称 类型 示例值 描述

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=GetExecutionTemplate
&ExecutionId=exec-046490ff88f242
&<公共请求参数>

正常返回示例

 XML  格式
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<GetExecutionTemplateResponse>
      <Content>
            <FormatVersion>OOS-2019-06-01</FormatVersion>
            <Parameters>
                  <Status>
                        <Type>String</Type>
                        <Description>(Required) The ID of the ECS instance.</Description>
                  </Status>
            </Parameters>
            <Tasks>
                  <Name>bar</Name>
                  <Properties>
                        <Parameters>
                              <Status>{{ Status }}</Status>
                        </Parameters>
                        <API>DescribeInstances</API>
                        <Service>Ecs</Service>
                  </Properties>
                  <Action>acs::ExecuteAPI</Action>
                  <Outputs>
                        <InstanceIds>
                              <ValueSelector>.Instances.Instance[].InstanceId</ValueSelecto
r>
                              <Type>List&amp;lt;String&amp;gt;</Type>
                        </InstanceIds>
                  </Outputs>
            </Tasks>
            <Outputs>
                  <InstanceIds>
                        <Value> {{ bar.InstanceIds }} </Value>
                        <Type>List&amp;lt;String&amp;gt;</Type>
                  </InstanceIds>
            </Outputs>
      </Content>
      <RequestId>FAAFA45-AB65-4049-BFE0-868E1C80AF</RequestId>
      <Template>
            <CreatedBy>root(13092000)</CreatedBy>
            <CreatedDate>2019-05-27T10:32:52Z</CreatedDate>
            <UpdatedBy>root(13092000)</UpdatedBy>
            <UpdatedDate>2019-05-27T08:46:33Z</UpdatedDate>
            <Description></Description>
            <Hash>62eac5c64b9dae5c41e1e8b648baad95f812cab4f9221a5283edb882b5f8d712</Hash>
            <ShareType>Private</ShareType>
            <TemplateFormat>JSON</TemplateFormat>
            <TemplateName>MyTemplate</TemplateName>
            <TemplateId>t-94753deea28d38</TemplateId>
            <TemplateVersion>v1</TemplateVersion>
      </Template>
</GetExecutionTemplateResponse>

 JSON  格式

API参考·执行 运维编排

62 > 文档版本：20220705



{
  "Content": {
    "FormatVersion": "OOS-2019-06-01",
    "Parameters": {
        "Status": {
        "Type": "String",
        "Description": "(Required) The ID of the ECS instance."
        }
    },
    "Tasks": [
        {
        "Name": "bar",
        "Properties": {
            "Parameters": {
            "Status": "{{ Status }}"
            },
            "API": "DescribeInstances",
            "Service": "Ecs"
        },
        "Action": "acs::ExecuteAPI",
        "Outputs": {
            "InstanceIds": {
            "ValueSelector": ".Instances.Instance[].InstanceId",
            "Type": "List&lt;String&gt;"
            }
        }
        }
    ],
    "Outputs": {
        "InstanceIds": {
        "Value": " {{ bar.InstanceIds }} ",
        "Type": "List&lt;String&gt;"
        }
    }
    },
  "RequestId": "FAAFA45-AB65-4049-BFE0-868E1C80AF",
  "Template": {
    "CreatedBy": "root(13092000)",
    "CreatedDate": "2019-05-27T10:32:52Z",
    "UpdatedBy": "root(13092000)",
    "UpdatedDate": "2019-05-27T08:46:33Z",
    "Description": "",
    "Hash": "62eac5c64b9dae5c41e1e8b648baad95f812cab4f9221a5283edb882b5f8d712",
    "ShareType": "Private",
    "TemplateFormat": "JSON",
    "TemplateName": "MyTemplate",
    "TemplateId": "t-94753deea28d38",
    "TemplateVersion": "v1"
  }
}

错误码
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访问错误中心查看更多错误码。

调用NotifyExecution通知一个状态为等待中的执行接下来如何运行。

有以下情况可以被通知：

特殊任务执行等待审批时，即模版中有Approve任务，模版执行到Approve对应的任务时，执行切换为等
待中状态，可通过该Api确认是否继续执行。

Debug模式下调试时，执行创建后或完成一个任务执行后，用该API指定接下来进行的任务执行。

高风险操作类任务执行等待审批时，可通过该Api确认是否继续执行。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 NotifyExecution
系统规定参数。取
值：Not if yExecut ion   。

ExecutionId String 是 exec-xxx 执行ID

NotifyType String 是 Approve

通知类型。取值范围：

Approve

同意，适用于批准待审批的执行。如已
知晓高危操作的任务执行风险，并准许
其执行。

Reject

拒绝，适用于驳回待审批的执行。如
不准许高危操作的任务执行。

Execut eT ask 

指定某个任务执行的开始，适用于
Debug模式。可能需配合
Parameters参数。

CancelT ask

取消当前的任务执行，适用于Debug
模式。

Complet eExecut ion 

手动终止一个Debug模式下的执行。
可配合Execut ionSt at us    参数指定
被终止执行的状态。

6.5. NotifyExecution
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RegionId String 否 cn-hangzhou 地域ID

NotifyNote String 否 说明 用于说明的message

TaskName String 否 describeInstance 下一步要执行的Task Name

TaskExecutionId String 否 task-exec-xxx 任务执行ID

ExecutionStatus String 否 Success 适用于CompleteExecution

Parameters String 否 {} 适用于ExecuteTask

LoopItem String 否 i-xxx Loop子节点对应Item数据

TaskExecutionIds String 否

["exec-
79c321c11003a97
c","exec-
79c321c11003aq
w97cz"]

任务执行的ID列表。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
491DF8C2-34C9-
4679-9DB3-
4C0F49B129AC

请求ID

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=NotifyExecution
&ExecutionId=exec-xxx
&NotifyType=Approve
&<公共请求参数>

正常返回示例

 XML  格式

<NotifyExecutionResponse>
      <RequestId>491DF8C2-34C9-4679-9DB3-4C0F49B129AC</RequestId>
</NotifyExecutionResponse>
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 JSON  格式

{
  "RequestId": "491DF8C2-34C9-4679-9DB3-4C0F49B129AC"
}

错误码
访问错误中心查看更多错误码。

调用ListExecutions查询执行，支持多种过滤方式。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 ListExecutions 系统规定参数。取值：List Execut ions   。

RegionId String 否 cn-hangzhou 地域ID

TemplateName String 否 MyTemplate
模板名称。名称未包含关系，最终列出包
含所填模板名称的所有模板。

Status String 否 Running
执行状态，取值范围：Running, Started,
Success, Failed, Waiting, Cancelled,
Pending, Skipped。

ExecutionId String 否 exec-xxx 执行ID

StartDateBefore String 否
2019-05-
16T10:26:14Z

开始时间小于等于指定时间的执行

StartDateAfter String 否
2019-05-
16T10:26:14Z

开始时间大于等于指定时间的执行

EndDateBefore String 否
2019-05-
16T10:26:14Z

结束时间小于等于指定时间的执行

EndDateAfter String 否
2019-05-
16T10:26:14Z

结束时间大于等于指定时间的执行

6.6. ListExecutions
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Mode String 否 Automatic

执行模式。取值范围：

Aut omat ic 

Debug

ExecutedBy String 否 vme 执行者

ParentExecutionId String 否 exec-xxx 父执行ID

RamRole String 否 OOSServiceRole RAM角色

IncludeChildExecu
tion

Boolean 否 true 是否包含子执行。默认为False。

Category String 否 Other
执行的模版类型。可分为Other、
TimerTrigger、EventTrigger、
AlarmTrigger。

Tags Map 否
{"k1":"v2","k2":"v
2"}

执行的标签

MaxResults Integer 否 50
分页大小。取值范围：10-100。默认为
50。

NextToken String 否
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ

翻页标记的Token

SortField String 否 StartDate

排序字段。取值范围：

St art Dat e   （默认值）：创建时间

EndDat e ：结束时间

St at us   ：状态

SortOrder String 否 Ascending
排序方向。取值范围：

Ascending：升序

Descending（默认值）：降序

ResourceId String 否 i-xxx ECS资源ID

ResourceTemplat
eName

String 否 ACS-ECS-TEST 资源的模板名称

名称 类型 是否必选 示例值 描述
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ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

NextToken String
MTRBMDc0NjAtRUJFN
y00N0NBLTk3NTctM
TJDQzQ

翻页标记的Token

RequestId String
14A074-47CA-9757-
12CC4761D47A

请求ID

MaxResults Integer 50 分页大小

Executions
Array of
Execution

执行数据

Status String Success

执行状态。取值范围为Started, Queued,
Running, Waiting, Success, Failed,
Cancelled。

WaitingStatus String "" 等待状态

Targets String "" 目标资源

StatusReason String "" 状态原因

Tags Map 执行的标签

LastSuccessful
TriggerT ime

String
2019-05-
27T09:29:18Z 最近一次成功触发模板的时间

Mode String Automatic 执行模式

SafetyCheck String Skip
安全检查模式。取值范围为Skip,
ConfirmEveryHighRiskAction。

TemplateName String MyTemplate 模板名称
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TemplateVersi
on

String v1 模板版本号

CreateDate String
2019-05-
16T10:26:14Z

执行创建时间

UpdateDate String
2019-05-
16T10:26:14Z

执行更新时间

Description String test execution. 执行描述

LastTriggerT im
e

String
2019-05-
27T09:29:18Z

最近一次触发模板的时间

ParentExecutio
nId

String exec-xxx 父执行ID

LastTriggerStat
us

String Success 最近一次触发模版后的执行状态

StatusMessage String “” 任务执行状态

Outputs String
{ "InstanceId":"i-xxx"
}

执行输出结果

ExecutedBy String 1309252800 执行模板者

EndDate String
2019-05-
16T10:26:14Z

执行结束时间

IsParent Boolean false 标记是否包含子任务

StartDate String
2019-05-
16T10:26:14Z

执行开始时间

ExecutionId String
exec-
44d32b45d2a449e

执行的唯一标识

Parameters Map 执行的输入参数

Counters Map 任务按执行状态计数

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

名称 类型 示例值 描述
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Category String Other
执行的模版类型。可分为Other、
TimerTrigger、EventTrigger、AlarmTrigger。

TemplateId String 123 模板ID

RamRole String OOSServiceRole 执行当前模板的角色

ResourceStatus String { "Success": 1 } 资源状态

CurrentTasks
Array of
CurrentTask

当前正在运行的Tasks

TaskExecutionI
d

String
task-exec-
44d32b45d2a49899
#1

Task执行ID

TaskName String installSLSILogtail Task名称

TaskAction String acs::Template Task执行模板

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=ListExecutions
&RegionId=cn-hangzhou
&TemplateName=MyTemplate
&Status=Running
&ExecutionId=exec-xxx
&StartDateBefore=2019-05-16T10:26:14Z
&StartDateAfter=2019-05-16T10:26:14Z
&EndDateBefore=2019-05-16T10:26:14Z
&EndDateAfter=2019-05-16T10:26:14Z
&Mode=Automatic
&ExecutedBy=vme
&ParentExecutionId=exec-xxx
&RamRole=OOSServiceRole
&IncludeChildExecution=true
&Category=Other
&MaxResults=50
&NextToken=MTRBMDc0NjAtRUJFNy00N0NBLTk3NTctMTJDQzQ
&SortField=StartDate
&SortOrder=Ascending
&ResourceId=i-xxx
&ResourceTemplateName=ACS-ECS-TEST
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<ListExecutionsResponse>
    <NextToken>MTRBMDc0NjAtRUJFNy00N0NBLTk3NTctMTJDQzQ</NextToken>
    <RequestId>14A074-47CA-9757-12CC4761D47A</RequestId>
    <MaxResults>50</MaxResults>
    <Executions>
        <Status>Success</Status>
        <WaitingStatus>""</WaitingStatus>
        <Targets>""</Targets>
        <StatusReason> ""</StatusReason>
        <LastSuccessfulTriggerTime>2019-05-27T09:29:18Z</LastSuccessfulTriggerTime>
        <Mode>Automatic</Mode>
        <SafetyCheck>Skip</SafetyCheck>
        <TemplateName>MyTemplate</TemplateName>
        <TemplateVersion>v1</TemplateVersion>
        <CreateDate>2019-05-16T10:26:14Z</CreateDate>
        <UpdateDate>2019-05-16T10:26:14Z</UpdateDate>
        <Description>test execution.</Description>
        <LastTriggerTime>2019-05-27T09:29:18Z</LastTriggerTime>
        <ParentExecutionId>exec-xxx</ParentExecutionId>
        <LastTriggerStatus>Success</LastTriggerStatus>
        <StatusMessage>“”</StatusMessage>
        <Outputs>{ "InstanceId":"i-xxx" }</Outputs>
        <ExecutedBy>1309252800</ExecutedBy>
        <EndDate>2019-05-16T10:26:14Z</EndDate>
        <IsParent>false</IsParent>
        <StartDate>2019-05-16T10:26:14Z</StartDate>
        <ExecutionId>exec-44d32b45d2a449e</ExecutionId>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <Category>Other</Category>
        <TemplateId>123</TemplateId>
        <RamRole>OOSServiceRole</RamRole>
        <ResourceStatus>{    "Success": 1   }</ResourceStatus>
        <CurrentTasks>
            <TaskExecutionId>task-exec-44d32b45d2a49899#1</TaskExecutionId>
            <TaskName>installSLSILogtail</TaskName>
            <TaskAction>acs::Template</TaskAction>
        </CurrentTasks>
    </Executions>
</ListExecutionsResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "NextToken" : "MTRBMDc0NjAtRUJFNy00N0NBLTk3NTctMTJDQzQ",
  "RequestId" : "14A074-47CA-9757-12CC4761D47A",
  "MaxResults" : 50,
  "Executions" : [ {
    "Status" : "Success",
    "WaitingStatus" : "\"\"",
    "Targets" : "\"\"",
    "StatusReason" : " \"\"",
    "LastSuccessfulTriggerTime" : "2019-05-27T09:29:18Z",
    "Mode" : "Automatic",
    "SafetyCheck" : "Skip",
    "TemplateName" : "MyTemplate",
    "TemplateVersion" : "v1",
    "CreateDate" : "2019-05-16T10:26:14Z",
    "UpdateDate" : "2019-05-16T10:26:14Z",
    "Description" : "test execution.",
    "LastTriggerTime" : "2019-05-27T09:29:18Z",
    "ParentExecutionId" : "exec-xxx",
    "LastTriggerStatus" : "Success",
    "StatusMessage" : "“”",
    "Outputs" : "{ \"InstanceId\":\"i-xxx\" }",
    "ExecutedBy" : "1309252800",
    "EndDate" : "2019-05-16T10:26:14Z",
    "IsParent" : false,
    "StartDate" : "2019-05-16T10:26:14Z",
    "ExecutionId" : "exec-44d32b45d2a449e",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "Category" : "Other",
    "TemplateId" : "123",
    "RamRole" : "OOSServiceRole",
    "ResourceStatus" : "{ \t\t\t\"Success\": 1 \t\t}",
    "CurrentTasks" : [ {
      "TaskExecutionId" : "task-exec-44d32b45d2a49899#1",
      "TaskName" : "installSLSILogtail",
      "TaskAction" : "acs::Template"
    } ]
  } ]
}

错误码
访问错误中心查看更多错误码。

调用ListExecutionLogs获取执行的详细日志。

调试

6.7. ListExecutionLogs
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您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 ListExecutionLogs
系统规定参数。取
值：List Execut ionLogs   。

ExecutionId String 是 exec-xxx 执行ID

RegionId String 否 cn-hangzhou 地域ID

TaskExecutionId String 否
exec-
1234567zxcvb.t0
010

任务执行ID

LogType String 否 System 日志类型

MaxResults Integer 否 50 分页大小

NextToken String 否

MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ3Nj
FENDdB

翻页标记的Token

返回数据

名称 类型 示例值 描述

ExecutionLogs Array 执行日志

LogType String System 日志类型

Message String
The task
CheckDiskCategory
completed.

详细信息

TaskExecutionI
d

String
exec-
1234567zxcvb.t0010

任务执行ID

Timestamp String
2019-05-
24T:02:29:07Z

时间戳

API参考·执行 运维编排
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IsTruncated Boolean true 局部展示

MaxResults Integer 50 分页大小

NextToken String

gAAAAABdpsGWjX8
dJ-
a6dl_pvoS7AFxNHSN
JKHLCAJ：
J0ylgA53nWW5V4HT
EZKCYTaEPNOrxFir4z
43UTOjE150cFr8AGTi
fA==

翻页标记的Token

RequestId String
14A07460-EBE7-
47CA-9757-
12CC4761D47A

请求ID

名称 类型 示例值 描述

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=ListExecutionLogs
&ExecutionId=exec-xxx
&<公共请求参数>

正常返回示例

 XML  格式
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<code>200</code>
<data>
    <NextToken>gAAAAABdpsY7X-3ZUoNUxqiny_gx3zXfJ3HHHSKJDq3UAp6dQ-p7qJ2ZLtivu2LhpMiPe0P9eVP_
76cO0cUgF5jFFj5Ut6g==</NextToken>
    <RequestId>0ABABABA-68A0-4DF2-8DCB-1DB8FE3A1CF1</RequestId>
    <ExecutionLogs>
        <Message>The task waitDataRecover waiting. Sleep estimated finish time (2019-10-16 
07:27:35.615945)</Message>
        <LogType>System</LogType>
        <Timestamp>2019-10-16T07:26:35Z</Timestamp>
        <TaskExecutionId>exec-00eb84dd8143440da047.t0001</TaskExecutionId>
    </ExecutionLogs>
    <ExecutionLogs>
        <Message>The task waitDataRecover started.</Message>
        <LogType>System</LogType>
        <Timestamp>2019-10-16T07:26:35Z</Timestamp>
        <TaskExecutionId>exec-00eb84dd8143440da047.t0001</TaskExecutionId>
    </ExecutionLogs>
    <MaxResults>20</MaxResults>
    <IsTruncated>true</IsTruncated>
</data>
<requestId>04ABABAAB5-68A0-4DF2-8DCB-1DB8FE3A1CF1</requestId>
<successResponse>true</successResponse>

 JSON  格式
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{
    "code": 200,
    "data": {
        "NextToken": "gAAAAABdpsY7X-3ZUoNUxqiny_gx3zXfJ3HHHSKJDq3UAp6dQ-p7qJ2ZLtivu2LhpMiPe
0P9eVP_76cO0cUgF5jFFj5Ut6g==",
        "RequestId": "0ABABABA-68A0-4DF2-8DCB-1DB8FE3A1CF1",
        "ExecutionLogs": [
            {
                "Message": "The task waitDataRecover waiting. Sleep estimated finish time (
2019-10-16 07:27:35.615945)",
                "LogType": "System",
                "Timestamp": "2019-10-16T07:26:35Z",
                "TaskExecutionId": "exec-00eb84dd8143440da047.t0001"
            },
            {
                "Message": "The task waitDataRecover started.",
                "LogType": "System",
                "Timestamp": "2019-10-16T07:26:35Z",
                "TaskExecutionId": "exec-00eb84dd8143440da047.t0001"
            }
        ],
        "MaxResults": 20,
        "IsTruncated": true
    },
    "requestId": "04ABABAAB5-68A0-4DF2-8DCB-1DB8FE3A1CF1",
    "successResponse": true
}

错误码
访问错误中心查看更多错误码。

调用StartExecution启动一个执行。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 StartExecution
系统规定参数。取
值：St art Execut ion   。

RegionId String 否 cn-hangzhou 地域ID

6.8. StartExecution
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TemplateName String 是 vmeixme
模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符。

TemplateVersion String 否 v1 版本号，如不填默认为最新的版本号。

Mode String 否 Automatic

执行模式。取值：

Automatic（默认值）：自动执行

FailurePause：失败暂停

Debug：单步执行

LoopMode String 否 Automatic

循环模式。取值：

Automatic（默认值）：不暂停

FirstBatchPause：第一批暂停

EveryBatchPause：每批暂停

ParentExecutionId String 否 exec-xxx 父执行ID

SafetyCheck String 否 Skip

安全检查模式。取值：

Skip：此选项表示客户了解风险，无需
确认即可执行任何Action，无论什么风
险等级。  Mode=Automatic 时有
效。

ConfirmEveryHighRiskAction（默认
值）：此选项会要求客户确认每一个高
风险的Action。客户通过调
用Not if yExecut ion   接口进行确认或取
消。

Parameters String 否
{"Status":"Runnin
g"}

由参数集合组成的Json字符串，默认为{}。

ClientToken String 否
123e56767-e89b-
12d3-a456-
426655440000

访问令牌

Tags Map 否
{"k1":"v2","k2":"v
2"}

要给执行打的标签

Description String 否 test execution. 要给执行添加的描述信息

名称 类型 是否必选 示例值 描述

API参考·执行 运维编排
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TemplateContent String 否

{ "Description":
"Example
template,
describe
instances in some
status",
"FormatVersion":
"OOS-2019-06-
01",
"Parameters": {},
"Tasks": [ {
"Name":
"describeInstance
s", "Action":
"ACS::ExecuteAPI
", "Description":
"desc-en",
"Properties": {
"Service": "ECS",
"API":
"DescribeInstance
s", "Parameters":
{ "Status":
"Running" } } } ] }

模板内容，JSON或YAML格式（同
CreateTemplate API 请求参数中的
Content字段）。用户传入此字段可直接执
行TemplateContent中的任务，而无需提
前创建模板再创建执行任务（当用户选择
已有的Template创建执行任务时不需传入
此字段）。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
14A07460-EBE7-
47CA-9757-
12CC4761D47A

请求ID

Execution Object 执行数据

Outputs String
{ "InstanceId":"i-xxx"
}

执行输出结果

Status String Success 执行状态

EndDate String
2019-05-
16T10:26:14Z

结束时间

ExecutedBy String
root(13092080xx123
44)

执行模板者

运维编排 API参考·执行
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IsParent Boolean false 是否包含子任务

Tags Map 执行的标签

StartDate String
2019-05-
16T10:26:14Z

开始时间

SafetyCheck String Skip 安全检查模式

Mode String Automatic 执行模式

TemplateName String MyTemplate 模板名称

CreateDate String
2019-05-
16T10:26:14Z

执行创建时间

TemplateVersi
on

String v1 模板版本号

ExecutionId String exec-xxxyyy 执行的唯一标识

Parameters String
{ "Status":"Running"
}

执行的输入参数

Description String test execution. 执行的描述信息

Counters Map 执行数

UpdateDate String
2019-05-
16T10:26:14Z

更新时间

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

ParentExecutio
nId

String exec-xxxx 父执行ID

RamRole String OOSServiceRole 执行当前模板的角色

TemplateId String t-1bd341007f 模板ID

名称 类型 示例值 描述

API参考·执行 运维编排
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StatusMessage String "" 状态信息

LoopMode String Automatic 循环模式

CurrentTasks
Array of
CurrentTask

当前正在运行的Tasks

TaskExecutionI
d

String exec-dsadasdawq 任务执行ID

TaskName String testTask 任务名称

TaskAction String ACS::T imerTrigger 任务的动作

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=StartExecution
&RegionId=cn-hangzhou
&TemplateName=vmeixme
&TemplateVersion=v1
&Mode=Automatic
&LoopMode=Automatic
&ParentExecutionId=exec-xxx
&SafetyCheck=Skip
&Parameters={"Status":"Running"}
&ClientToken=123e56767-e89b-12d3-a456-426655440000
&Description=test execution.
&TemplateContent={   "Description": "Example template, describe instances in some status", 
"FormatVersion": "OOS-2019-06-01",   "Parameters": {},   "Tasks": [     {       "Name": "de
scribeInstances",       "Action": "ACS::ExecuteAPI",       "Description": "desc-en",       
"Properties": {         "Service": "ECS",         "API": "DescribeInstances",         "Para
meters": {           "Status": "Running"         }       }     }   ] }
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<StartExecutionResponse>
    <RequestId>14A07460-EBE7-47CA-9757-12CC4761D47A</RequestId>
    <Execution>
        <Outputs>{ "InstanceId":"i-xxx" }</Outputs>
        <Status>Success</Status>
        <EndDate>2019-05-16T10:26:14Z</EndDate>
        <ExecutedBy>root(13092080xx12344)</ExecutedBy>
        <IsParent>false</IsParent>
        <StartDate>2019-05-16T10:26:14Z</StartDate>
        <SafetyCheck>Skip</SafetyCheck>
        <Mode>Automatic</Mode>
        <TemplateName>MyTemplate</TemplateName>
        <CreateDate>2019-05-16T10:26:14Z</CreateDate>
        <TemplateVersion>v1</TemplateVersion>
        <ExecutionId>exec-xxxyyy</ExecutionId>
        <Parameters>{ "Status":"Running" }</Parameters>
        <Description>test execution.</Description>
        <UpdateDate>2019-05-16T10:26:14Z</UpdateDate>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <ParentExecutionId>exec-xxxx</ParentExecutionId>
        <RamRole>OOSServiceRole</RamRole>
        <TemplateId>t-1bd341007f</TemplateId>
        <StatusMessage>""</StatusMessage>
        <LoopMode>Automatic</LoopMode>
        <CurrentTasks>
            <TaskExecutionId>exec-dsadasdawq</TaskExecutionId>
            <TaskName>testTask</TaskName>
            <TaskAction>ACS::TimerTrigger</TaskAction>
        </CurrentTasks>
    </Execution>
</StartExecutionResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "14A07460-EBE7-47CA-9757-12CC4761D47A",
  "Execution" : {
    "Outputs" : "{ \"InstanceId\":\"i-xxx\" }",
    "Status" : "Success",
    "EndDate" : "2019-05-16T10:26:14Z",
    "ExecutedBy" : "root(13092080xx12344)",
    "IsParent" : false,
    "StartDate" : "2019-05-16T10:26:14Z",
    "SafetyCheck" : "Skip",
    "Mode" : "Automatic",
    "TemplateName" : "MyTemplate",
    "CreateDate" : "2019-05-16T10:26:14Z",
    "TemplateVersion" : "v1",
    "ExecutionId" : "exec-xxxyyy",
    "Parameters" : "{ \"Status\":\"Running\" }",
    "Description" : "test execution.",
    "UpdateDate" : "2019-05-16T10:26:14Z",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "ParentExecutionId" : "exec-xxxx",
    "RamRole" : "OOSServiceRole",
    "TemplateId" : "t-1bd341007f",
    "StatusMessage" : "\"\"",
    "LoopMode" : "Automatic",
    "CurrentTasks" : [ {
      "TaskExecutionId" : "exec-dsadasdawq",
      "TaskName" : "testTask",
      "TaskAction" : "ACS::TimerTrigger"
    } ]
  }
}

错误码
访问错误中心查看更多错误码。

调用ListTaskExecutions查询任务执行，支持多种过滤方式。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

6.9. ListTaskExecutions
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Action String 是
ListTaskExecution
s

系统规定参数。取
值：List T askExecut ions    。

RegionId String 否 cn-hangzhou 地域ID

ExecutionId String 否 exec-xxx 执行ID

Status String 否 Running

执行状态，取值范围：Running, Started,
Success, Failed, Waiting, Cancelled,
Pending, Skipped。

StartDateBefore String 否
2019-05-
16T10:26:14Z

开始时间小于等于指定时间的执行

StartDateAfter String 否
2019-05-
16T10:26:14Z

开始时间大于等于指定时间的执行

EndDateBefore String 否
2019-05-
16T10:26:14Z

结束时间小于等于指定时间的执行

EndDateAfter String 否
2019-05-
16T10:26:14Z

结束时间大于等于指定时间的执行

TaskExecutionId String 否 task-exec-xxx 任务执行ID

TaskName String 否 describeInstance 任务名称

TaskAction String 否 ACS::Sleep 任务动作

ParentTaskExecut
ionId

String 否 task-exec-xxx
父任务执行ID。Loop情况会用到，一般是
Loop的Parent的TaskExecutionId。

IncludeChildTaskE
xecution

Boolean 否 false
标记是否展示Loop产生的子Task。默认为
False。

MaxResults Integer 否 50
分页大小。取值范围：20-100。默认为
50。

NextToken String 否

MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ3Nj
FENDdB

翻页标记的Token

名称 类型 是否必选 示例值 描述
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SortField String 否 StartDate

排序字段。取值范围：

St art Dat e   （默认值）：创建时间

EndDat e ：结束时间

St at us   ：状态

SortOrder String 否 Ascending

排序方向。取值范围：

Ascending：升序

Descending（默认值）：降序

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

MaxResults Integer 50 分页大小

NextToken String
MTRBMDc0NjAtRUJFN
y00N0NBLTk3NTctM
TJDQzQ3NjFENDdB

翻页标记的Token

RequestId String
CDABABABAB-FC28-
4D9C-8FB5-
68DC6F0486FC

请求ID

TaskExecutions
Array of
TaskExecution

执行数据

ChildExecutionI
d

String exec-xxx 子任务执行ID

CreateDate String
2019-05-
16T10:26:14Z

执行创建时间

EndDate String
2019-05-
16T10:26:14Z

结束时间

ExecutionId String
exec-
44d32b45d2a449e4
9899

执行ID

ExtraData Map { "NotifyNote":"" } 附加数据

Loop Map {}
Loop配置和统计信息，仅Loop父节点有此信
息。
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LoopBatchNum
ber

Integer 2 循环批次数

LoopItem String i-1234566zxcvvb 循环中的元素

Outputs String
{ "InstanceId":"i-xxx"
}

执行输出结果

ParentTaskExec
utionId

String task-exec-xxx 父任务执行ID

Properties String
{ "Status":"Running"
}

执行的输入参数

StartDate String
2019-05-
16T10:26:14Z

开始时间

Status String Running 任务状态

StatusMessage String "" 状态信息

TaskAction String ACS::Sleep 任务动作

TaskExecutionI
d

String task-exec-xxx 任务执行ID

TaskName String describeInstance 任务名称

TemplateId String xxx 模板ID

UpdateDate String
2019-05-
16T10:26:14Z

更新时间

名称 类型 示例值 描述

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=ListTaskExecutions
&<公共请求参数>

正常返回示例

 XML  格式
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<code>200</code>
<data>
    <RequestId>CDABABABAB-FC28-4D9C-8FB5-68DC6F0486FC</RequestId>
    <MaxResults>100</MaxResults>
    <TaskExecutions>
        <Status>Success</Status>
        <Loop/>
        <TaskAction>ACS::Sleep</TaskAction>
        <ExtraData>
            <NotifyNote/>
        </ExtraData>
        <Properties>
            <Duration>PT1M</Duration>
        </Properties>
        <CreateDate>2019-10-16T07:45:09Z</CreateDate>
        <EndDate>2019-10-16T07:46:10Z</EndDate>
        <StatusMessage>Sleep estimated finish time (2019-10-16 07:46:09.502154)</StatusMess
age>
        <StartDate>2019-10-16T07:45:09Z</StartDate>
        <UpdateDate>2019-10-16T07:46:10Z</UpdateDate>
        <LoopItem/>
        <TaskName>waitDataRecover</TaskName>
        <Outputs/>
        <TaskExecutionId>exec-934bc37ea31f4b9e9312.t0001</TaskExecutionId>
        <ExecutionId>exec-934bc37ea31f4b9e9312</ExecutionId>
    </TaskExecutions>
</data>
<requestId>CDABABABAB-FC28-4D9C-8FB5-68DC6F0486FC</requestId>
<successResponse>true</successResponse>

 JSON  格式
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{
    "code": 200,
    "data": {
        "RequestId": "CDABABABAB-FC28-4D9C-8FB5-68DC6F0486FC",
        "MaxResults": 100,
        "TaskExecutions": {
            "Status": "Success",
            "Loop": "",
            "TaskAction": "ACS::Sleep",
            "ExtraData": {
                "NotifyNote": ""
            },
            "Properties": {
                "Duration": "PT1M"
            },
            "CreateDate": "2019-10-16T07:45:09Z",
            "EndDate": "2019-10-16T07:46:10Z",
            "StatusMessage": "Sleep estimated finish time (2019-10-16 07:46:09.502154)",
            "StartDate": "2019-10-16T07:45:09Z",
            "UpdateDate": "2019-10-16T07:46:10Z",
            "LoopItem": "",
            "TaskName": "waitDataRecover",
            "Outputs": "",
            "TaskExecutionId": "exec-934bc37ea31f4b9e9312.t0001",
            "ExecutionId": "exec-934bc37ea31f4b9e9312"
        }
    },
    "requestId": "CDABABABAB-FC28-4D9C-8FB5-68DC6F0486FC",
    "successResponse": true
}

错误码
访问错误中心查看更多错误码。

一个已启动的执行，包含事件触发器、告警触发器或时间触发器任务，该API可对该类执行发送一条消息体
内容，消息体会使事件或告警任务产生一个新的子执行。可用于创建该类触发器执行后，进行调试。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

6.10. TriggerExecution
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Action String 是 TriggerExecution
系统规定参数。取
值：T riggerExecut ion  。

RegionId String 是 cn-hangzhou 地域ID

ExecutionId String 是
exec-
sadw3f23rsad

目标EventTrigger、AlarmTrigger或
TimerTrigger执行ID。

Type String 是 Event

触发器类型：

Event

Alarm

Timer

Content String 是

{"eventT ime":
"20181226T2201
14.058+0800",
"id": "9435EAD6-
3CF6-4494-8F7A-
3A********77","lev
el":
"INFO","name":
"Instance:StateC
hange","product"
:
"ECS","regionId":"
cn-
hangzhou","reso
urceId":
"acs:ecs:cn-
hangzhou:16907
0********30:instan
ce/i-
bp1ecr********5g
o2go","userId":
"169070********30
","ver":
"1.0","content":
{"resourceId": "i-
bp1ecr********5g
o2go",
"resourceType":
"ALIYUN::ECS::Ins
tance","state":
"Stopping"} }

发送给触发器任务的消息体。

ClientToken String 否 dswe2-3i0-029 保证幂等性的一个Token。

名称 类型 是否必选 示例值 描述
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返回数据

名称 类型 示例值 描述

RequestId String
14A07460-EBE7-
47CA-9757-
12CC4761D47A

请求ID

示例
请求示例

http(s)://[Endpoint]/?Action=TriggerExecution
&RegionId=cn-hangzhou
&ExecutionId=exec-sadw3f23rsad
&Type=Event
&Content={"eventTime": "20181226T220114.058+0800", "id": "9435EAD6-3CF6-4494-8F7A-3A*******
*77","level": "INFO","name": "Instance:StateChange","product": "ECS","regionId":"cn-hangzho
u","resourceId": "acs:ecs:cn-hangzhou:169070********30:instance/i-bp1ecr********5go2go","us
erId": "169070********30","ver": "1.0","content": {"resourceId": "i-bp1ecr********5go2go", 
"resourceType": "ALIYUN::ECS::Instance","state": "Stopping"} }
&ClientToken=dswe2-3i0-029
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<TriggerExecutionResponse>
    <RequestId>14A07460-EBE7-47CA-9757-12CC4761D47A</RequestId>
</TriggerExecutionResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "14A07460-EBE7-47CA-9757-12CC4761D47A"
}

错误码
访问错误中心查看更多错误码。

调用UpdateExecution更新未结束的执行。

调试

6.11. UpdateExecution
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您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 UpdateExecution
系统规定参数。取值：
UpdateExecution。

ExecutionId String 是
exec-
c223xxxxxxxxxxxx
xxxx

执行ID。

Parameters String 是
{"Status":"Runnin
g"}

由参数集合组成的Json字符串。

RegionId String 是 cn-hangzhou 地域ID。

ClientToken String 否
123e4567-e89b-
12d3-a456-
42665544****

保证请求的幂等性。该值由客户端生成，
并且必须是全局唯一的。 长度不超过64个
字符，可包含英文字母、数字、短划线
（-）和下划线（_）。

返回数据

名称 类型 示例值 描述

RequestId String
C8345E88-5334-
469E-901D-
F912C8CB9C55

请求ID

示例
请求示例

http(s)://[Endpoint]/?Action=UpdateExecution
&ExecutionId=exec-c223xxxxxxxxxxxxxxxx
&Parameters={"Status":"Running"}
&RegionId=cn-hangzhou
&<公共请求参数>

正常返回示例

 XML 格式

<RequestId>C8345E88-5334-469E-901D-F912C8CB9C55</RequestId>

 JSON 格式
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{
 "RequestId": "C8345E88-5334-469E-901D-F912C8CB9C55"
}

错误码
访问错误中心查看更多错误码。

调用ListResourceExecutionStatus查看包含ECS实例的定时运维执行信息。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListResourceExec
utionStatus

系统规定参数。取值：
ListResourceExecutionStatus。

ExecutionId String 是
exec-
xxxxxxxxxxxx

执行ID。

RegionId String 是 cn-hangzhou 地域ID。

MaxResults Integer 否 50
分页大小。取值范围：10-100。默认为
50。

NextToken String 否
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ

翻页标记的Token。

返回数据

名称 类型 示例值 描述

MaxResults Integer 50 分页大小

NextToken String
MTRBMDc0NjAtRUJFN
y00N0NBLTk3NTctM
TJDQzQ

翻页标记的Token

RequestId String
ED571CBD-9F96-
419D-B919-
CF340BBCA157

请求ID

6.12. ListResourceExecutionStatus

API参考·执行 运维编排

92 > 文档版本：20220705

https://error-center.aliyun.com/status/product/oos
https://api.aliyun.com/#product=oos&api=ListResourceExecutionStatus&type=RPC&version=2019-06-01


ResourceExecut
ionStatus

Array of Status 资源执行信息

ExecutionId String
exec-
6be6d6ff805349d9a
c13

执行ID

ExecutionTime String
2020-11-
13T08:48:34Z

执行时间

Outputs String
{
"commandOutput":
"hello\n" }

模板输出结果

ResourceId String
i-
bp1e1bxxxxxxxxxxxx
xx

资源ID

Status String Success 执行状态

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=ListResourceExecutionStatus
&ExecutionId=exec-xxxxxxxxxxxx
&RegionId=cn-hangzhou
&<公共请求参数>

正常返回示例

 XML  格式

<RequestId>ED571CBD-9F96-419D-B919-CF340BBCA157</RequestId>
<ResourceExecutionStatus>
    <Status>Success</Status>
    <ExecutionTime>2020-11-13T08:48:34Z</ExecutionTime>
    <ResourceId>i-bp1e1bxxxxxxxxxxxxxx</ResourceId>
    <Outputs>
        <commandOutput>hello
</commandOutput>
    </Outputs>
    <ExecutionId>exec-6be6d6ff805349d9ac13</ExecutionId>
</ResourceExecutionStatus>
<MaxResults>50</MaxResults>

 JSON  格式
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{
 "RequestId": "ED571CBD-9F96-419D-B919-CF340BBCA157",
 "ResourceExecutionStatus": [
  {
   "Status": "Success",
   "ExecutionTime": "2020-11-13T08:48:34Z",
   "ResourceId": "i-bp1e1bxxxxxxxxxxxxxx",
   "Outputs": {
    "commandOutput": "hello\n"
   },
   "ExecutionId": "exec-6be6d6ff805349d9ac13"
  }
 ],
 "MaxResults": 50
}

错误码

HttpCode 错误码 错误信息 描述

404
EntityNotExists.Exec
ution

The specified execution does
not exist.

被指定的执行不存在。

400 InvalidParameter The parameter is invalid. 无效的参数

访问错误中心查看更多错误码。
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调用ListActions查询可用动作，包括原子动作和云产品动作。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 ListActions 系统规定参数。取值：List Act ions   。

RegionId String 否 cn-hangzhou 地域ID

OOSActionName String 否 MyTemplate
动作名称。名称未包含关系，最终列出包
含所填动作名称的所有动作。

MaxResults Integer 否 50
分页大小。取值范围：20-100。默认为
50。

NextToken String 否 - 翻页标记的Token。

返回数据

名称 类型 示例值 描述

NextToken String xxx 翻页标记的Token

RequestId String
F9154C02-F847-
4563-BB6A-
6DD01A4F0

请求ID

MaxResults Integer 50 分页大小

Actions Array of Action 动作列表

Popularity Integer 5 使用热度

7.动作
7.1. ListActions
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ActionType String ACS::Template

动作类型。

1. 原子动作

Atomic.API

Atomic.Trigger

Atomic.Control

Atomic.Embedded

2. 云产品动作

Product.ECS

Product.RDS

Product.VPC

Product.FC

…..

Description String ReplaceSystemDisk 动作说明

CreatedDate String
2019-05-
16T10:26:14Z

动作创建时间

TemplateVersi
on

String v1

动作所对应的模板版本。

说明  对于原子动作，该字段不返
回。

OOSActionNam
e

String
ACS::ECS::ReplaceS
ystemDisk

动作名称

Properties String

{ "ImageId": {
"Description": "The
mirror ID you will
use when resetting
the system",
"Type": "String" },
"InstanceId": {
"Description": "the
instance id that you
will handle .",
"Type": "String" } }

动作参数

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=ListActions
&RegionId=cn-hangzhou
&OOSActionName=MyTemplate
&MaxResults=50
&NextToken=-
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<ListActionsResponse>
    <MaxResults>50</MaxResults>
    <RequestId>F9154C02-F847-4563-BB6A-6DD2F5F0</RequestId>
    <Actions>
        <OOSActionName>ACS::ECS::ReplaceSystemDisk</OOSActionName>
        <ActionType>Product.ECS</ActionType>
        <CreatedDate>2019-05-14T07:26:39Z</CreatedDate>
        <Description>ReplaceSystemDisk</Description>
        <TemplateVersion>v1</TemplateVersion>
        <Properties>
            <ImageId>
                <Description>The mirror ID you will use when resetting the system</Descript
ion>
                <Type>String</Type>
            </ImageId>
            <InstanceId>
                <Description>the instance id that you will handle .</Description>
                <Type>String</Type>
            </InstanceId>
        </Properties>
    </Actions>
    <Actions>
        <OOSActionName>ACS::Notify</OOSActionName>
        <ActionType>Automic.Trigger</ActionType>
        <CreatedDate>2019-05-16T09:33:45Z</CreatedDate>
        <Description>Send the notification.</Description>
        <Properties>
            <NotifyType>The type of notification. Support WebHook</NotifyType>
            <WebHook>
                <Content>The body for requesting web hook. Type: Mapping.</Content>
                <Headers>The headers for requesting web hook. Type: Mapping.</Headers>
                <URI>The web hook URI.</URI>
            </WebHook>
        </Properties>
    </Actions>
</ListActionsResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "MaxResults" : 50,
  "RequestId" : "F9154C02-F847-4563-BB6A-6DD2F5F0",
  "Actions" : [ {
    "OOSActionName" : "ACS::ECS::ReplaceSystemDisk",
    "ActionType" : "Product.ECS",
    "CreatedDate" : "2019-05-14T07:26:39Z",
    "Description" : "ReplaceSystemDisk",
    "TemplateVersion" : "v1",
    "Properties" : {
      "ImageId" : {
        "Description" : "The mirror ID you will use when resetting the system",
        "Type" : "String"
      },
      "InstanceId" : {
        "Description" : "the instance id that you will handle .",
        "Type" : "String"
      }
    }
  }, {
    "OOSActionName" : "ACS::Notify",
    "ActionType" : "Automic.Trigger",
    "CreatedDate" : "2019-05-16T09:33:45Z",
    "Description" : "Send the notification.",
    "Properties" : {
      "NotifyType" : "The type of notification. Support WebHook",
      "WebHook" : {
        "Content" : "The body for requesting web hook. Type: Mapping.",
        "Headers" : "The headers for requesting web hook. Type: Mapping.",
        "URI" : "The web hook URI."
      }
    }
  } ]
}

错误码
访问错误中心查看更多错误码。
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调用TagResources可创建标签资源关系，即可为资源创建用户标签。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 TagResources 系统规定参数。取值：T agResources  。

RegionId String 是 cn-hangzhou 地域ID。

ResourceIds Map 是
["templateName
1","templateNam
e2"]

需要修改资源组的云资源的资源ID列表，
资源ID数量限制为1至50。

当ResourceType为template
时，ResourceIds为
["TemplateName1","TemplateName
2"];

当ResourceType为parameter
时，ResourceIds为
["Name1","Name2"];

当ResourceType为secretparameter
时，ResourceIds为
["Name1","Name2"];

当ResourceType为stateconfiguration
时，ResourceIds为
["StateConfigurationId1","StateConfi
gurationId2"];

当ResourceType为application
时，ResourceIds为
["Name1","Name2"]。

ResourceType String 是 template

需要修改资源组的云资源类型，取值：

template: 模板。

parameter: 参数。

secretparameter: 加密参数。

stateconfiguration: 终态配置。

application: 应用。

8.标签
8.1. TagResources
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Tags Map 是
{"k1":"v1","k2":"v
2"}

标签键值映射，键值对数量限制为1至20。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
B19AE203-FD99-
49C7-9253-
FAAACAD46F4A

请求ID。

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=TagResources
&RegionId=cn-hangzhou
&ResourceIds=["templateName1","templateName2"]
&ResourceType=template
&Tags={"k1":"v2","k2":"v2"}
&<公共请求参数>

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<TagResourcesResponse> 
<RequestId>B19AE203-FD99-49C7-9253-FAAACAD46F4A</RequestId>
</TagResourcesResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "B19AE203-FD99-49C7-9253-FAAACAD46F4A"
}

错误码
访问错误中心查看更多错误码。

调用UntagResources可删除用户标签资源关系，即可为资源删除用户标签。

调试

8.2. UntagResources
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您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 UntagResources
系统规定参数。取
值：Unt agResources  。

RegionId String 是 cn-hangzhou 地域ID。

ResourceIds Map 是
["templateName
1","templateNam
e2"]

需要修改资源组的云资源的资源ID列表，
资源ID数量限制为1至50。

当ResourceType为template
时，ResourceIds为
["TemplateName1","TemplateName
2"];

当ResourceType为parameter
时，ResourceIds为
["Name1","Name2"];

当ResourceType为secretparameter
时，ResourceIds为
["Name1","Name2"];

当ResourceType为stateconfiguration
时，ResourceIds为
["StateConfigurationId1","StateConfi
gurationId2"];

当ResourceType为application
时，ResourceIds为
["Name1","Name2"]。

ResourceType String 是 template

需要修改资源组的云资源类型，取值：

template: 模板。

parameter: 参数。

secretparameter: 加密参数。

stateconfiguration: 终态配置。

application: 应用。

TagKeys Map 否 ["k1","k2"] 标签键列表，键的数量限制为1至20。

All Boolean 否 false

是否全部删除，仅当TagKeys为空时有
效。取值范围：true或false，默认是
false。当该参数为false时，TagKeys则是
必选参数。
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返回数据

名称 类型 示例值 描述

RequestId String
491DF8C2-34C9-
4679-9DB3-
4C0F49B129AC

请求ID。

示例
请求示例

http(s)://[Endpoint]/?Action=UntagResources
&RegionId=cn-hangzhou
&ResourceIds=["templateName1","templateName2"]
&ResourceType=template
&<公共请求参数>

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<UntagResourcesResponse>     
<RequestId>491DF8C2-34C9-4679-9DB3-4C0F49B129AC</RequestId>
</UntagResourcesResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "UntagResourcesResponse" : {
    "RequestId" : "491DF8C2-34C9-4679-9DB3-4C0F49B129AC"
  }
}

错误码
访问错误中心查看更多错误码。

调用ListTagResources查询可见的资源标签关系。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

8.3. ListTagResources
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名称 类型 是否必选 示例值 描述

Action String 是 ListTagResources
系统规定参数。取值：
ListTagResources。

NextToken String 是
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ

查询返回结果承接上一页的Token，该参
数需从上一页返回结果中获取。

RegionId String 是 cn-hangzhou 地域ID。

ResourceType String 是 template

资源类型定义。取值范围：

template:OOS模版

execution:OOS执行

ResourceIds Json 否
["templateNam1"
,"templateName
2"]

资源ID，资源ID数量限制为1至50。

Tags Json 否
{"k1":"v2","k2":"v
2"}

标签键及值，键值对数量限制为1至20。

返回数据

名称 类型 示例值 描述

NextToken String
MTRBMDc0NjAtRUJFN
y00N0NBLTk3NTctM
TJDQzQ

再次查询时，若期望返回结果承接本页，则在请
求参数中的NextToken传入该值。若NextToken
对应返回值为空，则表示不存在下一页。

RequestId String
A5EF78C1-67FC-
4E36-A6A8-
7DF9C51726DF

请求ID。

TagResources Array 标签及资源关系。

TagResource

ResourceId String TagTest2 资源ID。

ResourceType String template 资源类型。

TagKey String k1 标签键。
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TagValue String v1 标签值。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=ListTagResources
&NextToken=MTRBMDc0NjAtRUJFNy00N0NBLTk3NTctMTJDQzQ
&RegionId=cn-hangzhou
&ResourceType=template
&<公共请求参数>

正常返回示例

 XML  格式

<ListTagResourcesResponse> 
  <TagResources>
        <TagResource>
              <ResourceType>template</ResourceType>
              <TagValue>v1</TagValue>
              <ResourceId>TagTest2</ResourceId>
              <TagKey>k1</TagKey>
        </TagResource>
        <TagResource>
              <ResourceType>template</ResourceType>
              <TagValue>v1</TagValue>
              <ResourceId>TagTest3</ResourceId>
              <TagKey>k1</TagKey>
        </TagResource>
        <TagResource>
              <ResourceType>template</ResourceType>
              <TagValue>v1</TagValue>
              <ResourceId>TagTest4</ResourceId>
              <TagKey>k1</TagKey>
        </TagResource>
        <TagResource>
              <ResourceType>template</ResourceType>
              <TagValue>v1</TagValue>
              <ResourceId>TagTest5</ResourceId>
              <TagKey>k1</TagKey>
        </TagResource>
  </TagResources>
  <NextToken></NextToken>
  <RequestId>A5EF78C1-67FC-4E36-A6A8-7DF9C51726DF</RequestId>
</ListTagResourcesResponse>

 JSON  格式
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{
 "TagResources": {
  "TagResource": [
   {
    "ResourceType": "template",
    "TagValue": "v1",
    "ResourceId": "TagTest2",
    "TagKey": "k1"
   },
   {
    "ResourceType": "template",
    "TagValue": "v1",
    "ResourceId": "TagTest3",
    "TagKey": "k1"
   },
   {
    "ResourceType": "template",
    "TagValue": "v1",
    "ResourceId": "TagTest4",
    "TagKey": "k1"
   },
   {
    "ResourceType": "template",
    "TagValue": "v1",
    "ResourceId": "TagTest5",
    "TagKey": "k1"
   }
  ]
 },
 "NextToken": "",
 "RequestId": "A5EF78C1-67FC-4E36-A6A8-7DF9C51726DF"
}

错误码
访问错误中心查看更多错误码。

查询已创建的标签

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 ListTagKeys 系统规定参数。取值：ListTagKeys。

8.4. ListTagKeys
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RegionId String 否 cn-hangzhou 地域ID

MaxResults Integer 否 50
单页返回结果最大数量10到100，默认为
50。

NextToken String 否 djsdlkasd 翻下一页口令

ResourceType String 否 template 查询被打标签的资源类型

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

Keys List ["k3","k2","k1"] 标签键列表

MaxResults Integer 50 单页返回最大数

NextToken String 87y29h80h20h3f2 翻到下一页的口令

RequestId String
36210B73-8262-
4D08-9D3A-
7F96789733C8

请求ID

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=ListTagKeys
&<公共请求参数>

正常返回示例

 XML  格式
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<ListTagKeysResponse>
<RequestId>36210B73-8262-4D08-9D3A-7F96789733C8</RequestId>
<NextToken>e16333dsads3058fc897878ae</NextToken>
<Keys>k3</Keys>
<Keys>k2</Keys>
<Keys>k1</Keys>
<Keys>k4</Keys>
<Keys>key55</Keys>
<Keys>ew</Keys>
<Keys>oos</Keys>
<Keys>scaling_group</Keys>
<Keys>aa</Keys>
</ListTagKeyseResponse>

 JSON  格式

{
 "RequestId": "36210B73-8262-4D08-9D3A-7F96789733C8",
 "NextToken": "e16333dsads3058fc897878ae",
 "Keys": [
  "k3",
  "k2",
  "k1",
  "k4",
  "key55",
  "ew",
  "oos",
  "scaling_group",
  "aa"
 ]
}

错误码
访问错误中心查看更多错误码。

查询已创建的标签值

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 ListTagValues 系统规定参数。取值：ListTagValues。

8.5. ListTagValues
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RegionId String 否 cn-hangzhou 地域ID

MaxResults Integer 否 50 单页最大结果数

NextToken String 否
3272h923879hsak
sad

翻下一页的口令

ResourceType String 否 template 已打标签的资源类型

Key String 否 k1 要查询的标签键

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

MaxResults Integer 50 单页最大结果数

NextToken String 83u29j2dj3dskds 翻下一页的口令

RequestId String
65591133-1188-
4935-B78F-20F72

请求ID

Values List ["v1","v1"] 标签值

示例
请求示例

http(s)://oos.cn-hangzhou.aliyuncs.com/?Action=ListTagValues
&<公共请求参数>

正常返回示例

 XML  格式

<ListTagValuesResponse>
  <RequestId>65591133-1188-4935-B78F-20F722DCD647</RequestId>
  <NextToken>5c32b9208a941197e0b5e8707e68181f</NextToken>
  <Values>v1</Values>
  <Values>v1</Values>
</ListTagValuesResponse>

 JSON  格式
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{
 "RequestId": "65591133-1188-4935-B78F-20F722DCD647",
 "NextToken": "5c32b9208a941197e0b5e8707e68181f",
 "Values": [
  "v1",
  "v1"
 ]
}

错误码
访问错误中心查看更多错误码。
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调用DeleteParameter删除普通参数

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 DeleteParameter
系统规定参数。取值：
DeleteParameter。

Name String 是 MyParameter

普通参数名称。取值范围：内容限制为字
母、数字、中划线、下划线，长度不能超
过200字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

RegionId String 否 cn-hangzhou 地域ID。

返回数据

名称 类型 示例值 描述

RequestId String
C0D02BDF-77F6-
49F2-95C9-
8E87121D2979

请求ID

示例
请求示例

http(s)://[Endpoint]/?Action=DeleteParameter
&Name=MyParameter
&<公共请求参数>

正常返回示例

 XML  格式

<RequestId>C0D02BDF-77F6-49F2-95C9-8E87121D2979</RequestId>

9.参数
9.1. 普通参数
9.1.1. DeleteParameter
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 JSON  格式

{
 "RequestId": "C0D02BDF-77F6-49F2-95C9-8E87121D2979"
}

错误码
访问错误中心查看更多错误码。

调用GetParameter获取一个普通参数，包括参数值。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 GetParameter 系统规定参数。取值：Get Paramet er  。

RegionId String 否 cn-hangzhou 地域ID。

Name String 是 MyParameter

参数名称。取值范围：内容限制为字母、
数字、中划线、下划线，长度不能超过200
字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

ParameterVersion Integer 否 1 参数版本号。取值范围：1-100。

ResourceGroupId String 否
rg-
acfmxsn4m*****

资源组ID。

返回数据

名称 类型 示例值 描述

RequestId String
BA326372-2A10-
4C3B-BE3E-
6439DB7557CC

请求ID

Parameter Object 普通参数信息

9.1.2. GetParameter
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Type String String 参数类型

UpdatedDate String
2020-09-
01T08:01:43Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

Tags Map 标签

Value String parameter 参数内容

Description String parameter 参数描述信息

Constraints String

'{''AllowedValues":
["parameter"],"Allo
wedPattern":"para
meter","MinLength":
0,"MaxLength":20}'

参数约束条件

ResourceGroupI
d

String rg-acfmxsn4m***** 资源组ID

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T08:01:43Z

参数创建时间

ParameterVersi
on

Integer 1 参数版本号

Name String MyParameter 参数名称

Id String
p-
4c4b401cab6747xxx
xxx

参数ID

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=GetParameter
&RegionId=cn-hangzhou
&Name=MyParameter
&ParameterVersion=1
&ResourceGroupId=rg-acfmxsn4m*****
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<GetParameterResponse>
    <RequestId>BA326372-2A10-4C3B-BE3E-6439DB7557CC</RequestId>
    <Parameter>
        <Type>String</Type>
        <UpdatedDate>2020-09-01T08:01:43Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <Value>parameter</Value>
        <Description>parameter</Description>
        <Constraints>'{''AllowedValues":["parameter"],"AllowedPattern":"parameter","MinLeng
th":0,"MaxLength":20}'</Constraints>
        <ResourceGroupId>rg-acfmxsn4m*****</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T08:01:43Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MyParameter</Name>
        <Id>p-4c4b401cab6747xxxxxx</Id>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Parameter>
</GetParameterResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "BA326372-2A10-4C3B-BE3E-6439DB7557CC",
  "Parameter" : {
    "Type" : "String",
    "UpdatedDate" : "2020-09-01T08:01:43Z",
    "UpdatedBy" : "root(130900000)",
    "Value" : "parameter",
    "Description" : "parameter",
    "Constraints" : "'{''AllowedValues\":[\"parameter\"],\"AllowedPattern\":\"parameter\",\
"MinLength\":0,\"MaxLength\":20}'",
    "ResourceGroupId" : "rg-acfmxsn4m*****",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T08:01:43Z",
    "ParameterVersion" : 1,
    "Name" : "MyParameter",
    "Id" : "p-4c4b401cab6747xxxxxx",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

调用ListParameters查询普通参数，支持多种查询。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 ListParameters
系统规定参数。取
值：List Paramet ers   。

RegionId String 否 cn-hangzhou 地域ID。

Name String 否 MyParameter
参数名称。本Act ion下的Name为模糊
匹配。

9.1.3. ListParameters
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MaxResults Integer 否 50
分页大小。取值范围：10-100。默认为
50。

NextToken String 否
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzA

翻页标记的Token。

SortField String 否 Name

根据字段排序。取值范围：

Name（参数名称）

CreatedDate（创建时间）

SortOrder String 否 Descending

排序顺序。取值范围：

Ascending（升序）

Descending（默认值）：降序

Type String 否 String

参数类型。取值范围：

String

StringList

Path String 否 /path1/path2/
参数路径。例如：Name
为/path/path1/Myparameter 此时包含
参数路径。

Recursive Boolean 否 false
参数路径是否递归。

默认：false

Tags Map 否
{"k1": "v1", "k2":
"v2"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

NextToken String

gAAAAABfTgv5ewU
WmNdJ3g7JVLvX70s
PH90GZOVGC6KPDUL
0FIIb

翻页标记的Token
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RequestId String
A81E4B2E-6B33-
4BAE-9856-
55DB7C893E01

请求ID

TotalCount Integer 5 返回结果总数

MaxResults Integer 50 分页大小

Parameters
Array of
Parameter

普通参数信息

Type String String 参数类型

UpdatedDate String
2020-09-
01T08:01:43Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

Tags Map 标签

Description String parameter 参数描述信息

CreatedBy String root(130900000) 参数创建者

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组

CreatedDate String
2020-09-
01T08:01:43Z 参数创建时间

ParameterVersi
on

String 1 参数版本

Name String MyParameter 参数名称

Id String
p-
4c4b401cab6747xxx
xxx

普通参数Id

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=ListParameters
&RegionId=cn-hangzhou
&Name=MyParameter
&MaxResults=50
&NextToken=MTRBMDc0NjAtRUJFNy00N0NBLTk3NTctMTJDQzA
&SortField=Name
&SortOrder=Descending
&Type=String
&Path=/path1/path2/
&Recursive=false
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<ListParametersResponse>
    <NextToken>gAAAAABfTgv5ewUWmNdJ3g7JVLvX70sPH90GZOVGC6KPDUL0FIIb</NextToken>
    <RequestId>A81E4B2E-6B33-4BAE-9856-55DB7C893E01</RequestId>
    <TotalCount>5</TotalCount>
    <MaxResults>50</MaxResults>
    <Parameters>
        <Type>String</Type>
        <UpdatedDate>2020-09-01T08:01:43Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <Description>parameter</Description>
        <CreatedBy>root(130900000)</CreatedBy>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedDate>2020-09-01T08:01:43Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MyParameter</Name>
        <Id>p-4c4b401cab6747xxxxxx</Id>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Parameters>
</ListParametersResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "NextToken" : "gAAAAABfTgv5ewUWmNdJ3g7JVLvX70sPH90GZOVGC6KPDUL0FIIb",
  "RequestId" : "A81E4B2E-6B33-4BAE-9856-55DB7C893E01",
  "TotalCount" : 5,
  "MaxResults" : 50,
  "Parameters" : {
    "Type" : "String",
    "UpdatedDate" : "2020-09-01T08:01:43Z",
    "UpdatedBy" : "root(130900000)",
    "Description" : "parameter",
    "CreatedBy" : "root(130900000)",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedDate" : "2020-09-01T08:01:43Z",
    "ParameterVersion" : 1,
    "Name" : "MyParameter",
    "Id" : "p-4c4b401cab6747xxxxxx",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

调用UpdateParameter更新一个已存在的普通参数。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 UpdateParameter
系统规定参数。取
值：Updat eParamet er  。

RegionId String 否 cn-hangzhou 地域ID。

9.1.4. UpdateParameter
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Name String 是 MyParameter

参数名称。取值范围：内容限制为字母、
数字、中划线、下划线，长度不能超过200
字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

Value String 是 update 参数内容。长度限制为4096。

Description String 否 update
要给普通参数添加的描述信息。长度限制
为200字符。

Tags String 否
{"k1": "v1", "k2":
"v2"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
AF1AE6DE-61C4-
435E-8687-
072CFACCCEC7

请求ID

Parameter Object 普通参数信息。

Type String String 普通参数类型

UpdatedDate String
2020-09-
01T08:04:23Z

普通参数更新时间

UpdatedBy String root(130900000) 普通参数更新者

Tags String
{"k1": "v1", "k2":
"v2"}

标签

Description String update 普通参数描述信息

Constraints String

"{'AllowedValues':
['parameter'],'Allow
edPattern':'paramet
er','MinLength':0,'M
axLength':20}"

参数约束条件
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ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(130900000) 普通参数创建者

CreatedDate String
2020-09-
01T08:01:43Z

普通参数创建时间

ParameterVersi
on

Integer 2 普通参数版本

Name String MyParameter 普通参数名称

Id String
p-
4c4b401cab6747xxx
xxx

普通参数Id

ShareType String Private 普通参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=UpdateParameter
&RegionId=cn-hangzhou
&Name=MyParameter
&Value=update
&Description=update
&Tags={"k1": "v1", "k2": "v2"}
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<UpdateParameterResponse>
    <RequestId>AF1AE6DE-61C4-435E-8687-072CFACCCEC7</RequestId>
    <Parameter>
        <Type>String</Type>
        <UpdatedDate>2020-09-01T08:04:23Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <Tags>{"k1": "v1", "k2": "v2"}</Tags>
        <Description>update</Description>
        <Constraints>"{'AllowedValues':['parameter'],'AllowedPattern':'parameter','MinLengt
h':0,'MaxLength':20}"</Constraints>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T08:01:43Z</CreatedDate>
        <ParameterVersion>2</ParameterVersion>
        <Name>MyParameter</Name>
        <Id>p-4c4b401cab6747xxxxxx</Id>
        <ShareType>Private</ShareType>
    </Parameter>
</UpdateParameterResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "AF1AE6DE-61C4-435E-8687-072CFACCCEC7",
  "Parameter" : {
    "Type" : "String",
    "UpdatedDate" : "2020-09-01T08:04:23Z",
    "UpdatedBy" : "root(130900000)",
    "Tags" : "{\"k1\": \"v1\", \"k2\": \"v2\"}",
    "Description" : "update",
    "Constraints" : "\"{'AllowedValues':['parameter'],'AllowedPattern':'parameter','MinLeng
th':0,'MaxLength':20}\"",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T08:01:43Z",
    "ParameterVersion" : 2,
    "Name" : "MyParameter",
    "Id" : "p-4c4b401cab6747xxxxxx",
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

9.1.5. CreateParameter
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调用CreateParameter创建一个普通参数。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 CreateParameter
系统规定参数。取
值：Creat eParamet er  。

RegionId String 否 cn-hangzhou 地域ID。

Name String 是 MyParameter

参数名称。取值范围：内容限制为字母、
数字、中划线、下划线，长度不能超过200
字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

Type String 是 String
参数类型。取值范围：String、
StringList。

Value String 是 parameter 参数内容。长度限制为4096。

Description String 否 parameter
要给参数添加的描述信息。长度限制为200
字符。

ClientToken String 否
123e4567-e89b-
12d3-a456-
42665544****

保证请求的幂等性。该值由客户端生成，
并且必须是全局唯一的。

长度不超过64个字符，可包含英文字母、
数字、短划线（-）和下划线（_）。

更多详情，请参见如何保证幂等性。

Constraints String 否

'{''AllowedValues
":
["parameter"],"All
owedPattern":"p
arameter","MinLe
ngth":0,"MaxLen
gth":20}'

参数的约束条件，默认为空，取值范围：

AllowedValues 参数允许值，数组类型
的字符串

AllowedPattern 正则字符串

MinLength 参数最小长度

MaxLength 参数最大长度
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Tags Map 否
{"k1": "v1", "k2":
"v2"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
0B419FF3-ABC6-
4DF0-95E5-
636DC8CBB8AF

请求ID

Parameter Object 普通参数信息

Type String String 参数类型

UpdatedDate String
2020-09-
01T08:01:43Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

Tags Map 标签

Description String parameter 参数描述信息

Constraints String

"{'AllowedValues':
['parameter'],'Allow
edPattern':'paramet
er','MinLength':0,'M
axLength':20}"

参数约束条件

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T08:01:43Z

参数创建时间

ParameterVersi
on

Integer 1 参数版本号
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Name String MyParameter 参数名称

Id String
p-
4c4b401cab6747xxx
xxx

参数ID

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=CreateParameter
&RegionId=cn-hangzhou
&Name=MyParameter
&Type=String
&Value=parameter
&Description=parameter
&ClientToken=123e4567-e89b-12d3-a456-42665544****
&Constraints='{''AllowedValues":["parameter"],"AllowedPattern":"parameter","MinLength":0,"M
axLength":20}'
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<CreateParameterResponse>
    <RequestId>0B419FF3-ABC6-4DF0-95E5-636DC8CBB8AF</RequestId>
    <Parameter>
        <Type>String</Type>
        <UpdatedDate>2020-09-01T08:01:43Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <Description>parameter</Description>
        <Constraints>"{'AllowedValues':['parameter'],'AllowedPattern':'parameter','MinLengt
h':0,'MaxLength':20}"</Constraints>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T08:01:43Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MyParameter</Name>
        <Id>p-4c4b401cab6747xxxxxx</Id>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Parameter>
</CreateParameterResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "0B419FF3-ABC6-4DF0-95E5-636DC8CBB8AF",
  "Parameter" : {
    "Type" : "String",
    "UpdatedDate" : "2020-09-01T08:01:43Z",
    "UpdatedBy" : "root(130900000)",
    "Description" : "parameter",
    "Constraints" : "\"{'AllowedValues':['parameter'],'AllowedPattern':'parameter','MinLeng
th':0,'MaxLength':20}\"",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T08:01:43Z",
    "ParameterVersion" : 1,
    "Name" : "MyParameter",
    "Id" : "p-4c4b401cab6747xxxxxx",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}
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错误码
访问错误中心查看更多错误码。

调用ListParameterVersions查看普通参数的多个版本对象。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListParameterVer
sions

系统规定参数。取值：
ListParameterVersions。

Name String 是 MyParameter 参数名称。

RegionId String 否 cn-hangzhou 地域ID。

MaxResults Integer 否 50
分页大小。取值范围：10-100。默认为
50。

NextToken String 否

MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ3Nj
FENDdB

翻页标记的Token。

ShareType String 否 Private 参数共享类型。

返回数据

名称 类型 示例值 描述

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
07T11:37:29Z

参数创建时间

Description String
parameter-
description

参数描述信息

9.1.6. ListParameterVersions
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Id String
p-
a483b520e0axxxxxx
xxx

参数Id

MaxResults Integer 50 分页大小

Name String MyParameter 参数名称

NextToken String
MTRBMDc0NjAtRUJFN
y00N0NBLTk3NTctM
TJDQzQ3NjFENDdB

翻页标记的Token

ParameterVersi
ons

Array of
ParameterVersi
on

参数版本信息

ParameterVersi
on

Integer 1 参数版本

UpdatedBy String root(130900000) 参数更新者

UpdatedDate String
2020-09-
07T11:37:29Z

参数更新时间

Value String MyParameter 参数值内容

RequestId String
FD08D89D-B6C8-
4AA2-A2B4-
521D3F4A39FA

请求ID

TotalCount Integer 50 返回结果总数

Type String String 参数类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=ListParameterVersions
&Name=MyParameter
&<公共请求参数>

正常返回示例

 XML  格式
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<Type>String</Type>
<ParameterVersions>
    <UpdatedBy>root(130900000)</UpdatedBy>
    <UpdatedDate>2020-09-07T11:37:29Z</UpdatedDate>
    <ParameterVersion>1</ParameterVersion>
    <Value>Running</Value>
</ParameterVersions>
<Description>parameter-description</Description>
<CreatedBy>root(130900000)</CreatedBy>
<RequestId>FD08D89D-B6C8-4AA2-A2B4-521D3F4A39FA</RequestId>
<MaxResults>50</MaxResults>
<CreatedDate>2020-09-07T11:37:29Z</CreatedDate>
<Id>p-a483b520e0axxxxxxxxx</Id>
<Name>MyParameter</Name>

 JSON  格式

{
 "Type": "String",
 "ParameterVersions": [
  {
   "UpdatedBy": "root(130900000)",
   "UpdatedDate": "2020-09-07T11:37:29Z",
   "ParameterVersion": 1,
   "Value": "Running"
  }
 ],
 "Description": "parameter-description",
 "CreatedBy": "root(130900000)",
 "RequestId": "FD08D89D-B6C8-4AA2-A2B4-521D3F4A39FA",
 "MaxResults": 50,
 "CreatedDate": "2020-09-07T11:37:29Z",
 "Id": "p-a483b520e0axxxxxxxxx",
 "Name": "MyParameter"
}

错误码
访问错误中心查看更多错误码。

调用GetParametersByPath通过路径获取普通参数。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

9.1.7. GetParametersByPath
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名称 类型 是否必选 示例值 描述

Action String 是
GetParametersBy
Path

系统规定参数。取值：
GetParametersByPath。

Path String 是 /parameter
参数路径，参数长度小于200个字符串。例
如参数/parameter/myparameter，其
中/parameter为此参数的路径。

RegionId String 否 cn-hangzhou 地域ID。

Recursive Boolean 否 false

是否递归查询路径。如参
数/parameter/myparameter
与/parameter/prameter1/myparamete
r，取值范围：

true（搜索
出/parameter/myparameter
与/parameter/prameter1/myparame
ter两个结果）

false（仅能搜索
出/parameter/myparameter这一个结
果）

NextToken String 否
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzA

翻页标记的Token。

MaxResults Integer 否 10 分页大小。取值范围：1-10。默认为10。

返回数据

名称 类型 示例值 描述

MaxResults Integer 10 分页大小

NextToken String
gAAAAABfTgv5ewU
WmNdJ3g7JVLvX70s
PH90GZOVGC

翻页标记的Token

Parameters
Array of
Parameter

参数信息

Constraints String {\"MaxLength\": 2} 参数的约束条件
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CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-10-
21T04:03:12Z

参数创建时间

Description String parameter 参数的描述信息

Id String
p-
7cdc0000000000000
000

参数ID

Name String myParameter 参数名称

ParameterVersi
on

Integer 1 参数版本号

ShareType String Private 参数共享类型

Type String StringList 参数类型

UpdatedBy String root(130900000) 参数更新者

UpdatedDate String
2020-10-
21T04:03:12Z

参数更新时间

Value String
"parameter1,param
eter2"

参数内容

RequestId String
25156E99-7437-
4590-AA58-
2ACA17DE405C

请求ID

TotalCount Integer 1 查询到的参数总数。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetParametersByPath
&Path=/parameter
&<公共请求参数>

正常返回示例

 XML  格式
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<Parameters>
    <UpdatedBy>root(130900000)</UpdatedBy>
    <Type>StringList</Type>
    <CreatedBy>root(130900000)</CreatedBy>
    <Description/>
    <Constraints>{"MaxLength": 2}</Constraints>
    <UpdatedDate>2020-10-21T04:03:12Z</UpdatedDate>
    <ParameterVersion>1</ParameterVersion>
    <CreatedDate>2020-10-21T04:02:40Z</CreatedDate>
    <Value>parameter1,parameter2</Value>
    <Id>p-7cdc0000000000000000</Id>
    <Name>/parameter/myparameter</Name>
    <ShareType>Private</ShareType>
</Parameters>
<RequestId>25156E99-7437-4590-AA58-2ACA17DE405C</RequestId>
<MaxResults>10</MaxResults>

 JSON  格式

{
 "Parameters": [
  {
   "UpdatedBy": "root(130900000)",
   "Type": "StringList",
   "CreatedBy": "root(130900000)",
   "Description": "",
   "Constraints": "{\"MaxLength\": 2}",
   "UpdatedDate": "2020-10-21T04:03:12Z",
   "ParameterVersion": 1,
   "CreatedDate": "2020-10-21T04:02:40Z",
   "Value": "parameter1,parameter2",
   "Id": "p-7cdc0000000000000000",
   "Name": "/parameter/myparameter",
   "ShareType": "Private"
  }
 ],
 "RequestId": "25156E99-7437-4590-AA58-2ACA17DE405C",
 "MaxResults": 10
}

错误码
访问错误中心查看更多错误码。

调用GetParameters获取一个或多个普通参数的详细信息。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

9.1.8. GetParameters
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请求参数

名称 类型 是否必选 示例值 描述

Action String 是 GetParameters
系统规定参数。取
值：Get Paramet ers   。

RegionId String 否 cn-hangzhou 地域ID。

Names String 是
["parameter1","p
arameter2"]

参数名称，可以由多个参数名称组成一个
JSON数组，格式为 ["xxxxxxxxx",
"yyyyyyyyy", … "zzzzzzzzz"] ，最多支持
10个参数名称，参数名称之间用半角逗号
（,）隔开。

返回数据

名称 类型 示例值 描述

RequestId String
2597E94B-5346-
42D1-BB58-
D3333EDD0975

请求ID

InvalidParamet
ers

Array of String ["InvalidParameter"] 无效参数

Parameters
Array of
Parameter

参数信息

Type String StringList 参数类型

UpdatedDate String
2020-10-
22T03:30:45Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

Tags Map 标签

Value String
parameter,paramet
er1

参数值

Description String parameter 参数的描述信息

Constraints String {\"MaxLength\": 2} 参数的约束条件
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ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-10-
22T03:30:45Z

参数创建时间

ParameterVersi
on

Integer 1 参数版本号

Name String MyParameter 参数名称

Id String
p-
7cdc0000000000000
000

参数ID

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetParameters
&RegionId=cn-hangzhou
&Names=["parameter1","parameter2"]
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<GetParametersResponse>
    <Parameters>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <Type>StringList</Type>
        <CreatedBy>root(130900000)</CreatedBy>
        <Description>parameter</Description>
        <Constraints/>
        <UpdatedDate>2020-10-22T03:30:45Z</UpdatedDate>
        <ParameterVersion>2</ParameterVersion>
        <CreatedDate>2020-10-22T03:30:27Z</CreatedDate>
        <Value>parameter,parameter1</Value>
        <Id>p-7cdc0000000000000000</Id>
        <Name>MyParameter</Name>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <ShareType>Private</ShareType>
    </Parameters>
    <RequestId>2597E94B-5346-42D1-BB58-D3333EDD0975</RequestId>
    <InvalidParameters>InInvalidParameter</InvalidParameters>
</GetParametersResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "Parameters" : {
    "UpdatedBy" : "root(130900000)",
    "Type" : "StringList",
    "CreatedBy" : "root(130900000)",
    "Description" : "parameter",
    "Constraints" : "",
    "UpdatedDate" : "2020-10-22T03:30:45Z",
    "ParameterVersion" : 2,
    "CreatedDate" : "2020-10-22T03:30:27Z",
    "Value" : "parameter,parameter1",
    "Id" : "p-7cdc0000000000000000",
    "Name" : "MyParameter",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "ShareType" : "Private"
  },
  "RequestId" : "2597E94B-5346-42D1-BB58-D3333EDD0975",
  "InvalidParameters" : "InInvalidParameter"
}

错误码
访问错误中心查看更多错误码。

调用DeleteSecretParameter删除一个加密参数。请确保在使用该接口前有操作DeleteSecret  API的权限。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
DeleteSecretPara
meter

系统规定参数。取值：
DeleteSecretParameter。

9.2. 加密参数
9.2.1. DeleteSecretParameter
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Name String 是
MySecretParamet
er

加密参数名称。取值范围：内容限制为字
母、数字、中划线、下划线，长度不能超
过180字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

RegionId String 否 cn-hangzhou 地域ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
C0D02BDF-77F6-
49F2-95C9-
8E87121D1944

请求ID

示例
请求示例

http(s)://[Endpoint]/?Action=DeleteSecretParameter
&Name=MySecretParameter
&<公共请求参数>

正常返回示例

 XML  格式

<RequestId>C0D02BDF-77F6-49F2-95C9-8E87121D1944</RequestId>

 JSON  格式

{
 "RequestId": "C0D02BDF-77F6-49F2-95C9-8E87121D1944"
}

错误码
访问错误中心查看更多错误码。

调用GetSecretParameter获取一个加密参数，包括参数值。请确保在使用该接口前有操作GetSecretValue
API的权限。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

9.2.2. GetSecretParameter
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请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GetSecretParame
ter

系统规定参数。取
值：Get Secret Paramet er   。

RegionId String 否 cn-hangzhou 地域ID。

Name String 是
MySecretParamet
er

参数名称。取值范围：内容限制为字母、
数字、中划线、下划线，长度不能超过180
字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

ParameterVersion Integer 否 1 参数版本号。取值范围：1-100。

WithDecryption Boolean 否 false
是否解密参数值。只有参数为true时，返
回值的value才会有结果，否则为空。

返回数据

名称 类型 示例值 描述

RequestId String
7F14FB7C-C9BE-
44AE-92ED-
21ACC02FBFD2

请求ID。

Parameter Object 加密参数信息

Type String Secret 参数类型

UpdatedDate String
2020-09-
01T09:35:17Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

KeyId String
80e9409f-78fa-
42ab-84bd-
83f40c******

加密使用的KMS 的KeyId

Tags Map 标签

Value String SecretParameter 参数内容
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Description String SecretParameter 参数描述信息

Constraints String

'{''AllowedValues":
["secretparameter"],
"AllowedPattern":".
*","MinLength":0,"M
axLength":20}'

参数约束条件

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T09:28:47Z

参数创建时间

ParameterVersi
on

Integer 1 参数版本号

Name String MySecretParameter 加密参数名称

Id String
p-
14ed150fdcd048xxx
xxx

加密参数Id

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetSecretParameter
&RegionId=cn-hangzhou
&Name=MySecretParameter
&ParameterVersion=1
&WithDecryption=false
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<GetSecretParameterResponse>
    <RequestId>7F14FB7C-C9BE-44AE-92ED-21ACC02FBFD2</RequestId>
    <Parameter>
        <Type>Secret</Type>
        <UpdatedDate>2020-09-01T09:35:17Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <KeyId>80e9409f-78fa-42ab-84bd-83f40c******</KeyId>
        <Value>SecretParameter</Value>
        <Description>SecretParameter</Description>
        <Constraints>'{''AllowedValues":["secretparameter"],"AllowedPattern":".*","MinLengt
h":0,"MaxLength":20}'</Constraints>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T09:28:47Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MySecretParameter</Name>
        <Id>p-14ed150fdcd048xxxxxx</Id>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Parameter>
</GetSecretParameterResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "7F14FB7C-C9BE-44AE-92ED-21ACC02FBFD2",
  "Parameter" : {
    "Type" : "Secret",
    "UpdatedDate" : "2020-09-01T09:35:17Z",
    "UpdatedBy" : "root(130900000)",
    "KeyId" : "80e9409f-78fa-42ab-84bd-83f40c******",
    "Value" : "SecretParameter",
    "Description" : "SecretParameter",
    "Constraints" : "'{''AllowedValues\":[\"secretparameter\"],\"AllowedPattern\":\".*\",\"
MinLength\":0,\"MaxLength\":20}'",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T09:28:47Z",
    "ParameterVersion" : 1,
    "Name" : "MySecretParameter",
    "Id" : "p-14ed150fdcd048xxxxxx",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

调用ListSecretParameters查询普通参数，支持多种查询。

请确保在使用该接口前有操作KMS secret对应权限，

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListSecretParame
ters

系统规定参数。取
值：List Secret Paramet ers    。

RegionId String 否 cn-hangzhou 地域ID。

9.2.3. ListSecretParameters
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Name String 否
MySecretParamet
er

参数名称。本Act ion下的Name为模糊
匹配。

MaxResults Integer 否 50
分页大小。取值范围：10-100。默认为
50。

NextToken String 否
sPH90GZOVGC6KP
DUL0FIIbEtMQHq_
19S6_4O_XqA

翻页标记的Token

SortField String 否 Name

根据字段排序。取值范围：

Name（参数名称）

CreatedDate（创建时间）

SortOrder String 否 Descending

排序顺序。取值范围：

Ascending（升序）

Descending（默认值）：降序

Path String 否 /path1/path2/
参数路径。例如：Name
为/path/path1/Myparameter 此时包含
参数路径。

Recursive Boolean 否 false
参数路径是否递归。

默认：false

Tags Map 否
{"k1": "v1", "k2":
"v2"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

NextToken String
sPH90GZOVGC6KPDU
L0FIIbEtMQHq_19S6_
4O_XqA

翻页标记的Token

RequestId String
CA9C6248-AF2A-
4AE9-A166-
88FD901BBB90

请求ID。
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MaxResults Integer 50 分页大小

Parameters
Array of
Parameter

加密参数信息

Type String Secret 参数类型

UpdatedDate String
2020-09-
01T09:35:17Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

KeyId String
80e9409f-78fa-
42ab-84bd-
83f40c******

加密使用的KMS的KeyId

Tags Map 标签

Description String SecretParameter 参数描述信息

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T09:28:47Z

参数创建时间

ParameterVersi
on

String 1 参数版本

Name String MySecretParameter 参数名称

Id String
p-
14ed150fdcd048xxx
xxx

加密参数Id

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=ListSecretParameters
&RegionId=cn-hangzhou
&Name=MySecretParameter
&MaxResults=50
&NextToken=sPH90GZOVGC6KPDUL0FIIbEtMQHq_19S6_4O_XqA
&SortField=Name
&SortOrder=Descending
&Path=/path1/path2/
&Recursive=false
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<ListSecretParametersResponse>
    <NextToken>sPH90GZOVGC6KPDUL0FIIbEtMQHq_19S6_4O_XqA</NextToken>
    <RequestId>CA9C6248-AF2A-4AE9-A166-88FD901BBB90</RequestId>
    <MaxResults>50</MaxResults>
    <Parameters>
        <Type>Secret</Type>
        <UpdatedDate>2020-09-01T09:35:17Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <KeyId>80e9409f-78fa-42ab-84bd-83f40c******</KeyId>
        <Description>SecretParameter</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T09:28:47Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MySecretParameter</Name>
        <Id>p-14ed150fdcd048xxxxxx</Id>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Parameters>
</ListSecretParametersResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "NextToken" : "sPH90GZOVGC6KPDUL0FIIbEtMQHq_19S6_4O_XqA",
  "RequestId" : "CA9C6248-AF2A-4AE9-A166-88FD901BBB90",
  "MaxResults" : 50,
  "Parameters" : {
    "Type" : "Secret",
    "UpdatedDate" : "2020-09-01T09:35:17Z",
    "UpdatedBy" : "root(130900000)",
    "KeyId" : "80e9409f-78fa-42ab-84bd-83f40c******",
    "Description" : "SecretParameter",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T09:28:47Z",
    "ParameterVersion" : 1,
    "Name" : "MySecretParameter",
    "Id" : "p-14ed150fdcd048xxxxxx",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

调用UpdateSecretParameter更新一个加密参数。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
UpdateSecretPar
ameter

系统规定参数。取
值：Updat eSecret Paramet er   。

RegionId String 否 cn-hangzhou 地域ID。

9.2.4. UpdateSecretParameter
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Name String 是
MySecretParamet
er

参数名称。取值范围：内容限制为字母、
数字、中划线、下划线，长度不能超过180
字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

Value String 是 update 参数内容。长度限制为4096。

Description String 否 SecretParameter
要给加密参数添加的描述信息。长度限制
为200字符。

Tags Map 否
{"k1": "v1", "k2":
"v2"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
0B419FF3-ABC6-
4DF0-95E5-
636DC8CBB8AF

请求ID。

Parameter Object 加密参数信息

Type String Secret 参数类型

UpdatedDate String
2020-09-
01T09:33:11Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

KeyId String
80e9409f-78fa-
42ab-84bd-
83f40c******

加密使用的KMS的KeyId

Tags String
{"k1": "v1", "k2":
"v2"}

标签。

Description String SecretParameter 参数描述信息
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Constraints String

'{''AllowedValues":
["secretparameter"],
"AllowedPattern":".
*","MinLength":0,"M
axLength":20}'

参数约束条件

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T09:30:36Z

参数创建时间

ParameterVersi
on

Integer 2 参数版本

Name String MyParameter 参数名称

Id String
p-
0b0fff9919c946xxxx
xx

参数Id

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=UpdateSecretParameter
&RegionId=cn-hangzhou
&Name=MySecretParameter
&Value=update
&Description=SecretParameter
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<UpdateSecretParameterResponse>
    <RequestId>0B419FF3-ABC6-4DF0-95E5-636DC8CBB8AF</RequestId>
    <Parameter>
        <Type>Secret</Type>
        <UpdatedDate>2020-09-01T09:33:11Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <KeyId>80e9409f-78fa-42ab-84bd-83f40c******</KeyId>
        <Tags>{"k1": "v1", "k2": "v2"}</Tags>
        <Description>SecretParameter</Description>
        <Constraints>'{''AllowedValues":["secretparameter"],"AllowedPattern":".*","MinLengt
h":0,"MaxLength":20}'</Constraints>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T09:30:36Z</CreatedDate>
        <ParameterVersion>2</ParameterVersion>
        <Name>MyParameter</Name>
        <Id>p-0b0fff9919c946xxxxxx</Id>
        <ShareType>Private</ShareType>
    </Parameter>
</UpdateSecretParameterResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "0B419FF3-ABC6-4DF0-95E5-636DC8CBB8AF",
  "Parameter" : {
    "Type" : "Secret",
    "UpdatedDate" : "2020-09-01T09:33:11Z",
    "UpdatedBy" : "root(130900000)",
    "KeyId" : "80e9409f-78fa-42ab-84bd-83f40c******",
    "Tags" : "{\"k1\": \"v1\", \"k2\": \"v2\"}",
    "Description" : "SecretParameter",
    "Constraints" : "'{''AllowedValues\":[\"secretparameter\"],\"AllowedPattern\":\".*\",\"
MinLength\":0,\"MaxLength\":20}'",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T09:30:36Z",
    "ParameterVersion" : 2,
    "Name" : "MyParameter",
    "Id" : "p-0b0fff9919c946xxxxxx",
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。
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调用CreateSecretParameter创建一个加密参数。请确保在使用该接口前有操作CreateSecret  API的权限。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
CreateSecretPara
meter

系统规定参数。取
值：Creat eSecret Paramet er   。

RegionId String 否 cn-hangzhou 地域ID。

Name String 是
MySecretParamet
er

参数名称。取值范围：内容限制为字母、
数字、中划线、下划线，长度不能超过180
字符，且不能以ALIYUN、ACS、
ALIBABA、ALICLOUD、OOS开头。

Type String 是 Secret 参数类型。取值范围：Secret。

Value String 是 SecretParameter 参数内容。长度限制为4096。

Description String 否 SecretParameter
要给参数添加的描述信息。长度限制为200
字符

KeyId String 否
80e9409f-78fa-
42ab-84bd-
83f40c******

加密使用的KMS的KeyId。

ClientToken String 否
123e4567-e89b-
12d3-a456-
42665544****

保证请求的幂等性。该值由客户端生成，
并且必须是全局唯一的。

长度不超过64个字符，可包含英文字母、
数字、短划线（-）和下划线（_）。

更多详情，请参见如何保证幂等性。

9.2.5. CreateSecretParameter
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Constraints String 否

'{''AllowedValues
":
["secretparamete
r"],"AllowedPatte
rn":"secretparam
eter","MinLength"
:0,"MaxLength":2
0}'

参数的约束条件，默认为空，取值范围：

AllowedValues 参数允许值，数组类型
的字符串

AllowedPattern 正则字符串

MinLength 参数最小长度

MaxLength 参数最大长度

Tags String 否
{"k1": "v1", "k2":
"v2"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
0B419FF3-ABC6-
4DF0-95E5-
636DC8CBB8AF

请求ID。

Parameter Object 加密参数信息

Type String Secret 参数类型

UpdatedDate String
2020-09-
01T09:30:36Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者

KeyId String
80e9409f-78fa-
42ab-84bd-
83f40c******

加密使用的KMS的KeyId

Tags String
{"k1": "v1", "k2":
"v2"}

标签

Description String SecretParameter 参数描述信息

Constraints String

'{ "AllowedValues":
["secretparameter"],
"AllowedPattern":
"secretparameter",
"MinLength": 0,
"MaxLength": 20 }'

参数约束条件
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ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组。

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T09:30:36Z

参数创建时间

ParameterVersi
on

Integer 1 参数版本号

Name String MyParameter 参数名称

Id String
p-
0b0fff9919c946xxxx
xx

参数ID

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=CreateSecretParameter
&RegionId=cn-hangzhou
&Name=MySecretParameter
&Type=Secret
&Value=SecretParameter
&Description=SecretParameter
&KeyId=80e9409f-78fa-42ab-84bd-83f40c******
&ClientToken=123e4567-e89b-12d3-a456-42665544****
&Constraints='{''AllowedValues":["secretparameter"],"AllowedPattern":"secretparameter","Min
Length":0,"MaxLength":20}'
&Tags={"k1": "v1", "k2": "v2"}
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<CreateSecretParameterResponse>
    <RequestId>0B419FF3-ABC6-4DF0-95E5-636DC8CBB8AF</RequestId>
    <Parameter>
        <Type>Secret</Type>
        <UpdatedDate>2020-09-01T09:30:36Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <KeyId>80e9409f-78fa-42ab-84bd-83f40c******</KeyId>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <Description>SecretParameter</Description>
        <Constraints>'{  "AllowedValues": ["secretparameter"],  "AllowedPattern": "secretpa
rameter",  "MinLength": 0,  "MaxLength": 20 }'</Constraints>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-09-01T09:30:36Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MyParameter</Name>
        <Id>p-0b0fff9919c946xxxxxx</Id>
        <ShareType>Private</ShareType>
    </Parameter>
</CreateSecretParameterResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "0B419FF3-ABC6-4DF0-95E5-636DC8CBB8AF",
  "Parameter" : {
    "Type" : "Secret",
    "UpdatedDate" : "2020-09-01T09:30:36Z",
    "UpdatedBy" : "root(130900000)",
    "KeyId" : "80e9409f-78fa-42ab-84bd-83f40c******",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "Description" : "SecretParameter",
    "Constraints" : "'{ \t\"AllowedValues\": [\"secretparameter\"], \t\"AllowedPattern\": \
"secretparameter\", \t\"MinLength\": 0, \t\"MaxLength\": 20 }'",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-09-01T09:30:36Z",
    "ParameterVersion" : 1,
    "Name" : "MyParameter",
    "Id" : "p-0b0fff9919c946xxxxxx",
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。

调用ListSecretParameterVersions查询加密参数的多个版本对象。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListSecretParame
terVersions

系统规定参数。取
值：List Secret Paramet erVersions    。

RegionId String 否 cn-hangzhou 地域ID。

Name String 是
MySecretParamet
er

参数名称。

9.2.6. ListSecretParameterVersions
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MaxResults Integer 否 10
分页大小。取值范围：10-100。默认为
50。

NextToken String 否

MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzQ3Nj
FENDdB

翻页标记的Token。

ShareType String 否 Private 参数共享类型。

WithDecryption Boolean 否 false
是否解密参数值。只有参数为true时，返
回值的value才会有结果，否则为空。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

Type String Secret 参数类型

NextToken String
MTRBMDc0NjAtRUJFN
y00N0NBLTk3NTctM
TJDQzQ3NjFENDdB

翻页标记的Token

RequestId String
DBA6E6C8-F75D-
41DE-AFF5-
1FA03F551CA3

请求ID

Description String SecretParameter 参数描述信息

MaxResults Integer 50 分页大小

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-09-
01T08:01:43Z

参数创建时间

Name String MySecretParameter 参数名称

TotalCount Integer 1 返回结果总数

Id String
p-
4c4b401cab6747xxx
xxx

参数Id
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ParameterVersi
ons

Array of
ParameterVersi
on

参数版本信息

ParameterVersi
on

Integer 1 参数版本号

Value String SecretParameter 参数值

UpdatedDate String
2020-09-
01T08:01:43Z

参数更新日期

UpdatedBy String root(130900000) 参数更新者

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=ListSecretParameterVersions
&Name=MySecretParameter
&<公共请求参数>

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<Parameters>
    <UpdatedBy>root(130900000)</UpdatedBy>
    <Type>Secret</Type>
    <CreatedBy>root(130900000)</CreatedBy>
    <Description>secret-test</Description>
    <UpdatedDate>2020-09-02T11:44:11Z</UpdatedDate>
    <ParameterVersion>3</ParameterVersion>
    <CreatedDate>2020-09-02T11:44:01Z</CreatedDate>
    <Id>p-e4e117b5c6c941xxxxxx</Id>
    <Name>secret-test1</Name>
    <ShareType>Private</ShareType>
</Parameters>
<RequestId>DBA6E6C8-F75D-41DE-AFF5-1FA03F551CA3</RequestId>
<MaxResults>50</MaxResults>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "Parameters" : [ {
    "UpdatedBy" : "root(130900000)",
    "Type" : "Secret",
    "CreatedBy" : "root(130900000)",
    "Description" : "secret-test",
    "UpdatedDate" : "2020-09-02T11:44:11Z",
    "ParameterVersion" : 3,
    "CreatedDate" : "2020-09-02T11:44:01Z",
    "Id" : "p-e4e117b5c6c941xxxxxx",
    "Name" : "secret-test1",
    "ShareType" : "Private"
  } ],
  "RequestId" : "DBA6E6C8-F75D-41DE-AFF5-1FA03F551CA3",
  "MaxResults" : 50
}

错误码
访问错误中心查看更多错误码。

调用GetSecretParametersByPath通过路径获取加密参数。请确保在使用该接口前有操作GetSecretValue
API的权限。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GetSecretParame
tersByPath

系统规定参数。取值：
GetSecretParametersByPath。

Path String 是 /secretParameter

参数路径，参数长度小于200个字符串。例
如参
数/secretParameter/mySecretParamet
er，其中/secretParameter为此参数的路
径。

RegionId String 否 cn-hangzhou 地域ID。

9.2.7. GetSecretParametersByPath
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Recursive Boolean 否 false

是否递归查询路径。如参
数/secretParameter/mySecretParamet
er
与/secretParameter/secretParameter1/
mySecretParameter，取值范围：

true（搜索
出//secretParameter/mySecretPara
meter
与/secretParameter/secretParamete
r1/mySecretParameter两个结果）

false（仅能搜索
出/secretParameter/mySecretParam
eter这一个结果）

NextToken String 否
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzA

翻页标记的Token。

MaxResults Integer 否 10 分页大小。取值范围：1-10。默认为10。

WithDecryption Boolean 否 true

是否解密参数值。

取值范围：

true

false（默认）

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

MaxResults Integer 10 分页大小

NextToken String
gAAAAABfTgv5ewU
WmNdJ3g7JVLvX70s
PH90GZOVGC

翻页标记的Token

Parameters
Array of
Parameter

参数信息

Constraints String
{\"AllowedPattern\"
: \"^[a-g]*$\"}

参数的约束条件

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-10-
21T06:22:48Z

参数更新时间
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Description String secretParameter 参数的描述信息

Id String
p-
7cdc0000000000000
000

参数ID

KeyId String
090xxbex-xexx-xxxx-
axfc-ddxxcxxxxcex

密钥ID

Name String mySecretParameter 参数名称

ParameterVersi
on

Integer 1 参数版本号

ShareType String Private 参数共享类型

Type String Secret 参数类型

UpdatedBy String root(130900000) 参数更新者

UpdatedDate String
2020-10-
21T06:22:48Z

参数更新时间

Value String secretParameter 参数内容

RequestId String
25156E99-7437-
4590-AA58-
2ACA17DE405C

请求ID

TotalCount Integer 10 查询到的加密参数总数

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetSecretParametersByPath
&Path=/secretParameter
&<公共请求参数>

正常返回示例

 XML  格式
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<Parameters>
    <UpdatedBy>root(130900000)</UpdatedBy>
    <Type>Secret</Type>
    <CreatedBy>root(130900000)</CreatedBy>
    <Description>secretParameter</Description>
    <Constraints>{"AllowedPattern": "^[a-g]*$"}</Constraints>
    <UpdatedDate>2020-10-21T06:22:48Z</UpdatedDate>
    <ParameterVersion>3</ParameterVersion>
    <CreatedDate>2020-10-21T03:28:33Z</CreatedDate>
    <Value>secretParameter</Value>
    <KeyId>090xxbex-xexx-xxxx-axfc-ddxxcxxxxcex</KeyId>
    <Id>p-7cdc0000000000000000</Id>
    <Name>mySecretParameter</Name>
    <ShareType>Private</ShareType>
</Parameters>
<RequestId>14F404A1-0863-4BB3-B884-78FCE6075DA8</RequestId>
<MaxResults>10</MaxResults>

 JSON  格式

{
 "Parameters": [
  {
   "UpdatedBy": "root(130900000)",
   "Type": "Secret",
   "CreatedBy": "root(130900000)",
   "Description": "secretParameter",
   "Constraints": "{\"AllowedPattern\": \"^[a-g]*$\"}",
   "UpdatedDate": "2020-10-21T06:22:48Z",
   "ParameterVersion": 3,
   "CreatedDate": "2020-10-21T03:28:33Z",
            "Value": "secretParameter",
   "KeyId": "090xxbex-xexx-xxxx-axfc-ddxxcxxxxcex",
   "Id": "p-7cdc0000000000000000",
   "Name": "mySecretParameter",
   "ShareType": "Private"
  }
 ],
 "RequestId": "14F404A1-0863-4BB3-B884-78FCE6075DA8",
 "MaxResults": 10
}

错误码
访问错误中心查看更多错误码。

调用GetSecretParameters获取一个或多个加密参数的详细信息。请确保在使用该接口前有操作
GetSecretValue API的权限。

调试

9.2.8. GetSecretParameters
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您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GetSecretParame
ters

系统规定参数。取
值：Get Secret Paramet ers    。

RegionId String 否 cn-hangzhou 地域ID。

Names String 是
["secretParamete
r","secretParamet
er1"]

参数名称，可以由多个参数名称组成一个
JSON数组，格式为 ["xxxxxxxxx",
"yyyyyyyyy", … "zzzzzzzzz"] ，最多支持
10个参数名称，参数名称之间用半角逗号
（,）隔开。

WithDecryption Boolean 否 false

是否解密参数值。

取值范围：

true

false（默认）

返回数据

名称 类型 示例值 描述

RequestId String
A5320F1D-92D9-
44BB-A416-
5FC525ED6D57

请求ID

InvalidParamet
ers

Array of String
[
"InvalidSecretParam
eter"]

无效的参数名称列表

Parameters
Array of
Parameter

参数信息

Type String Secret 参数类型

UpdatedDate String
2020-10-
22T03:11:13Z

参数更新时间

UpdatedBy String root(130900000) 参数更新者
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KeyId String
ssh-
bp67acfmxazb4p***
*

密钥ID

Tags Map 标签

Value String
secretParameter,sec
retParameter1

参数值

Description String secretParameter 参数的描述信息

Constraints String
{\"AllowedValues\":
[\"test\"]}

参数的约束条件

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID

CreatedBy String root(130900000) 参数创建者

CreatedDate String
2020-10-
22T03:11:13Z

参数创建时间

ParameterVersi
on

Integer 1 参数版本号

Name String MySecretParameter 参数名称

Id String
p-
7cdc0000000000000
000

参数ID

ShareType String Private 参数共享类型

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetSecretParameters
&RegionId=cn-hangzhou
&Names=["secretParameter","secretParameter1"]
&WithDecryption=false
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<GetSecretParametersResponse>
    <RequestId>A5320F1D-92D9-44BB-A416-5FC525ED6D57</RequestId>
    <InvalidParameters>[ "InvalidSecretParameter"]</InvalidParameters>
    <Parameters>
        <Type>Secret</Type>
        <UpdatedDate>2020-10-22T03:11:13Z</UpdatedDate>
        <UpdatedBy>root(130900000)</UpdatedBy>
        <KeyId>ssh-bp67acfmxazb4p****</KeyId>
        <Value>secretParameter,secretParameter1</Value>
        <Description>secretParameter</Description>
        <Constraints>{\"AllowedValues\": [\"test\"]}</Constraints>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <CreatedBy>root(130900000)</CreatedBy>
        <CreatedDate>2020-10-22T03:11:13Z</CreatedDate>
        <ParameterVersion>1</ParameterVersion>
        <Name>MySecretParameter</Name>
        <Id>p-7cdc0000000000000000</Id>
        <Tags>
            <k1>v1</k1>
            <k2>v2</k2>
        </Tags>
        <ShareType>Private</ShareType>
    </Parameters>
</GetSecretParametersResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "A5320F1D-92D9-44BB-A416-5FC525ED6D57",
  "InvalidParameters" : "[ \"InvalidSecretParameter\"]",
  "Parameters" : {
    "Type" : "Secret",
    "UpdatedDate" : "2020-10-22T03:11:13Z",
    "UpdatedBy" : "root(130900000)",
    "KeyId" : "ssh-bp67acfmxazb4p****",
    "Value" : "secretParameter,secretParameter1",
    "Description" : "secretParameter",
    "Constraints" : "{\\\"AllowedValues\\\": [\\\"test\\\"]}",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "CreatedBy" : "root(130900000)",
    "CreatedDate" : "2020-10-22T03:11:13Z",
    "ParameterVersion" : 1,
    "Name" : "MySecretParameter",
    "Id" : "p-7cdc0000000000000000",
    "Tags" : {
      "k1" : "v1",
      "k2" : "v2"
    },
    "ShareType" : "Private"
  }
}

错误码
访问错误中心查看更多错误码。
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使用GetInventorySchema获取配置清单的模式信息。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GetInventorySche
ma

系统规定参数。取
值：Get Invent orySchema  。

RegionId String 否 cn-hangzhou 地域ID。

Aggregator Boolean 否 false

是否仅展示支持聚合的模式。

取值范围：

true（只返回支持聚合的模式）

false（返回所有的模式）

TypeName String 否 ACS:Application

组件名称。取值范围：

ACS:InstanceInformation

ACS:Application

ACS:File

ACS:Network

ACS:WindowsRole

ACS:Service

ACS:WindowsUpdate

ACS:WindowsRegistry

MaxResults Integer 否 50
分页大小。取值范围：1-100。默认为
50。

NextToken String 否

gAAAAABfh8MVL
QI9AuKGACLgjbsX
bWs-
Mna47IDM6tr6wK
7TZ1

翻页标记的Token。

10.配置清单
10.1. GetInventorySchema
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返回数据

名称 类型 示例值 描述

NextToken String

gAAAAABfh8MVLQI9
AuKGACLgjbsXbWs-
Mna47IDM6tr6wK7T
Z1

翻页标记的Token

RequestId String
89117642-7167-
4F4D-B7F1-
876582279E3E

请求ID

MaxResults String 1 分页大小

Schemas
Array of
Schema

组件配置清单详细信息

Version String 1.0 组件版本

TypeName String ACS:Application 组件名称

Attributes
Array of
Attribute

组件配置的详细属性

Name String ApplicationType 组件配置的属性名称

DataType String STRING 组件配置的数据类型

示例
请求示例

http(s)://[Endpoint]/?Action=GetInventorySchema
&RegionId=cn-hangzhou
&Aggregator=false
&TypeName=ACS:Application
&MaxResults=50
&NextToken=gAAAAABfh8MVLQI9AuKGACLgjbsXbWs-Mna47IDM6tr6wK7TZ1
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<GetInventorySchemaResponse>
    <RequestId>FE253810-D3CF-5FB7-8F29-69B4D8525A63</RequestId>
    <NextToken>gAAAAABhjOVCZyK6F8UtjODxmp7_-28Ctb-Yh27zmXv1QD6yIepgi42prBOMIUQ7EDAqIYKHAM1G

API参考·配置清单 运维编排

164 > 文档版本：20220705



    <NextToken>gAAAAABhjOVCZyK6F8UtjODxmp7_-28Ctb-Yh27zmXv1QD6yIepgi42prBOMIUQ7EDAqIYKHAM1G
RG9Ux5TjncdKol_84qTzKsg2qer7ceijXT-AQMC2XO4EppeAjsvXxFMUjCaBXKkZ7A30vrsTuNc0MsHjiJdqqw==</N
extToken>
    <MaxResults>1</MaxResults>
    <Schemas>
        <TypeName>ACS:InstanceInformation</TypeName>
        <Version>1.0</Version>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>AgentType</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>AgentVersion</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>ComputerName</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>RamRole</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>InstanceId</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>IpAddress</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>PlatformName</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>PlatformType</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>PlatformVersion</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>ResourceType</Name>
        </Attributes>
        <Attributes>
            <DataType>STRING</DataType>
            <Name>Status</Name>
        </Attributes>
    </Schemas>
</GetInventorySchemaResponse>
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 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "FE253810-D3CF-5FB7-8F29-69B4D8525A63",
  "NextToken" : "gAAAAABhjOVCZyK6F8UtjODxmp7_-28Ctb-Yh27zmXv1QD6yIepgi42prBOMIUQ7EDAqIYKHAM
1GRG9Ux5TjncdKol_84qTzKsg2qer7ceijXT-AQMC2XO4EppeAjsvXxFMUjCaBXKkZ7A30vrsTuNc0MsHjiJdqqw=="
,
  "MaxResults" : 1,
  "Schemas" : [ {
    "TypeName" : "ACS:InstanceInformation",
    "Version" : "1.0",
    "Attributes" : [ {
      "DataType" : "STRING",
      "Name" : "AgentType"
    }, {
      "DataType" : "STRING",
      "Name" : "AgentVersion"
    }, {
      "DataType" : "STRING",
      "Name" : "ComputerName"
    }, {
      "DataType" : "STRING",
      "Name" : "RamRole"
    }, {
      "DataType" : "STRING",
      "Name" : "InstanceId"
    }, {
      "DataType" : "STRING",
      "Name" : "IpAddress"
    }, {
      "DataType" : "STRING",
      "Name" : "PlatformName"
    }, {
      "DataType" : "STRING",
      "Name" : "PlatformType"
    }, {
      "DataType" : "STRING",
      "Name" : "PlatformVersion"
    }, {
      "DataType" : "STRING",
      "Name" : "ResourceType"
    }, {
      "DataType" : "STRING",
      "Name" : "Status"
    } ]
  } ]
}

错误码
访问错误中心查看更多错误码。

10.2. SearchInventory
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调用SearchInventory查询配置清单的详细信息或聚合信息。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是 SearchInventory
系统规定参数。取
值：SearchInvent ory 。

RegionId String 否 cn-hangzhou 地域ID。

NextToken String 否

gAAAAABfTgv5e
wUWmNdJ3g7JVL
vX70sPH90GZOVG
C

翻页标记的Token。

MaxResults Integer 否 50
分页大小。取值范围：1-100。默认为
50。

Filter.N.Operator String 否 Equal

组件属性查询值比较符(N取值范围1-5)。

取值范围：

Equal

NotEqual

BeginWith

LessThan

GreaterThan

Filter.N.Name String 否
ACS:InstanceInfor
mation.InstanceId

组件的属性名称(N取值范围1-5)。不同的
组件内部属性的名称不同。使
用GetInventorySchema查询不同组件的属
性名称。例如：组件
ACS:InstanceInformation下有InstanceId
这个属性，所以本参数则取值为
ACS:InstanceInformation.InstanceId。

返回数据

名称 类型 示例值 描述

10.2. SearchInventory
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NextToken String
gAAAAABfTgv5ewU
WmNdJ3g7JVLvX70s
PH90GZOVGC

翻页标记的Token

RequestId String
A81E4B2E-6B33-
4BAE-9856-
55DB7C893E01

请求ID

MaxResults Integer 50 分页大小

Entit ies Array of Object

[ {
"ACS:InstanceInform
ation": {
"CaptureT ime":
"2020-10-
13T08:55:06Z",
"SchemaVersion":
"1.0", "Content": {
"PlatformName":
"ubuntu",
"PlatformVersion":
"20.04", "Status":
"Running",
"InstanceId": "i-
bp1cpoxxxxxxxxxxxx
xx", "AgentVersion":
"v1.5",
"ComputerName":
"iZbp1cpoxxxw111jc
v94drZ",
"IpAddress":
"192.168.10.245",
"AgentName":
"oosutil",
"PlatformType":
"linux" }, "RegionId":
"cn-hangzhou" },
"Id": "i-
bp1cpoxxxxxxxxxxxx
xx" } ]}

组件查询的详细配置清单，或聚合信息。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=SearchInventory
&Filter.0.Name=ACS:InstanceInformation.InstanceId
&Filter.0.Operator=Equal
&Filter.0.Value.0=i-bp1cpoxxxxxxxxxxxxxx
&Aggregator.0=ACS:Application.Name
&Aggregator.1=ACS:Application.Version
&<公共请求参数>
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正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<RequestId>5B694097-E7C7-4231-858C-B979CEC3A0AC</RequestId>
<MaxResults>50</MaxResults>
<Entities>
    <Data>
        <ACS:Application>
            <Content>
                <ACS:Application.Name>NetworkManager</ACS:Application.Name>
                <ACS:Application.Version>1.22.8</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>NetworkManager-libnm</ACS:Application.Name>
                <ACS:Application.Version>1.22.8</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>NetworkManager-team</ACS:Application.Name>
                <ACS:Application.Version>1.22.8</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>NetworkManager-tui</ACS:Application.Name>
                <ACS:Application.Version>1.22.8</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>PackageKit</ACS:Application.Name>
                <ACS:Application.Version>1.1.12</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>PackageKit-glib</ACS:Application.Name>
                <ACS:Application.Version>1.1.12</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>abattis-cantarell-fonts</ACS:Application.Name>
                <ACS:Application.Version>0.0.25</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>acl</ACS:Application.Name>
                <ACS:Application.Version>2.2.53</ACS:Application.Version>
                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>adcli</ACS:Application.Name>
                <ACS:Application.Version>0.8.2</ACS:Application.Version>
                <Count>1</Count>
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                <Count>1</Count>
            </Content>
            <Content>
                <ACS:Application.Name>aliyun_assist</ACS:Application.Name>
                <ACS:Application.Version>1.0.2.493</ACS:Application.Version>
                <Count>1</Count>
            </Content>
        </ACS:Application>
    </Data>
</Entities>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "5B694097-E7C7-4231-858C-B979CEC3A0AC",
  "MaxResults" : 50,
  "Entities" : [ {
    "Data" : {
      "ACS:Application" : {
        "Content" : [ {
          "ACS:Application.Name" : "NetworkManager",
          "ACS:Application.Version" : "1.22.8",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "NetworkManager-libnm",
          "ACS:Application.Version" : "1.22.8",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "NetworkManager-team",
          "ACS:Application.Version" : "1.22.8",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "NetworkManager-tui",
          "ACS:Application.Version" : "1.22.8",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "PackageKit",
          "ACS:Application.Version" : "1.1.12",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "PackageKit-glib",
          "ACS:Application.Version" : "1.1.12",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "abattis-cantarell-fonts",
          "ACS:Application.Version" : "0.0.25",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "acl",
          "ACS:Application.Version" : "2.2.53",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "adcli",
          "ACS:Application.Version" : "0.8.2",
          "Count" : 1
        }, {
          "ACS:Application.Name" : "aliyun_assist",
          "ACS:Application.Version" : "1.0.2.493",
          "Count" : 1
        } ]
      }
    }
  } ]
}
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错误码
访问错误中心查看更多错误码。

调用List InventoryEntries查询一个实例下的配置清单记录。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListInventoryEntri
es

系统规定参数。取
值：List Invent oryEnt ries    。

InstanceId String 是
i-
bp1cpoxxxwxxxx
xxxxxx

实例ID。

TypeName String 是
ACS:InstanceInfor
mation

组件名称。

取值范围：

ACS:InstanceInformation

ACS:Application

ACS:File

ACS:Network

ACS:WindowsRole

ACS:Service

ACS:WindowsRegistry

ACS:WindowsUpdate

MaxResults Integer 否 50
分页大小。取值范围：1-100。默认为
50。

NextToken String 否
MTRBMDc0NjAtRU
JFNy00N0NBLTk3
NTctMTJDQzA

翻页标记的Token。

RegionId String 否 cn-hangzhou 地域ID。

Filter.N.Value.N String 否 ubuntu 某个组件下的返回内容里面的单个值。

10.3. ListInventoryEntries
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Filter.N.Operator String 否 Equal

组件的比较符(N取值范围1-5)。

取值范围：

Equal

NotEqual

BeginWith

LessThan

GreaterThan

Filter.N.Name String 否 PlatformName
某个组件下的返回内容里面的单个值的名
称(N取值范围1-5)。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

NextToken String
gAAAAABfTgv5ewU
WmNdJ3g7JVLvX70s
PH90GZOVGC

翻页标记的Token

RequestId String
A81E4B2E-6B33-
4BAE-9856-
55DB7C893E01

请求ID

SchemaVersion String 1.0 组件版本号

MaxResults Integer 50 分页大小

CaptureT ime String
2020-09-
17T12:28:13Z

同步配置清单信息时间

TypeName String
ACS:InstanceInform
ation

组件名称

InstanceId String
i-
bp1cpoxxxwxxxxxxx
xxx

ECS实例ID
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Entries Array of Object

{ "RequestId":
"1DF96445-5E18-
4524-A4AE-
3A218D0C345A",
"Entries": [ {
"PlatformName":
"ubuntu",
"PlatformVersion":
"20.04", "Status":
"Running",
"InstanceId": "i-
bp1cpoxxxwxxxxxxx
xxx",
"AgentVersion":
"v1.5",
"ComputerName":
"i-
bp1cpoxxxwxxxxxxx
xxx", "IpAddress":
"192.000.00.000",
"AgentName":
"oosutil",
"PlatformType":
"linux" } ]}

某个实例下查询组件的详细配置属性

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?InstanceId=i-bp1cpoxxxwxxxxxxxxxx
&TypeName=ACS:InstanceInformation
&<公共请求参数>

正常返回示例

 XML 格式

API参考·配置清单 运维编排

174 > 文档版本：20220705



HTTP/1.1 200 OK
Content-Type:application/xml
<TypeName>ACS:InstanceInformation</TypeName>
<CaptureTime>2020-09-17T12:28:13Z</CaptureTime>
<RequestId>F2727F63-CDC5-45A1-995E-4F1127E001CE</RequestId>
<SchemaVersion>1.0</SchemaVersion>
<InstanceId>i-bp1cpoxxxwxxxxxxxxxx</InstanceId>
<MaxResults>50</MaxResults>
<Entries>
    <PlatformName>centos</PlatformName>
    <PlatformVersion>8.2.2004</PlatformVersion>
    <Status>Running</Status>
    <InstanceId>i-bp1cpoxxxwxxxxxxxxxx</InstanceId>
    <AgentVersion>v1.0.4</AgentVersion>
    <ComputerName>i-bp1cpoxxxwxxxxxxxxxx</ComputerName>
    <IpAddress>192.168.00.000</IpAddress>
    <AgentName>oosutil</AgentName>
    <PlatformType>linux</PlatformType>
</Entries>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "TypeName" : "ACS:InstanceInformation",
  "CaptureTime" : "2020-09-17T12:28:13Z",
  "RequestId" : "F2727F63-CDC5-45A1-995E-4F1127E001CE",
  "SchemaVersion" : "1.0",
  "InstanceId" : "i-bp1cpoxxxwxxxxxxxxxx",
  "MaxResults" : 50,
  "Entries" : [ {
    "PlatformName" : "centos",
    "PlatformVersion" : "8.2.2004",
    "Status" : "Running",
    "InstanceId" : "i-bp1cpoxxxwxxxxxxxxxx",
    "AgentVersion" : "v1.0.4",
    "ComputerName" : "i-bp1cpoxxxwxxxxxxxxxx",
    "IpAddress" : "192.168.00.000",
    "AgentName" : "oosutil",
    "PlatformType" : "linux"
  } ]
}

错误码
访问错误中心查看更多错误码。
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创建终态配置。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
CreateStateConfi
guration

系统规定参数。取
值：Creat eSt at eConf igurat ion     。

RegionId String 否 cn-hangzhou 地域ID。

Description String 否 收集Inventory数据 终态配置的描述信息。

TemplateName String 是
ACS-ECS-
InventoryDataColl
ection

模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符。

TemplateVersion String 否 v1 版本号，如不填默认为最新的版本号。

Parameters String 否

{ "policy": {
"ACS:Application"
: { "Collection":
"Enabled" },
"ACS:Network": {
"Collection":
"Enabled" } } }

参数。

ConfigureMode String 否 ApplyOnce

配置模式。

ApplyOnly：配置只应用一次（更新配置后
重新应用）。

ApplyAndMonitor： 配置只应用一次，成
功应用后，后续只检查配置是否漂移。

ApplyAndAutoCorrect：总是应用配置。

ScheduleType String 是 rate 调度类型。可选值：rate。

11.终态管理
11.1. CreateStateConfiguration
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ScheduleExpressi
on

String 是
1 hour 或 30
minutes

调度表达式。调度间隔不得小于30分钟。

Targets String 是

{
"ResourceType":
"ALIYUN::ECS::Ins
tance", "Filters": [
{ "Type": "All",
"RegionId": "cn-
hangzhou",
"Parameters": {
"RegionId": "cn-
hangzhou",
"Status":
"Running" } } ] }

目标资源。

ClientToken String 否
DASKJJLKADS-
AHKLJHJSAKL-AJK

幂等token。

Tags Map 否
{"Key": "oos",
"Value":
"inventory"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
1306108F-610C-
40FD-AAD5-
DA13E8B00BE9

请求ID。

StateConfigura
tion

Object 终态配置。

CreateT ime String
2021-03-
22T03:13:32Z

创建时间。

Targets String

{ "ResourceType":
"ALIYUN::ECS::Insta
nce", "Filters": [ {
"Type": "All",
"RegionId": "cn-
hangzhou",
"Parameters": {
"RegionId": "cn-
hangzhou",
"Status": "Running" }
} ] }

目标资源。

运维编排 API参考·终态管理

> 文档版本：20220705 177



Tags Map 标签。

StateConfigura
tionId

String
sc-
a538febe18fabcdef

创建生成的配置ID。

ScheduleExpres
sion

String 1 hour 定时表达式。

TemplateName String
ACS-ECS-
InventoryDataCollec
tion

模板名称。

TemplateVersi
on

String v1 模板版本。

ConfigureMode String
ApplyAndAutoCorre
ct

配置模式。

ScheduleType String rate 定时类型。

Parameters Map 参数。

Description String 收集Inventory数据 描述信息。

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID。

TemplateId String t-1234asadf 模板ID。

名称 类型 示例值 描述

示例
请求示例
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http(s)://[Endpoint]/?Action=CreateStateConfiguration
&RegionId=cn-hangzhou
&Description=收集Inventory数据
&TemplateName=ACS-ECS-InventoryDataCollection
&TemplateVersion=v1
&Parameters={     "policy": {       "ACS:Application": {         "Collection": "Enabled"   
},       "ACS:Network": {         "Collection": "Enabled"       }     }   }
&ConfigureMode=ApplyOnce
&ScheduleType=rate
&ScheduleExpression=1 hour 或 30 minutes
&Targets={     "ResourceType": "ALIYUN::ECS::Instance",     "Filters": [       {         "T
ype": "All",         "RegionId": "cn-hangzhou",         "Parameters": {           "RegionId
": "cn-hangzhou",           "Status": "Running"         }       }     ]   }
&ClientToken=DASKJJLKADS-AHKLJHJSAKL-AJK
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<CreateStateConfigurationResponse>
    <RequestId>1306108F-610C-40FD-AAD5-DA13E8B00BE9</RequestId>
    <StateConfiguration>
        <CreateTime>2021-03-22T03:13:32Z</CreateTime>
        <Targets>{     "ResourceType": "ALIYUN::ECS::Instance",     "Filters": [       {   
"Type": "All",         "RegionId": "cn-hangzhou",         "Parameters": {           "Region
Id": "cn-hangzhou",           "Status": "Running"         }       }     ]   }</Targets>
        <StateConfigurationId>sc-a538febe18fabcdef</StateConfigurationId>
        <ScheduleExpression>1 hour</ScheduleExpression>
        <TemplateName>ACS-ECS-InventoryDataCollection</TemplateName>
        <TemplateVersion>v1</TemplateVersion>
        <ConfigureMode>ApplyAndAutoCorrect</ConfigureMode>
        <ScheduleType>rate</ScheduleType>
        <Description>收集Inventory数据</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <Tags>
            <oos>inventory</oos>
        </Tags>
        <TemplateId>t-1234asadf</TemplateId>
    </StateConfiguration>
</CreateStateConfigurationResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "1306108F-610C-40FD-AAD5-DA13E8B00BE9",
  "StateConfiguration" : {
    "CreateTime" : "2021-03-22T03:13:32Z",
    "Targets" : "{     \"ResourceType\": \"ALIYUN::ECS::Instance\",     \"Filters\": [     
{         \"Type\": \"All\",         \"RegionId\": \"cn-hangzhou\",         \"Parameters\":
{           \"RegionId\": \"cn-hangzhou\",           \"Status\": \"Running\"         }     
}     ]   }",
    "StateConfigurationId" : "sc-a538febe18fabcdef",
    "ScheduleExpression" : "1 hour",
    "TemplateName" : "ACS-ECS-InventoryDataCollection",
    "TemplateVersion" : "v1",
    "ConfigureMode" : "ApplyAndAutoCorrect",
    "ScheduleType" : "rate",
    "Description" : "收集Inventory数据",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "Tags" : {
      "oos" : "inventory"
    },
    "TemplateId" : "t-1234asadf"
  }
}

错误码
访问错误中心查看更多错误码。

更新终态配置。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
UpdateStateConf
iguration

系统规定参数。取
值：Updat eSt at eConf igurat ion     。

RegionId String 否 cn-hangzhou 地域ID。

Description String 否
ACS-ECS-
InventoryDataColl
ection

描述内容。

11.2. UpdateStateConfiguration
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Parameters Map 否

{ "policy": {
"ACS:Application"
: { "Collection":
"Enabled" },
"ACS:Network": {
"Collection":
"Enabled" } } }

参数。

ConfigureMode String 否 ApplyOnce

配置模式。 ApplyOnce：配置只应用一次
（更新配置后重新应用）。
ApplyAndMonitor： 配置只应用一次，成
功应用后，后续只检查配置是否漂移。
ApplyAndAutoCorrect：总是应用配置。

ScheduleType String 否 rate 调度类型。

ScheduleExpressi
on

String 否 1 hour 调度表达式。

Targets String 否

{
"ResourceType":
"ALIYUN::ECS::Ins
tance", "Filters": [
{ "Type": "All",
"RegionId": "cn-
hangzhou",
"Parameters": {
"RegionId": "cn-
hangzhou",
"Status":
"Running" } } ] }

目标资源。

ClientToken String 否
DASKJJLKADS-
AHKLJHJSAKL-AJK

幂等token。

StateConfiguratio
nId

String 是 sc-asfgdhj12345 终态配置ID。

Tags Map 否
{"Key": "oos",
"Value": "sc"}

标签。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

名称 类型 是否必选 示例值 描述

返回数据
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名称 类型 示例值 描述

RequestId String
1306108F-610C-
40FD-AAD5-
DA13E8B00BE9

请求ID。

StateConfigura
tion

Array of
StateConfigura
tion

配置清单。

UpdateTime String
2021-03-
22T03:13:32Z

更新时间。

CreateT ime String
2021-03-
22T03:13:32Z

创建时间。

Targets String

{ "ResourceType":
"ALIYUN::ECS::Insta
nce", "Filters": [ {
"Type": "All",
"RegionId": "cn-
hangzhou",
"Parameters": {
"RegionId": "cn-
hangzhou",
"Status": "Running" }
} ] }

目标资源。

Tags Map 标签。

StateConfigura
tionId

String
StateConfigurationI
d

创建生成的配置ID。

ScheduleExpres
sion

String 1 hour 定时表达式。

TemplateName String
ACS-ECS-
InventoryDataCollec
tion

模板名称。

TemplateVersi
on

String v1 模板版本。

ConfigureMode String
ApplyAndAutoCorre
ct

配置模式。

ScheduleType String rate 定时类型。
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Parameters String

{"policy":
{"ACS:Network":
{"Collection":
"Enabled"},
"ACS:Application":
{"Collection":
"Enabled"}}}

参数。

Description String 收集Inventory数据 终态配置的描述信息。

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID。

TemplateId String t-1234asadf 模板ID。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=UpdateStateConfiguration
&RegionId=cn-hangzhou
&Description=ACS-ECS-InventoryDataCollection
&ConfigureMode=ApplyOnce
&ScheduleType=rate
&ScheduleExpression=1 hour
&Targets={ "ResourceType": "ALIYUN::ECS::Instance", "Filters": [ { "Type": "All", "RegionId
": "cn-hangzhou", "Parameters": { "RegionId": "cn-hangzhou", "Status": "Running" } } ] }
&ClientToken=DASKJJLKADS-AHKLJHJSAKL-AJK
&StateConfigurationId=sc-asfgdhj12345
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式
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HTTP/1.1 200 OK
Content-Type:application/xml
<UpdateStateConfigurationResponse>
    <RequestId>1306108F-610C-40FD-AAD5-DA13E8B00BE9</RequestId>
    <StateConfiguration>
        <UpdateTime>2021-03-22T03:13:32Z</UpdateTime>
        <CreateTime>2021-03-22T03:13:32Z</CreateTime>
        <Targets>{ "ResourceType": "ALIYUN::ECS::Instance", "Filters": [ { "Type": "All", "
RegionId": "cn-hangzhou", "Parameters": { "RegionId": "cn-hangzhou", "Status": "Running" } 
} ] }</Targets>
        <StateConfigurationId>StateConfigurationId</StateConfigurationId>
        <ScheduleExpression>1 hour</ScheduleExpression>
        <TemplateName>ACS-ECS-InventoryDataCollection</TemplateName>
        <TemplateVersion>v1</TemplateVersion>
        <ConfigureMode>ApplyAndAutoCorrect</ConfigureMode>
        <ScheduleType>rate</ScheduleType>
        <Parameters>{"policy": {"ACS:Network": {"Collection": "Enabled"}, "ACS:Application"
: {"Collection": "Enabled"}}}</Parameters>
        <Description>收集Inventory数据</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <TemplateId>t-1234asadf</TemplateId>
    </StateConfiguration>
</UpdateStateConfigurationResponse>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "1306108F-610C-40FD-AAD5-DA13E8B00BE9",
  "StateConfiguration" : [ {
    "UpdateTime" : "2021-03-22T03:13:32Z",
    "CreateTime" : "2021-03-22T03:13:32Z",
    "Targets" : "{ \"ResourceType\": \"ALIYUN::ECS::Instance\", \"Filters\": [ { \"Type\": 
\"All\", \"RegionId\": \"cn-hangzhou\", \"Parameters\": { \"RegionId\": \"cn-hangzhou\", \"
Status\": \"Running\" } } ] }",
    "StateConfigurationId" : "StateConfigurationId",
    "ScheduleExpression" : "1 hour",
    "TemplateName" : "ACS-ECS-InventoryDataCollection",
    "TemplateVersion" : "v1",
    "ConfigureMode" : "ApplyAndAutoCorrect",
    "ScheduleType" : "rate",
    "Parameters" : "{\"policy\": {\"ACS:Network\": {\"Collection\": \"Enabled\"}, \"ACS:App
lication\": {\"Collection\": \"Enabled\"}}}",
    "Description" : "收集Inventory数据",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "TemplateId" : "t-1234asadf"
  } ]
}

错误码
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访问错误中心查看更多错误码。

查询终态配置。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
ListStateConfigur
ations

系统规定参数。取
值：List St at eConf igurat ions      。

RegionId String 否 cn-hangzhou 地域ID。

TemplateName String 否
ACS-ECS-
InventoryDataColl
ection

模板名称。内容限制为字母、数字、中划
线、下划线，长度200字符。

TemplateVersion String 否 v1 版本号，如不填默认为最新的版本号。

StateConfiguratio
nIds

String 否
["sc-
asfgdhj12345"]

终态配置ID。

Tags Map 否
{"Key": "oos",
"Value":
"inventory"}

标签。

MaxResults Integer 否 50 每页返回的最大结果数。

NextToken String 否
AHJKH-AHKJHDJK-
AKHDIOWJL

下一页Token。

ResourceGroupId String 否
rg-
acfmxsn4m4*****
*

资源组ID。

返回数据

名称 类型 示例值 描述

RequestId String
1306108F-610C-
40FD-AAD5-
DA13E8B00BE9

请求ID。

11.3. ListStateConfigurations

运维编排 API参考·终态管理

> 文档版本：20220705 185

https://error-center.aliyun.com/status/product/oos
https://api.aliyun.com/#product=oos&api=ListStateConfigurations&type=RPC&version=2019-06-01


StateConfigura
tions

Array of
StateConfigura
tion

终态配置列表。

UpdateTime String
2021-04-
22T03:13:32Z

配置更新时间。

CreateT ime String
2021-03-
22T03:13:32Z

创建时间。

Targets String

{ "ResourceType":
"ALIYUN::ECS::Insta
nce", "Filters": [ {
"Type": "All",
"RegionId": "cn-
hangzhou",
"Parameters": {
"RegionId": "cn-
hangzhou",
"Status": "Running" }
} ] }

目标资源。

Tags Map 标签。

StateConfigura
tionId

String
sc-
a538febe18fabcdef

终态配置ID。

ScheduleExpres
sion

String 1 hour 定时表达式。

TemplateName String
ACS-ECS-
InventoryDataCollec
tion

模版名称。

TemplateVersi
on

String v2 模版版本。

ConfigureMode String
ApplyAndAutoCorre
ct

配置模式。

ScheduleType String rate 定时类型。

Parameters String

{"policy":
{"ACS:Network":
{"Collection":
"Enabled"},
"ACS:Application":
{"Collection":
"Enabled"}}}

参数。

名称 类型 示例值 描述

API参考·终态管理 运维编排

186 > 文档版本：20220705



Description String inventory数据收集 描述内容。

ResourceGroupI
d

String
rg-
acfmxsn4m4******

资源组ID。

TemplateId String t-ajshjalscfhjk2214 模版ID。

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=ListStateConfigurations
&RegionId=cn-hangzhou
&TemplateName=ACS-ECS-InventoryDataCollection
&TemplateVersion=v1
&StateConfigurationIds=["sc-asfgdhj12345"]
&MaxResults=50
&NextToken=AHJKH-AHKJHDJK-AKHDIOWJL
&ResourceGroupId=rg-acfmxsn4m4******
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<ListStateConfigurationsResponse>
    <RequestId>1306108F-610C-40FD-AAD5-DA13E8B00BE9</RequestId>
    <StateConfigurations>
        <UpdateTime>2021-04-22T03:13:32Z</UpdateTime>
        <CreateTime>2021-03-22T03:13:32Z</CreateTime>
        <Targets>{ "ResourceType": "ALIYUN::ECS::Instance", "Filters": [ { "Type": "All", "
RegionId": "cn-hangzhou", "Parameters": { "RegionId": "cn-hangzhou", "Status": "Running" } 
} ] }</Targets>
        <StateConfigurationId>sc-a538febe18fabcdef</StateConfigurationId>
        <ScheduleExpression>1 hour</ScheduleExpression>
        <TemplateName>ACS-ECS-InventoryDataCollection</TemplateName>
        <TemplateVersion>v2</TemplateVersion>
        <ConfigureMode>ApplyAndAutoCorrect</ConfigureMode>
        <ScheduleType>rate</ScheduleType>
        <Parameters>{"policy": {"ACS:Network": {"Collection": "Enabled"}, "ACS:Application"
: {"Collection": "Enabled"}}}</Parameters>
        <Description> inventory数据收集</Description>
        <ResourceGroupId>rg-acfmxsn4m4******</ResourceGroupId>
        <TemplateId>t-ajshjalscfhjk2214</TemplateId>
    </StateConfigurations>
</ListStateConfigurationsResponse>
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 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "1306108F-610C-40FD-AAD5-DA13E8B00BE9",
  "StateConfigurations" : [ {
    "UpdateTime" : "2021-04-22T03:13:32Z",
    "CreateTime" : "2021-03-22T03:13:32Z",
    "Targets" : "{ \"ResourceType\": \"ALIYUN::ECS::Instance\", \"Filters\": [ { \"Type\": 
\"All\", \"RegionId\": \"cn-hangzhou\", \"Parameters\": { \"RegionId\": \"cn-hangzhou\", \"
Status\": \"Running\" } } ] }",
    "StateConfigurationId" : "sc-a538febe18fabcdef",
    "ScheduleExpression" : "1 hour",
    "TemplateName" : "ACS-ECS-InventoryDataCollection",
    "TemplateVersion" : "v2",
    "ConfigureMode" : "ApplyAndAutoCorrect",
    "ScheduleType" : "rate",
    "Parameters" : "{\"policy\": {\"ACS:Network\": {\"Collection\": \"Enabled\"}, \"ACS:App
lication\": {\"Collection\": \"Enabled\"}}}",
    "Description" : " inventory数据收集",
    "ResourceGroupId" : "rg-acfmxsn4m4******",
    "TemplateId" : "t-ajshjalscfhjk2214"
  } ]
}

错误码
访问错误中心查看更多错误码。

批量删除终态配置。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
DeleteStateConfi
gurations

系统规定参数。取值：
DeleteStateConfigurations。

StateConfiguratio
nIds

String 是
["sc-
asfgdhj12345"]

终态配置ID列表。

RegionId String 否 cn-hangzhou 地域ID。

11.4. DeleteStateConfigurations
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ClientToken String 否
abcde3OARpx77N
o54nv6

幂等token。

名称 类型 是否必选 示例值 描述

返回数据

名称 类型 示例值 描述

RequestId String
12345B731-0FCE-
48BA-8D42-
605abcde

请求ID。

示例
请求示例

http(s)://[Endpoint]/?Action=DeleteStateConfigurations
&StateConfigurationIds=["sc-asfgdhj12345"]
&<公共请求参数>

正常返回示例

 XML 格式

<RequestId>12345B731-0FCE-48BA-8D42-605abcde</RequestId>

 JSON 格式

{"RequestId":"12345B731-0FCE-48BA-8D42-605abcde"}

错误码
访问错误中心查看更多错误码。
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调用GetServiceSett ings获取投递功能的配置信息。

调试
您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
GetServiceSetting
s

系统规定参数。取
值：Get ServiceSet t ings    。

RegionId String 否 cn-hangzhou 地域ID。

返回数据

名称 类型 示例值 描述

RequestId String
9F755DC9-C0CF-
4598-B2E3-
2CC763F18CB2

请求ID

ServiceSettings
Array of
ServiceSetting

投递功能配置详情

DeliveryOssBuck
etName

String OssBucketName OSS存储空间名称

DeliveryOssKey
Prefix

String oos/execution

OSS存储空间目录，如"oos/execution"，传
入""表示不需要目录，若之前设置过再次设置不
需要目录可通过传入""清空

DeliveryOssEna
bled

Boolean false 是否开启了向OSS投递模板执行记录功能

DeliverySlsEnab
led

Boolean false 是否开启了向SLS投递模板执行记录功能

DeliverySlsProje
ctName

String SlsProjectName SLS的项目名称

12.设置
12.1. GetServiceSettings
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RdcEnterpriseId String RdcEnterpriseId 云效企业ID

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=GetServiceSettings
&RegionId=cn-hangzhou
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<RequestId>9F755DC9-C0CF-4598-B2E3-2CC763F18CB2</RequestId>
<ServiceSettings>
    <DeliverySlsEnabled>false</DeliverySlsEnabled>
    <DeliveryOssKeyPrefix>oos/execution</DeliveryOssKeyPrefix>
    <DeliveryOssEnabled>true</DeliveryOssEnabled>
    <DeliveryOssBucketName>OssBucketName</DeliveryOssBucketName>
    <DeliverySlsProjectName>SlsProjectName</DeliverySlsProjectName>
</ServiceSettings>

 JSON 格式

HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "9F755DC9-C0CF-4598-B2E3-2CC763F18CB2",
  "ServiceSettings" : {
    "DeliverySlsEnabled" : false,
    "DeliveryOssKeyPrefix" : "oos/execution",
    "DeliveryOssEnabled" : true,
    "DeliveryOssBucketName" : "OssBucketName",
    "DeliverySlsProjectName" : "SlsProjectName"
  }
}

错误码
访问错误中心查看更多错误码。

调用SetServiceSett ings开启或关闭模板执行记录的投递功能，以及投递存储地点。

调试

12.2. SetServiceSettings
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您可以在OpenAPI Explorer中直接运行该接口，免去您计算签名的困扰。运行成功后，OpenAPI Explorer可
以自动生成SDK代码示例。

请求参数

名称 类型 是否必选 示例值 描述

Action String 是
SetServiceSetting
s

系统规定参数。取
值：Set ServiceSet t ings    。

DeliveryOssEnable
d

Boolean 否 false
是否开启向OSS投递模板执行记录功能，
默认为false。

DeliveryOssBucket
Name

String 否 OssBucketName OSS存储空间名称。

DeliveryOssKeyPre
fix

String 否 oos/execution
OSS存储空间目录，如"oos/execution",
传入""表示不需要目录，若之前设置过再
次设置不需要目录可通过传入""清空。

DeliverySlsProject
Name

String 否 SlsProjectName SLS的项目名称。

DeliverySlsEnable
d

Boolean 否 false
是否开启向SLS投递模板执行记录功能，默
认为false。

RegionId String 否 cn-hangzhou 地域ID。

RdcEnterpriseId String 否 RdcEnterpriseId 云效企业ID。

返回数据

名称 类型 示例值 描述

RequestId String
CBEC8072-BEC2-
478E-8EAE-
E723BA79CF19

请求ID。

ServiceSettings
Array of
ServiceSetting

投递功能配置详情

DeliveryOssBuck
etName

String OssBucketName OSS存储空间名称

DeliveryOssKey
Prefix

String oos/execution OSS存储空间目录
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DeliveryOssEna
bled

Boolean true 是否开启了向OSS投递模板执行记录功能

DeliverySlsEnab
led

Boolean false 是否开启了向SLS投递模板执行记录功能

DeliverySlsProje
ctName

String SlsProjectName SLS的项目名称

RdcEnterpriseId String RdcEnterpriseId 云效企业ID

名称 类型 示例值 描述

示例
请求示例

http(s)://[Endpoint]/?Action=SetServiceSettings
&DeliveryOssEnabled=false
&DeliveryOssBucketName=OssBucketName
&DeliveryOssKeyPrefix=oos/execution
&DeliverySlsProjectName=SlsProjectName
&DeliverySlsEnabled=false
&RegionId=cn-hangzhou
&RdcEnterpriseId=RdcEnterpriseId
&公共请求参数

正常返回示例

 XML 格式

HTTP/1.1 200 OK
Content-Type:application/xml
<SetServiceSettingsResponse>
    <RequestId>CBEC8072-BEC2-478E-8EAE-E723BA79CF19</RequestId>
    <ServiceSettings>
        <DeliveryOssBucketName>OssBucketName</DeliveryOssBucketName>
        <DeliveryOssKeyPrefix>oos/execution</DeliveryOssKeyPrefix>
        <DeliveryOssEnabled>true</DeliveryOssEnabled>
        <DeliverySlsEnabled>false</DeliverySlsEnabled>
        <DeliverySlsProjectName>SlsProjectName</DeliverySlsProjectName>
        <RdcEnterpriseId>RdcEnterpriseId</RdcEnterpriseId>
    </ServiceSettings>
</SetServiceSettingsResponse>

 JSON 格式
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HTTP/1.1 200 OK
Content-Type:application/json
{
  "RequestId" : "CBEC8072-BEC2-478E-8EAE-E723BA79CF19",
  "ServiceSettings" : [ {
    "DeliveryOssBucketName" : "OssBucketName",
    "DeliveryOssKeyPrefix" : "oos/execution",
    "DeliveryOssEnabled" : true,
    "DeliverySlsEnabled" : false,
    "DeliverySlsProjectName" : "SlsProjectName",
    "RdcEnterpriseId" : "RdcEnterpriseId"
  } ]
}

错误码
访问错误中心查看更多错误码。
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